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Genesys Knowledge Center Deployment

Guide

Tip

The latest version of our documentation (titled “Current”) relates to release 9.0.x.

What is Genesys Knowledge Center

Provides an overview of the Knowledge
Center functionality and architecture:

What is Genesys Knowledge Center
Genesys Knowledge Center Components
High-level architecture

Terminology

Planning your Deployment

Describes major considerations while
planning a deployment of your
Knowledge Center cluster:

Prerequisites
Sizing Information

Hardware Recommendations

C Lo o r= il

Installation and Deployment

Step-by-step guide of Knowledge Center
service deployment (see main page for
full list):

Before You Begin

Configuring the Knowledge Center Cluster
Application

Post Installation and Deployment

Describes tuning options and additional
functionalities to tune the Knowledge
Center to your business needs:

Access Permissions
Configuration Options

Load Balancing Configuration

Installing the CMS

Security

Translation Service
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Knowledge Center in Production

Tips & tricks on operating your
Knowledge Center cluster in production:

Monitoring Knowledge Center

Sample Ul

Importing Data into the Knowledge Center
Server
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What is Genesys Knowledge Center?

What is Genesys Knowledge Center?

Genesys Knowledge Center allows you to make the best use of your enterprise knowledge by

capturing, storing, and distributing it wherever it is needed. Let's take a closer look at the various
capabilities of Knowledge Center and some corresponding use cases.

¢ Knowledge-assisted Channels
* Proactive Knowledge

¢ Knowledge Web Search

Knowledge-assisted Channels

With Knowledge Center, you can:

¢ Knowledge-enable channels by providing the right answers to customers in-channel to deflect
interactions, leading to cost reduction and better customer service.

* Knowledge-assisted Email form: Find applicable support articles based on email ticket submission
and web form.

* Empower agents with context-appropriate knowledge in a unified desktop for faster resolution when
agent-assisted service is needed.

Use Case: Knowledge-assisted Email

Basic Flow Outcome 1 Outcome 2
1. Tracy clicks on an email web

form to find out if

GDemoTelecom has service in

an area that she is moving to.

f ] : Tracy ignores the FAQ search and types
2. Tracy types “Do you have ng?Cge'lfn%r:tv'gidagghSEhe ec;)t\éedr?a%ivvzp content in the message body since she
service in Belmont, CA?” in ’ 99 : has more questions.
the subject line. She provides feedback and closes the

i An email request is logged and placed in

3. Tracy clicks out of the subject queue.

line to type the content in the
message body.

4. An FAQ search is invoked.

Note: This use case requires customization of Web Form with Knowledge Search API.
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Use Case: Knowledge-assisted Social or SMS
Basic Flow Outcome 1 Outcome 2

1. @tibwizz sends a Tweet (or
SMS) “looks like | will miss my
connecting flight from LAX to
SFO” to @blueskyairlines.

Answer found.

; ; Answer not found.
2. Interaction is created and @Blueskyairlines auto-responds to

queued. @tibwizz “Click here to schedule a call Queue the message for agent.

. o with our travel consultant to rebook”.
3. Orchestration script invokes

Knowledge API to find
answers on what to do when
you miss connections.

Note: This use case requires customization of Orchestration logic.

Proactive Knowledge

* Combine Knowledge with Proactive Engagement to proactively provide suggested articles at the right
moment.

¢ Provide knowledge-based assistance for agents if the customer asks for a human-assisted channel
escalation.

¢ Reduce effort, reduce friction and channel escalation.

Use Case: Proactive Knowledge

Basic Flow Outcome 1 Outcome 2 Outcome 3

Suggested Pages/Info
1. Jurgen browses Within the suggested articles
1cni u I
www.Gbank.com to section of the page, a few
research College links are populated:

Savings Plan.

. Starting a college Jurgen looks at suggestions,

i A Jurgen ignores the but still continues to browse.

2. He navigates to the savings plan suggestions.

page. Proactively offer customers
3. Web Engagement « Transferring an No action taken. the ability to escalate to

. A ist ice.

Rules can trigger existing college assisted service

knowledge article savings plan

lookup to provide .

knowﬁedggnudges e College Savings Plan

Calculator
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Note: This use case requires customization of Rules and Web Page logic.

Knowledge Web Search

Enable dynamic FAQ and channel deflection using natural language search and present knowledge

articles to customers via the web.

Use Case: Contact Center Escalation

The following list of outcomes from examples on this page demonstrates how Knowledge Center
allows customers to serve themselves if they want to, while providing them with easy ways to
contact an agent if they cannot find what they are looking for:

¢ Qutcome 3 in the Web Search and Proactive Knowledge examples

e QOutcome 2 in the Knowledge-assisted Email example

e Qutcome 3 in the Knowledge Assisted Chat example

Use Case: Web Search

Basic Flow Outcome 1

1. John recently booked
an Alaskan vacation
for his family on
Blue Sky Airlines.

2. John would like to
know if he can gate
check his baby’s
stroller and car seat.

One Question. One Answer.

Knowledge Center finds the
right answer in the FAQs and
3. John goes on provides the answer to John.
www.blueskyairlines.com

and in the search

box types “can |

gate check my

infant car seat and

stroller?”

Outcome 2

Top 3 Answers.

Knowledge Center also
provides two other articles
that contain information about
gate checking guidelines.

Note: This use case requires customization of Rules and web page logic.

Outcome 3

John is not satisfied with the
answers and says answer was
not helpful.

John is offered a choice of
chat, email, or callback based
on agent availability or hours
of operation.

Agent receiving John’s request
is presented with all the
relevant information about
John, his reservations, and the
answers viewed by John so
that he/she can quickly help
John.
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Use Case: Fast access to content with auto-complete

Basic Flow Outcome 1 Outcome 2

1. John goes online to the Blue
Sky Airlines website.

2. He navigates the website and
finds the page for Traveling
with an infant.

3. After reviewing the page, John

is not clear if he can gate John {_inds ;h? ?nlswers to the suggested John has more questions.
check his stroller. questions helptul.
. Create a chat interaction and place John
. He provides feedback and closes the )
4. John notices a Search Bar at et in queue.

the top of the page and types
“can | gate check”

5. Genesys Knowledge Center
Auto-complete functionality
provides suggestions like
“can | gate check my infant
car seat?”.

Use Case: Browsing though document categories

Basic Flow Outcome

1. As John reads the knowledge article about gate
checking his infant’s car seat, he also notices a
category link called “Traveling with Infants”. John now has all the information he needs.

2. John clicks on .the link and now has access to He answers “Yes” to the feedback question from the original
four other articles:

article, which now ranks the article higher for subsequent
searches.

e Travel tips for parents traveling with infants
Note: Feedback is not available for browsed articles, since all

e Baggage allowance for infants feedback is directly related to a search query.

e Online check-in for parents traveling with
kids
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Knowledge Center Components

Before you start working with Genesys Knowledge Center, you might find it helpful to learn about its
components:

¢ Knowledge Center Server—Combines indexing and natural language-based search capabilities to
provide effective knowledge article retrieval from one or more knowledge bases.

¢ Knowledge Center CMS—Provides customers who do not have an existing Content Management
System (CMS) with the ability to create and update their knowledge bases and push them to the

Genesys Knowledge Center Server for indexing and search. This component also allows customers to
import and edit knowledge articles from a file.

« Knowledge Center Plugin for Workspace Desktop Edition—Provides agents with access to
knowledge events (searches, article views and feedback) related to the current customer and also
allows them to search the knowledge base right from their desktop.

Knowledge Center Server

The Genesys Knowledge Center Server combines indexing and search capabilities that allow for
effective knowledge retrieval over one or more knowledge bases.

Also, Genesys Knowledge Center Server provides the ability to use Named Entity Dictionaries to build
a domain-specific thesaurus which, in turn, can be used as a Synonyms dictionary to expand the set
of keywords when searching for documents. This provides greater efficiency of the search query
formulated by words that are close in meaning to the subject of the search.

The Knowledge Center Server requires Elasticsearch 6.2 cluster to be set up and running.

Elasticsearch is a search server based on Lucene. It provides a distributed, multi-tenant-capable full-
text search engine with a RESTful web interface and schema-free JSON documents. ElasticSearch is
distributed, which means that indices can be divided into shards and each shard can have zero or

more replicas. Each node hosts one or more shards, and acts as a coordinator to delegate operations
to the correct shards.

Other Features of the Knowledge Center Server

¢ Knowledge Center Server exposes a REST API that can be used for both client and management
functions.

Knowledge Center Server is a cluster application, meaning that several nodes or servers can be
grouped within a single cluster.

* Knowledge Center Server requires two application objects in Genesys Administrator:
* One to describe the server itself (type = Genesys Knowledge Center Server)

* Another for storing high-level options and knowledge base configurations, and for integrating the
Knowledge Center server with other applications (type = Application Cluster)

Genesys Knowledge Center Deployment Guide 10
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* You can use third-party load-balancers above the cluster to organize your servers into a single pool,
thereby providing a single point of entry for your users.

* Knowledge Center Server uses Genesys Roles to restrict access, and to authorize and authenticate
users.

Knowledge Center CMS

The Knowledge Center Content Management System (CMS) serves several purposes:

¢ Creates, activates, and deactivates knowledge bases
¢ Creates, updates, and deletes questions and answers in a knowledge base
* Assigns categories to this content

¢ Imports historical information from the Knowledge Center Server

The CMS primarily interacts with the Knowledge Center Server when creating or updating index data.

Plugin for WDE

Your agents can use the Knowledge Center Plugin for Workspace Desktop Edition (WDE) to access
Knowledge Center data from from their WDE worksession.

For example, if a customer escalates a question using a chat widget and the resulting interaction is
routed to an agent, Knowledge Center can pre-populate a search based on the data that is attached
to the chat interaction. When the interaction reaches the agent, he or she will see the customer's
search history, so the customers needs can be met more quickly. In cases where the customer
doesn't authorize automatic search-based access, the agent will also be able to search the
customer's session history if the customer allows this during their chat.

The following images show a FAQ search and customer history, respectively.

Genesys Knowledge Center Deployment Guide 11
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Integration with Genesys Solutions

Widgets

Knowledge Center functionality is pre-integrated into Genesys Widgets, as the part of Widgets
framework. The following Knowledge Center related components are included:

¢ KnowledgeCenterService widget - provides APl and events exposed by Knowledge Center within the
Widgets framework.

Genesys Knowledge Center Deployment Guide 12
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What is Genesys Knowledge Center?

Knowledge Center Components

e Search widget - allows a customer to address his question to the corporate knowledge. The Ul appears

within the page and customers can ask a question (search), review provided results, and provide
feedback on whether the results addressed the problem.

e ChatDeflection widget - allows a customer to address a question while waiting for a customer service

agent to join a live chat. ChatDeflection does not introduce a new Ul, it simply adds additional

functionality to the WebChat widget. ChatDeflection widget uses the KnowledgeCenterService widget to
match a customer's question to the corporate knowledge base and comes up with the most relevant
knowledge for that question. ChatDeflection stops any interactions with the customer as soon as the
customer service agent joins the live chat session. The customer service agent who joins the session
after the deflection attempt, now has some context of the customer issue ready for review, as well as

the information on the suggested knowledge and the customer's interactions with it.

Pulse

Reporting functionality is not available in the 9.0 release of the product. Please
contact customer care for further guidance.

Genesys Web Engagement

While it isn't exactly a component, we thought this would be a good place to mention that you can
integrate Knowledge Center with Genesys Web Engagement. GWE helps you monitor, identify, and
proactively engage web visitors in conversations that match your business objectives. And
Knowledge Center can be used with GWE to provide proactive engagement capabilities.

For more information, see how to integrate Knowledge Center with Genesys Web Engagement.

Genesys Knowledge Center Deployment Guide
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High-Level Architecture

Genesys Knowledge Center consist of several components:

¢ Genesys Knowledge Center Server
* Genesys Knowledge Center CMS

¢ Genesys Knowledge Center Plugin for Workspace Desktop Edition

Genesys Knowledge Center Server

Knowledge Center Server is the heart of the Genesys Knowledge Center solution. For purposes of
load balancing and reliability, you can logically group your Knowledge Center Servers within a
Knowledge Center Cluster. Each server in the cluster owns the same data and can be used to execute
any desired queries against this data. These servers must be accessed by means of a properly
configured load balancer that distributes the load among the server instances.

l

/_ Knowledge Center Cluster

Workspace

Deskiop Edisien

v

Intranet Load Balancer

\

=¥ RESTwia HTTP/s
e TCP | Internal Communication)

Load Balancer/Reverse Proxy

l

Knowledge Center High Level Architecture

Genesys Knowledge Center Server provides several levels of integration, allowing you to access your
knowledge wherever you need it—and in the way that best suits your needs. This includes a set of
RESTful APIs that enables you to index data, query the server to find answers, and check usage
information.

The Sample Ul

The Sample Ul is a JavaScript/HTML sample application that you can use as an example of how to

Genesys Knowledge Center Deployment Guide 14
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integrate Knowledge Center into your corporate site. It runs in the visitors' browser and allows them
to find answers to their questions in your corporate knowledge base.

The Sample Ul offers all of the available levels of integration, allowing you to chose the one that best
suits a particular need, whether it is:

« The Knowledge API—The RESTful web service that provides access to the Knowledge Center Server
functionality

* The Knowledge Agent—A low-level JavaScript mapper that covers the Knowledge APl and
encapsulates Knowledge session management

The Ul Widgets—Basic and atomic Ul elements covering different aspects of working with knowledge

 The Sample Ul—An integrated sample application that implements fully functional access to the
knowledge stored in Knowledge Center Server

Sample Ul

Knowledge agent

Knowledge API

Knowledge Center Sample Ul

Genesys Knowledge Center CMS

The Genesys Knowledge Center CMS is an optional component that can be used to store company
knowledge and allow role-based access for authoring and improvement. The CMS is seamlessly
integrated with Knowledge Center Server using its public REST APIs and allows you to:

¢ Index authored information into the Knowledge Center Server to expose it for use by agent and
customers

Genesys Knowledge Center Deployment Guide 15
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* Retrieve usage information from the Knowledge Center Server and use it to better understand customer
needs and to improve your knowledge base

For more information, consult the Knowledge Center User's Guide.

—_—
/ Knowledge Cantar Clustar \

Knowledge
Center Server

Knowledge
Center
cMsS

Intranat Load Balancer

Knowledge Knowledge
Center Server Center Server

- /

weip  RESTvia HTTP/s
Knowledge Center CMS Architecture

s TCP (Internal Communication)

Genesys Knowledge Center Plugin for Workspace Desktop Edition

Genesys Knowledge Center comes with a plugin that allows it to be easily integrated into the
Genesys environment:

e The Plugin for Workspace Desktop Edition—enriching standard agent workplace with the
knowledge functionality and history of customer interaction with the knowledge

You can also integrate Knowledge Center with Genesys Web Engagement. This allows you to take
actions based on the way your knowledge is used by the customer and agents.

Genesys Knowledge Center Deployment Guide 16
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Terminology

Terminology

Term

cluster
knowledge base

node
replica

shard

Meaning

Set of the Knowledge Center Servers that are
working together using the same knowledge.

Collection of your knowledge sharing same
taxonomy (set of categories) and covering same
domain/sub-domain.

One instance of the Genesys Knowledge Center
Server.

backup shard of data used to guarantee data
redundancy.

The way to divide your knowledge base on chunks
that can be distributed between different servers.

Genesys Knowledge Center Deployment Guide
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Planning Your Deployment

This chapter helps you to plan the Knowledge Center deployment within your environment. It covers
following topics:

* Terminology

¢ Prerequisites

e Multi-Tenancy

¢ Planning Your Cluster

* Hardware Recommendations

* Software Configuration

The exact deployment architecture and solution size will vary depending on your
hardware and your ability to fine-tune the deployed system to get the best
performance on your equipment and with your particular user load. However, the
estimates in the following topics may give you some basic ideas on how to size your
deployment.

Genesys Knowledge Center Deployment Guide 18
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Prerequisites

OS Requirements

Knowledge Center Server

* OS Red Hat Enterprise Linux 7 (Intel EM64T)
¢ OS Windows Server 2012
¢ OS Windows Server 2016

Knowledge CMS

¢ OS Red Hat Enterprise Linux 7 (Intel EM64T)
¢ OS Windows Server 2012 (Intel EM64T)
¢ OS Windows Server 2016

Genesys Knowledge Center Plugin for Workspace Desktop Edition

* OS Windows Vista (Intel 32-bit)

¢ OS Windows 7 (Intel 32-bit, Intel EM64T)
¢ OS Windows Server 2012 (Intel EM64T)
* OS Windows Server 2016

¢ .Net framework 4.6.2 or higher

Genesys Knowledge Center Plugin for Pulse

¢ OS Red Hat Enterprise Linux 5 (Intel EM64T)
¢ OS Windows Server 2012 (Intel EM64T)
¢ OS Windows Server 2016

Web Browsers

¢ Google Chrome 34+

e Mozilla Firefox 54+

Genesys Knowledge Center Deployment Guide 19
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e Microsoft Internet Explorer 9, 10, 11
e Microsoft Edge
e Apple Safari 10+

Java Requirements
* OpenJDK
Minimum version - Version 8

Maximum version - Version 9

For Open)DK 9 to work as expected, you must make the following changes in either Windows or
Linux.

Windows

1. Open the \server\launcher.ini file.

2. Uncomment the following lines:

; --add-modules=java.xml.bind

; --add-modules=java.se.ee

; --add-modules=jdk.management
3. Open the \cms\launcher.ini file.
4. Uncomment the following lines:

; --add-modules=java.xml.bind

; --add-modules=java.se.ee
; --add-modules=jdk.management

Linux

1. Open the \server\setenv.sh file.

2. Uncomment the following lines:

JAVA 9 OPTS="--add-modules=java.xml.bind --add-modules=java.se.ee --add-
modules=jdk.management"

3. Open the \cms\setenv.sh file.
4. Uncomment the following lines:

JAVA 9 OPTS="--add-modules=java.xml.bind --add-modules=java.se.ee --add-
modules=jdk.management"

Genesys Knowledge Center Deployment Guide 20
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Prerequisites

Elasticsearch Requirements

e Elasticsearch 6.2.3

Genesys Environment

¢ Genesys Framework 8.1-8.5

e Configuration Server (8.1.300.21/8.5.101.41)

¢ Genesys Administrator 8.5.210.10 or higher

e Workspace Desktop Edition 8.5.120.05 or higher
e Pulse 8.5.108.02 or higher

Genesys Knowledge Center Deployment Guide
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Planning Your Deployment Sizing Information

Sizing Information

Disclaimer: This page contains information related to the 8.5.x release of the
product. It will be updated soon to reflect the 9.0 release.

Before deploying the Genesys Knowledge Center solution to your production site, you must estimate
the size of the solution that can handle the expected user load. Genesys recommends that you
download the Sizing Calculator, an Excel workbook that you can use to help calculate the number of
nodes required for your production deployment. Note: clicking the link will automatically start the
download.

The process of estimation starts from input values, usually given in the terms of business operations
(for example, number of knowledge bases, or number of sessions and questions per session). Using
some math, and having in mind the workflow that is applied to the input traffic, you can then produce
the expected load values in terms of requests per second. Applying these values to the
experimentally produced measurements, you can estimate the size of the solution required to be
deployed.

The minimum number of the Knowledge Center Server nodes in Knowledge Center
Cluster is 3. When doing the lab testing you can use 1 node configuration.

A cluster with 2 nodes cannot be used in the lab or in a production deployment.
Running a 2 node cluster might lead to data loss in a network outage between these
nodes.

Genesys Knowledge Center Deployment Guide 22
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Hardware Recommendations

Disclaimer: This page contains information related to the 8.5.x release of the
product. It will be updated soon to reflect the 9.0 release.

Hardware you can use to deploy the Knowledge Center varies from the particular needs & conditions
that you will use it in. Below is the set of recommendations and considerations that will help you to
achieve a better understanding how the different components our your environment influence the
Knowledge Center performance.

CPUs

Overall application is light on CPU when in comes to finding relevant knowledge to your search
requests. This leads to lower dependency on CPU performance. Any modern processor with multiple
cores will do the job. These days, two key parameters of the CPU are: speed and number of cores. In
this case, you should choose a CPU with more cores than a slightly faster one. This allows the
Knowledge Center to service concurrent requests more efficiently.

A modern CPU with 4 or 8 core CPUs is recommended.

Memory

This solution is designed to process tons of data and select only relevant data for each one of your
queries. In this case, memory is one of the resources that is intensively used. When planning your

host memory you need to ensure that RAM size will be enough to host all your running applications
and some extra is left for the system to host the OS filesystem cache.

The absolute minimum of 8Gb RAM must not be crossed. It is recommended to use hosts with 16 Gb.
With optimization and running multiple applications on the host, you may end up with 32 or 64 Gb
hosts.

In most cases it is recommended to plan your deployment with 50% of your memory
allocated to the running application. The remaining 50% is used for the OS filesystem
cache allowing for different software (including Genesys Knowledge Center) to work
faster and minimizing disk operations.
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Discs or Storage

Disks play a key role in the system performance as well. Being data-intensive and doing a lot of the
read-write operations, Genesys Knowledge Center Server is highly dependent on the speed of the
disk operations.

There are several common ways to improve performance of read-write intensive applications:

¢ Use the OS cache to minimize the number of read operations required (see recommendation above in
the Memory section).

¢ Using faster disks; high-performance (15K) spinning disks are a good choice. Usage of SSD disks will
burst the performance of your cluster even mlore.

¢ Using RAID 0 to improve the speed over any type of disk you are using (no need to go further with
redundancy features of RAID, as data replication is the integral part of the solution itself).

The amount of disk space consumed by the Genesys Knowledge Center solution can be estimated
using the Sizing Calculator.

Avoid any types of the disk technologies that increase latency and throughput. An
example of this solution would be the NAS.

Network

We recommend keeping all your nodes within a cluster in the same network, avoiding cross data
center communication. Replication of the data between datacenter is a separate concern and
deserves a separate solution.

The key parameters of the network you need to watch for are:

e latency: the Knowledge Center Cluster is the self-managing solution that distributes the load between
all available nodes. By sending a request to one node of the cluster, your are employing all nodes (to
the extent that it makes sense) to execute your request. Keeping the latency low will guarantee you the
maximum speed of distributed execution.

* reliability: minimizing the number of disconnects in the system will guarantee that the Knowledge
Center Cluster is fully concentrated on serving the request of your internal and external customers
instead of doing house-keeping duties such as replacing dead nodes and relocating the data.

e bandwidth: being quite light in network communication during ordinary work (executing the searches),
this solution can be demanding on the network bandwidth while indexing huge amounts of data or
recovering from node failure.
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summary

Genesys Knowledge Center Server does not require any enormous hardware configuration to run on.
A medium-sized box is the best option to run this application.

Another general recommendation is to keep your hardware set up as solid as possible:

e adding a high performance, huge RAM, SSD RAID 0 enabled server to the cluster of outdated servers will
not provide any noticeable or stable performance improvement overall of the solution. The speed of
newly-added servers are completely compromised by the old hardware that executes parts of the same
requests making the overall response and performance to be almost unchanged.

e putting one server into a higher latency network segment can improve some access parameters in that
particular segment but will result in overall system performance degradation.

The best shot for the deployment of the cluster is using similar hardware for all servers and putting
them into similar network conditions. This will ensure the most balanced use of your resources.

Please ensure that the disk's volume that you are using for search indexes has at least
of 15% of the total volume of the disk in free space. We are recommending not to use
huge volumes as it requires you to have a lot of free space. Genesys Knowledge
Center Server is constantly monitoring the remaining free space on the disk and if it
finds that there is less then 10% of your disk volume left, it might make a decision to
relocate indexes on a different host.
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Software Configuration

Disclaimer: This page contains information related to the 8.5.x release of the
product. It will be updated soon to reflect the 9.0 release.

JVM Settings

We recommended you run the most recent version of Java Virtual Machine. The minimum version
supported is Java 1.8 64 bit. The recommended (default) memory settings for the Knowledge Center
Server java process (Xms/Xms) is 4 Gb. Extending it to 16 Gb might be a good idea when using large
amounts of data. Adding and extra 4 Gb of heap for the process recommended on the nodes that are
used to execute history archiving.

It is strongly advised to not set the Xmx larger than 30Gb.

Co-Locating On Same Host

We do not recommended co-locating two or more nodes of the Genesys Knowledge Center Server on
the same host. Loosing the host due to hardware or network failure will result in two or more nodes
being lost by the cluster. This will lead to massive network operations, potential loss of data (in the
case where the number of replications is configured to 1) and even a complete outage of the cluster
(for example, for clusters with 3 nodes).

Genesys Knowledge Center Server can be co-located on the same host with other Genesys or 3rd
party solutions.

When co-locating please ensure that:

e The host is equipped with enough resources, especially RAM

¢ the solutions you are co-locating with are not causing any CPU spike when any other application on the
host is blocked

Do not co-locate with other disks' read-write intensive solutions as it could easily overrun capabilities
of your disk system.
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In most cases it is recommended to plan your deployment with 50% of your memory
allocated to the running application. The remaining 50% is used for the OS filesystem
cache allowing for different software (including Genesys Knowledge Center) to work
faster and minimizing disk operations.

Genesys Knowledge Center Server/Cluster Configuration

Genesys Knowledge Center Server/Cluster is configured by default to enable smooth and high
performance operations. Detailed information on every option exposed, valid values, and
considerations behind the solutions are available on the Configurations Options page of the product
documentation.

The section below provides additional information and recommendations.

Cluster Setup

The starting point of any cluster configuration is to create one application of the Application Cluster
type and as many as needed applications of the Genesys Knowledge Center Server type in Genesys
Administrator.

While doing this please ensure that you are creating the application only for the actual nodes of the
Server that you will use. Having a spare application added to the cluster will mislead the cluster
members while calculating the required number of nodes to be online and to enable cluster
functionality.

Generally a cluster expects the N/2+1 node to be online to start servicing the clients (where N is the
number of Genesys Knowledge Center Server applications connected to the cluster and is enabled).

For example, if you have configured 3 nodes in the Genesys Administrator and started just one, the
started server will refuse any client's requests as it will treat the overall cluster as not started yet.
The cluster will become functional only when the second node of The Genesys Knowledge Center
Server joins the cluster.

In rare cases when you still need to run such a configuration there are several ways to enforce cluster
functionality:

¢ Disable applications that you are not going to run (by unchecking the Enable checkbox in every such
application in Genesys Administrator)

¢ Manually setting the minimumMasterNodes value option in the index section into a desired value
(for example, 1 in the example below).
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We do not recommended using manual settings, especially manually defining the
minimumMasterNodes option as any incorrect values could result in data
corruption.

Tip
Running nodes needs to be restarted if you applying one of the listed below
recommendations.

Internode Communication

When running a production cluster it is required to disable the multicast node discovery by setting it
to false enabled option in multicast section of the cluster application object in the configuration. It
is also a good idea to disable multicast in lab deployments.

Multicast may lead to incidental joining of the undesired node to the cluster that will trigger data
relocations to rebalance the data between nodes.

Host On-Boarding

Having the majority of the configuration in common between all nodes in the cluster there are few
parameters that must be configured to onboard the node on a particular host. An example of these
parameters is the folder for log files that is configured in the log section of the Genesys Knowledge
Center Server application.

The other configuration that you need to set properly is the location of the indexed knowledge that is
configured in option path.data of gms.yml file.

It is recommended to store your indexed knowledge on the fastest disk you have on
the host. By default the data will be placed into the folder where you have installed
Genesys Knowledge Center Server.

If you have two disks attached to the host (for example, one spinning and another
SSD) you can reconfigure the application to store the data in the fastest disc (SSD)
while using the spinning disc for the application binaries.
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Multi-Tenancy

Knowledge Center 8.5.302.xx and earlier is a single tenant solution. This means that if you have a
multi-tenant environment and you want to use the Knowledge Center application within several
tenants, you need to deploy a separate cluster for every tenant where you plan to use the
application.

Starting from 8.5.303.xx release of the product it supports multiple tenants within one cluster
deployment. The list of the tenants needs to be explicitly set for the applications in cluster.

Within one Knowledge Center cluster all Knowledge Center Server nodes and all
Knowledge Center CMS nodes must be configured to have the same tenant(s) in the
Tenants section.
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Multi-Tenancy

Installation and Deployment

Task Summary: Genesys Knowledge Center

The following table outlines the task flow for installing Genesys Knowledge Center.

Objective

1. Prepare your environment

2. Configure the Knowledge Center Cluster
Application

3. Install the Knowledge Center Server

4. Install the Knowledge Center CMS

Actions

. Configure Languages
. Setup RDBMS for CMS

. Setup Elasticsearch cluster

. Import the Knowledge Center Cluster

Application Template

. Create the Cluster Applications

. Configure the Cluster Application

. Import the Knowledge Center Server Application

Template

. Create the Server Applications

. Configure the Knowledge Center Server

Application

. Install Knowledge Center Server

. Install the CMS

. Configure Data Source (based on the selected

provider):

e (if using Microsoft Server as persistent
storage), Configure the CMS to work with
Microsoft SQL Server

e (if using Oracle as persistent storage),
Configure the CMS to work with Oracle

» (if using PostgreSQL as persistent storage),
Configure the CMS to work with PostgreSQL

3. Configure the CMS
4. Manage the Knowledge Base using CMS
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Objective

5. Install the Workspace Desktop Edition Plugin

6. Configure agent accounts

7. Configure Reporting

Actions

. Install the Plugin for Workspace Desktop Edition
. Configure the WDE Application to work with the

WDE Plugin

. Grant access permission to content authors

. Provide Knowledge Center Server Access to

Agents

. Provide Knowledge Center Workspace Desktop

Edition Plugin Access to Agents

. Enable and configure reporting within your

Knowledge Center deployment
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Before you Begin

This chapter describe the step(s) required to prepare your environment for the Knowledge Center
installation. Preparation step(s) are:

¢ Define the languages used in your environment
¢ Chose and install RDBMS for Genesys Knowledge Center CMS

e Configure access to Elasticseach cluster for Genesys Knowledge Center Server

Configuring Languages

Overview

To operate the Genesys Knowledge Center solution you need to define and configure languages that
will be used within your knowledge.

Knowledge Center requires:

e all supported languages to be defined in Configuration Server

e |ISO codes to be defined in the Annex of the Language Attributes Values
Knowledge Center supports two types on languages:

¢ Language ("base" language)

¢ Regional language
Regional language is a version of the "base" Language that is used in a particular country.
The use of regional languages is recommended only in situations when knowledge documents can be
different in the different countries using a same language (for example: knowledge documents which
include local regulatory information or region-specific terminology, and so on).

Regional language requires two ISO codes:
* language code (ISO 639-1)

e country code (ISO 3166-1 alpha-2 code)

How to configure a language

1. Open Genesys Administrator and navigate to Provisioning > Routing/eServices > Business
Attributes.

2. Select Language business attribute
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Click Edit button
Select Attribute Values tab

Click New button or select existing attribute value and press Edit button

o v s W

On Configuration tab (skip this step if you are editing existing Attributes Value. For example, English
which is created by default)

a. Enter Name. For instance, French_CA
b. Enter Display Name. For instance French (Canada)

c. Ensure that State check is enabled

X
i | - \Business Attributes\Language\Attribute Values\
3¢ Cancel |l Save & Close |gll Save g Save & New
J _Co nfiguration H _Options H _Permissions
* Name: ‘French_CA|
' * Display Name: French (Canada)
Tenant:
Description:
Default: [ True
State: Enabled

7. Select Options tab:
a. Press New button to add language code
b. Enter "code" in Section field (eg. new section "code" should be created)
c. Enter "language" in Name filed (eg. new option "name" should be created)
d. Enter ISO 639-1 alpha-2 code that corresponds to desired language in Value field. For instance fr
e. Press OK button
8. If you are adding regional language you also need to specify a region code:
a. Press New button
b. Enter code in Section field
c. Enter country in Name filed

d. Enter ISO 3166-1 alpha-2 code that corresponds to desired region/country in value filed. For instance
CA

e. Press OK button
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X
i | - \Business Attributes\Language\Attribute Values\
¢ Cancel |l Save & Close |zl Save |gll Save & New
‘ _Conﬂguration H _Options ‘ ‘ _Permissions ‘
i | New _n—g‘DeIete 2 Export 3 Import View: Advanced View (Annex) v
Name « Section Option Value
T |Filter Filter Filter Filter
= code (2 Items)
code/country code country CA
code/language code language fr
9. Press Save & Close button
Note: You need to repeat this procedure for every language that you plan to use in your Knowledge
Base.
Please ensure that following rules are followed when you are adding Attribute Values
to the Language Business Attribute:
e Languages should be create in the same tenant in which Knowlege Server and CMS
applications will be configured.
¢ Every language needs to have language (mandatory) and country (if applicable) codes
defined on options tab (languages w/o codes will be ignored)
* Ensure that all language/country combinations are unique (duplicate combinations will
be ignored)
* Do not edit/change defined codes if they are used in the knowledge bases
e Language code needs to correspond to the ISO 639-1 alpha-2 code for the given
language (http://www.iso.org/iso/home/standards/language_codes.htm)
e Country code needs to correspond to the ISO 3166-1 alpha-2 code for given language
(http://www.iso.org/iso/country_codes)
Example
If you wish to have following languages in your environment:
¢ English
e French (Canadian)
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¢ French (France)

You will need to create 3 attribute values:

Display Name =

State
T | Filter Filter
View: || Language > [ ] Attribute Values
» English Enabled
» French (Canada) Enabled
» French (France) Enabled
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Name Display Name Options
code/language=en
X
] English - \Business Attributes \Attri Values\
% cancel [ Save & Close [ Save |l Save & New
‘760nﬂguratmn |‘7Dptinns H 7Pe| missions
[i"INew iz Delete ¥ Export 7 Import View: Advanced View (Annex) v
E n g | is h E n g I is h Name ~ Section Option Value
T Filter Filter Filter Filter
= code (1 Item)
code/language code language en
code/language=fr
code/country=FR
X
[ French (France) - \Busi i \Attribute Values\
2 Cancel H Save & Close H Save H Save & New
Configuration Options Permissions
French FR French (France) ‘ | — H
- [/ New i3z Delete % Export 1 Import View: | Advanced View (Annex) v
Name « Section Option Value
¥ Filter Filter Filter Filter

= code (2 Items)
code/country code country FR

code/language code language fr

code/language=fr
French_CA French (Canada) code/country=CA
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Name Display Name Options
I3

i} = \Busi il L \Attribute Values\

3 Cancel [l Save & Close [l Save |l Save & New

| configuration ” Options H Permissions

[i"INew [i¢Delete % Export T3 Import View:‘Advanced View (Annex) ‘v
Name Section Option Value

T |Fiter | Fitter |[Fitter |[Ftter

2 code (2 Items)

code/country code country CA
code/language code language fr
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Installing a Relational Database Management System

Knowledge Center CMS requires a Relational database management system (RDBMS) to be deployed
and configured in order to store the knowledge data.

The following RDBMS providers are supported by Genesys Knowledge Center CMS:
e Microsoft SQL Server

e Oracle

* PostgreSQL

Please check supported versions of RDBMS in the Genesys Supported Operating
Environment Reference Guide.

Before proceeding with the installation of the Knowledge Center solution you need to:

1. Install RDBMS

2. Create a new dababase

3. Create a user that will be used by the Knowledge Center to access the database
4

. Ensure that you are able to connect to the new database from the hosts that the Knowledge Center CMS
nodes are running on

5. Create backups for the new database

Configure access to Elasticsearch

Knowledge Center Server requires Elasticsearch cluster to be deployed.

To use Elasticsearch culster by Knowledge Center Server you need to configure a Resource Access
Point and connect it with the Knowledge Center Cluster application.

Importing the Elasticsearch Resource Access Point Template
Start

1. Open Genesys Administrator and navigate to Provisioning > Environment > Application
Templates.

2. In the Tasks panel, click Upload Template.
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Tasks e

Create -~
@ Unload Template
Multi Update -

e Manage Annes

o4 Manage Permissions

Copy Object -

Copy Ohiject Fram
Other Location

3. Click Add and choose the application template (APD) file to import, then click Add.

4. Browse to the Elasticsearch_Resource_Access_Point.tpl file. Click Open.
The New Application Template panel opens:

. Gy mabreraborTy - =

5. Click Save & Close.

End

Creating the Elasticsearch Resource Access Point Application

Prerequisites

¢ You completed Importing the Elasticsearch Resource Access Point Template

Start

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.

2. In the Tasks panel, click Create New Application.
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3.

Tasks e

Multi Update -

.‘5‘3 Manage Connections
A Manage Options
.:fd Manage Annex

l\_{j Manage Permissions

Create -~

@ Create Mew
&pplication

In the Select Application Template panel, click Browse for Template and select the
Elasticsearch_Resource_Access_Point template that you imported in Importing the Elasticsearch
Resource Access Point Template. Click OK.
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. The template is added to the Select Application Template panel. Click Next.
. In the Select Metadata file panel:

a. Click Browse
b. Click Add
c. Select the Elasticsearch_Resource_Access _Point.xml file

d. Click Open

. The metadata file is added to the Select Metadata File panel. Click Next.

. In the Specify Application Parameters field:

a. Enter a name for your application (for instance, "Genesys Knowledge Elasticsearch RAP")
b. Make sure that State is enabled

c. Select the Host on which the Access Point will reside
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d. Click Create
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8. The Results panel opens.

9. Enable Opens the Application details form after clicking 'Finish' and click Finish. The
Elasticsearch Resource Access Point application form opens and you can start configuring its properties.

= P bewai b
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End

Configuring the Elasticsearch Resource Access Point Application

Prerequisites

* You completed Creating the Elasticsearch Resource Access Point Application.

Start

1. If your Elasticsearch Resource Access Point application form is not open in Genesys Administrator,
navigate to Provisioning > Environment > Applications. Select the application defined for the
Elasticsearch Resource Access Point and click Edit.

2. Expand the Server Info pane.

3. In the Tenant section, click Add and select your tenant (for instance, Environment). Click OK. (Tenant
should be same as the Genesys Application cluster previously created).

4. If your Host is not defined, click the lookup icon to browse to the hostname of your application, which
should point to the host where you plan to locate your Elasticsearch node or Load-Balancer.

5. In the Listening Ports section, create the default port by clicking Add. The Port Info dialog opens.
a. Enter the Port (for instance, 9200 [use value of http of your Elasticsearch]).

b. Click OK. The default port appears in the list of Listening ports.
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6. Ensure the Working Directory and Command Line fields contain a "." (period).
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7. Click Save.
8. The confirmation dialog for changing the application's port opens. Click Yes.
9. Select the Options tab.

* Make sure the following options are set in the [resource] section:

e [resource]/type=elasticsearch

10. Click Save & Close. If the confirmation dialog opens, click Yes.

End

Configuring the Knowledge Center Cluster for Use with Elasticsearch RAP

Prerequisites
* You completed Configuring the Elasticsearch Resource Access Point Application.

Start

1. Navigate to Provisioning > Environment > Applications. Select the application defined for the

Knowledge Center Cluster and click Edit.

2. In the Connections section of the Configuration tab, click Add. The Browse for applications panel
opens. Select a Genesys application defined as a Elasticsearch Resource Access Point, then click OK.

3. Select the added connection to application, click Edit and ensure that the default connection port is

selected as ID.

4. Click Save & Close. If the confirmation dialog opens, click Yes.
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End
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Automatic Provisioning during installation

During the installation of Genesys Knowledge Center Server and Genesys Knowledge Center CMS
from the Installation Package, the Installation Wizard will automatically apply some minimal
necessary provisioning actions for Configuration Server objects.

Provisioning during installation

The provisioning tool will take care of the following configuration details:

¢ Environment
* create "selfservice" media type in Business Attributes
* add language code to the English language
e Server or CMS application
» check if application connected with Application Cluster object
» define default ports (if they are not defined)
* copy tenants from the cluster object (if they are not configured explicitly)

* ensure that internal options are properly initialized

Provisioning tool

The provisioning tool is found in the following location:

e For Genesys Knowledge Center Server:
<path to installation folder>\server\tools\provisioning
¢ For Genesys Knowledge Center CMS:

<path to installation folder>\tools\provisioning
In this folder you will find logs with provisioning results in file provisioning. log

If everything is correct, the following results will appear (below is an example from Genesys
Knowledge Center Server):

Provisioning script is started with the following arguments:
[--host, host, --port, 2020, --app, Knowledge Center Server, --user, user --password, pa, --
all, --product, server]

Command-line arguments, used for the connection to Configurations server and provided by
Installation Wizard.
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[4503] Connected to ConfigServer 'confserv' at host 'host', port 2020
Connection to Configuration Server.

Starting configuration thread
Configuration thread started.

Starting configuring application
Configuration init successfully completed.

Information messages.
Application [Knowledge Center Cluster] is configured to work with [2] tenant
Tool get cluster's tenants

Start provisioning of application [Knowledge Center Server] on CfgServer [host:2020]
Process LANGUAGE target ...

English in tenant 1 already has language defined [en]

English in tenant 101 already has language defined [en]

Check if, at minimum, the English language (with code en) was created in configured Tenants. If not,
languages will be auto-configured. For more information, see Configuring Languages.

Process MEDIATYPE target ...
MediaType [selfservice] already exists in tenant 1. Leave it.
MediaType [selfservice] already exists in tenant 101. Leave it.

Check if selfservice media exists in configured Tenants. If not, selfservice Media Type is auto-
created.

Process APPLICATION target ...
Knowledge Center Server 902 has the same tenants as the Cluster application
Knowledge Center Cluster 902

The tool then checks if the Cluster and Server applications have the same set of tenants.
Setting Knowledge Center Server 902/CFGKnowledgeCenter ports
[default] has been set already [5600]

[clustering] has been set already [9152]
[kibana] has been set already [5601]

Check if the necessary ports are configured in the application. If not, the port is auto-configured (in
other words, a port is added and default values are set).

Provisioning script has finished work. Result: SUCCESS

End.

Limitations

In IP mode, provisioning cannot interact with the Installation Package in any other way than returning
an error code. This means that in a case of configuration issues we can write a report in the local
folder, but cannot communicate to the user any errors or warnings in any other way than "failed IP
installation".
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Configuring the Knowledge Center Cluster
Application

Carry out the procedures below, in order, to install and configure the Knowledge Center Cluster
Application.

Import the Knowledge Center Cluster Application Template

1. Open Genesys Administrator and navigate to Provisioning > Environment > Application
Templates.

2. In the Tasks panel, click Upload Template.
3. In the Click 'Add' and choose application template (APD) file to import window, click Add.

4. Browse to the Knowledge Center Cluster.apd file available in the templates directory of your installation
CD.

5. Click open.

6. The New Application Template panel opens.
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New Application Template Panel

7. Click Save and Close.
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Create Cluster Applications

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.
2. In the Tasks panel, click Create New Application.

3. In the Select Application Template panel, click Browse for Template and select the Genesys
Knowledge Center Cluster application template that you imported earlier. Click OK.
Browse |

 Instructions: Choose oljects from the list below

apphcaton Templates |
T T New . ) e Folder »

Fame = Trpe Erson Shabe
T File ——
View 7T Rost = [ Application Templates

I Conrdguraton_lanager 5 Coorfiguration lansger B Erabie:
P Condgorstion_Server_B Configuration Server 21 Enabied
P Gersays_Acminivmicr 5 Glenedys Adminsiraor g1 Enaibiess
| Gereups_Acminnvwioe_Server B Ganeiyn Adminsyatsr Server &1 Frata:
¥ Hecatedos Certer_Chele 823 Appis por Chealer 853 Erabies
|
Fagel ofl ¢ B & Displarying objacts 1- 5 of §

oo | _comcet |

“Selecting Knowledge Center Cluster Application Template
4. The template is added to the Select Application Template panel. Click Next.
5. In the Select Metadata file panel:
a. Click Browse.
b. Click Add.

c. Select the Knowledge_Center_Cluster.xml file available in the templates directory of your
installation CD.

d. Click Open.

5. The metadata file is added to the Select Metadata file panel. Click Next.

6. In Specify Application parameters:
a. Enter a name for your application. For instance, Knowledge Center Cluster.
b. Ensure that State is checked.

c. Select the Host on which the Knowledge Center Cluster load-balancer will reside.
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d. Click Create.
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Specifying Knowledge Center Cluster Application Parameters

5. The Results panel opens.

. Enable Open the Application details form after clicking 'Finish' and click Finish. The Knowledge
Center Cluster application form opens and you can start configuring the Cluster application.
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Configuring the Knowledge Center Cluster Application

Configure the Cluster Application

1. If your Knowledge Center Cluster application form is not open in Genesys Administrator, navigate to

Provisioning > Environment > Applications. Select the application defined for the Knowledge
Center Cluster and click Edit....

2. Expand the Server Info pane.

3. If your Host is not defined, click the lookup icon to browse to the host on which the Knowledge Center

Cluster load-balancer will reside.
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Knowledge Center Cluster serves as the entry point to all client requests sent to Knowledge Center Servers.
The cluster application in Genesys Administrator needs to be configured to point to the host and port of the
load balancer that will distribute these requests among your Knowledge Center Servers.

4. In the Listening Ports section, create the default port by clicking Add. The Port Info dialog opens.
a. Enter the port number for the Knowledge Center Cluster load-balancer, for instance, 9092.

b. Choose http or "https" for the Connection Protocol.

c. If you will be using a secure connection to the cluster, choose Secured for the Select Listening
Mode.

d. Click OK. The HTTP or HTTPS port with the default identifier appears in the list of Listening ports.

Port Info
General | Advanced Metwork Security

* ID:

" Port: Q092

Connection Protocol: hitg] v

HA sync: [ True .
Salect Listening Mode: Uinsacured w |
Description:

[ ok || canca |

Knowledge Center Cluster Port Information

e. In the Tenants section, add a working tenant by clicking Add. Browse and choose the appropriate
tenant in the pop-up dialog. Click Ok.

f. Ensure the Working Directory and Command Line fields contain "." (period).
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Knowledge Center Cluster Server Information

5. Click Save.

6. The Confirmation dialog for changing the application's port opens. Click Yes.

When configuring several Knowledge Center Clusters in one tenant, use the option
"knowledgebaseFolder" found in the "general" section to separate the folders for your
Knowledge Bases definitions in Scripts (for example, when setting different values for
different clusters).
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Installing the Knowledge Center Server

Import the Knowledge Center Server Application Template
Start
1. Open Genesys Administrator and navigate to Provisioning > Environment > Application
Templates.
2. In the Tasks panel, click Upload Template.
3. In the Click 'Add' and choose application template (APD) file to import window, click Add.

4. Browse to the Knowledge Center Server.apd file available in the templates directory of your installation
CD.

5. Click Open.

6. The New Application Template panel opens.
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The Knowledge Center Server Application Template

7. Click Save and Close.

End

Create Server applications

Start
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1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.
2. In the Tasks panel, click Create New Application.

3. In the Select Application Template panel, click Browse for Template and select the Genesys
Knowledge Center Server application template that you imported earlier. Click OK.
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Selecting the Knowledge Center Server Template
4. The template is added to the Select Application Template panel. Click Next.
5. In the Select Metadata file panel:

a. Click Browse

b. Click Add

c. Select the Knowledge Center_Server.xml file available in the templates directory of your installation
CD.

d. Click Open
6. The metadata file is added to the Select Metadata file panel. Click Next.
7. In Specify Application parameters:
a. Enter a name for your application. For instance, Knowledge Center Server' .
b. Enable the State
c. Ensure that State checkbox is checked
d. Select the Host on which the Knowledge Center Server will reside

e. Click Create
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Creating the Knowledge Center Server Application

6. The Results panel opens.
7. Enable Open the Application details form after clicking Finish and click Finish.

8. The Knowledge Center Server application form opens and you can start configuring the Knowledge
Center Server application.
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Knowledge Center Server Application Details

End

Configuring the Knowledge Center Server Application

Start

1. If your Knowledge Center Server application form is not open in Genesys Administrator, navigate to

Provisioning > Environment > Applications. Select the application defined for the Knowledge
Center Server and click Edit....
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2. In the Connections section of the Configuration tab, click Add. The Browse for applications panel
opens. Select the Knowledge Center Cluster application, then click OK.
| Browse F.

) Iestructions: Select application]s) to be added to the connection list
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Selecting the Knowledge Center Cluster Application

3. Expand the Server Info pane.

Fabe

Displaying sjects 1 - 7ol 7

4. If your Host is not defined, click the lookup icon to browse to the hostname of your application.

5. In the Listening Ports section, create the default port by clicking Add. The Port Info dialog opens.

a.

Enter the Port. For instance, 9092. This should be the port number for the Knowledge Center Server

instance.

Choose http or https for the Connection Protocol.

If you will be using a secure connection to the cluster, choose Secured for the Select Listening

Mode.

Click OK. The port with the default identifier appears in the list of Listening ports.
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| Port Info

General Advanced Metwork Security

= I

* Port: 9092

Connection Protocol: httgl -

HA sync: [ True _
Select Listening Mode: Uinsecured v |
Description:

ook J[ concel | |

Knowledge Center Server Port Information

6. Add a port that will be used by Knowledge Center Server nodes to communicate with each other by
clicking on the Add button and:

a. Entering clustering in the ID field
b. Entering the Port. For instance, 9152
c. Clicking OK
d. Ensure the Working Directory and Command Line fields contain "." (period).
e. In the Tenants section, add a working tenant by clicking Add. Browse and choose the appropriate
tenant in the pop-up dialog. Click Ok.
f. If you are using Access Groups to assign privileges to agents:
* Uncheck Log On As System
* In Log On Account specify the user account that has the ability to view access groups (for
example, user from the Super Administrators access group).
» User should have access to the same tenant/tenants in which that Node is configured
e User should belong to Administrator access group in Environment tenant or be granted "Read
and Execute (RX)" and "Read Permissions (E)" permissions for Environment tenant, if the
application configured not in the Environment tenant; user should belong to some
Administrator Access Group in application's tenant/tenants
g. Click Save.

h. The Confirmation dialog for changing the application's port opens. Click Yes.

. (Optional) Select the Options tab. In the [log] section, the all option is set to stdout by default.

Enter a filename if you wish to enable logging to a file. For example, you can enter stdout, C:\Logs\
Knowledge\Knowledge_server to force the system to write logs both to the console and to a file.
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Knowledge Center Server Application Logging Options

End

Installing Knowledge Center Server

Windows Installation Procedure

Important

From Knowledger Center Server version 8.5.302.04, you must install the Visual
C++ Redistributable Packages run-time components which are required to run
C++ applications on Windows.

Start

1. In your installation package, locate and double-click the setup.exe file. The Install Shield opens the
welcome screen.

Genesys Installation Wizard

‘Welcome to the Installation of Enowledge Center Server.

WErsion

bl |

-# Genesys Knowledge Center Server combines indexing and natural
it language-based search capabilies to provide effecive knowledge
| SR afficle ratieval from one of more knowledge bases

The Genasys Installation Wizard will guida vou thraugh the Knowledge
Cantar Saner installaton or maintenance, depending on your system
status,

S Genesys

To continue, click Mext. To axit the Wizard, click Cancal

] (o

Knowledge Center Server Installation Window

2. Click Next. The Connection Parameters to the Configuration Server screen appears.
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Genesys Installation Wizard E3

Connection Parameters to the Configuration Server

The parameters in the Host and U zer fields are required o establish a connection bo Configuraton
Server,

r Host

Specify the host name and port number for Hogt name: II:::::thusi
the machine on which Coniguration Server

1% IUnRinG,

Port: |2020
User
Specify pour Configuration Server user Uszer name: Idefault

name and passwiord.

Password: I..“....‘

< Back Mest = Cancel

D —
Knowledge Center Server Connection Parameters

3. Under Host, specify the host name and port number where Configuration Server is running. (This is
the main listening port entered in the Server Info tab for Configuration Server.)

4. Under User, enter the user name and password for logging into Configuration Server.

5. Click Next. The Select Application screen appears.
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Select Application

Select Application frorm the list of configured apphcations for target computer, If appbcation that you
afe trying boinstall iz not incthe Bzt bedow contact paur spstem adrmmiztrabor.

Application Properties:

Tvpe: Genesys Knowledge Center Server [130]
Host: okc-alBS

whorking Directony: .

Caommand Line: |

Command Line Args:

£

Selecting the Knowledge Center Server Application

6. Select the Knowledge Center Server application that you are installing. The Application
Properties area shows the Type, Host, Working Directory, Command Line executable, and
Command Line Arguments information previously entered in the Server Info and Start Info
tabs of the selected Application object.

Note: You might see "Reserved Application 6(190)" as the type under the application properties of
the selected application. This happens when older versions of Configuration Server are used.

7. Click Next. The Choose Destination Location screen appears.
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Choose Destination Location

Genesys Installation 'wizard will inztall Knowledge Center Server in the following Destination Folder.
To install to this folder, click Mext.

Ta install to & different folder, chok Browse and select another folder,
To restore a path to default Destination Foldes, click D efault.

Destination Folder

|E:"~F'|ngran FilezhGCT " nowdedae Center Serven\Enoweldoe Center Server |

| Defaut | | Browse. |

Choosing the Knowledge Center Server Installation Destination
8. Under Destination Folder, keep the default value or browse to the desired installation location.

9. Click Next. The Backup Configuration Server Parameters screen appears.

Genesys Knowledge Center Deployment Guide 59



Installation and Deployment Installing the Knowledge Center Server

Genesys Installation Wizard E3

Backup Configuration Server Parameters

Host

Specify Host name and Fort for the Host name: |
machine where the backup of
Configuration Server is running.

Part: |

< Back | Mest » I Cancel

Knowledge Center Backup Config Server Parameters

10. If you have a backup Configuration Server, enter the Host name and Port.

11. Click Next. Choose the appropriate version of the Java JDK.
Note: Knowledge Center Server requires Java 1.8 or higher.
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Genesys Installation VWizard |

Select Installed Sun's Java Development Kit [JDK]

Select Sun's Java Development Kit DDE) from the list of Sun's Java Development Kit WDE)
installed on tamet computern, Product propertis: will be updated based on your selechion

Sun's Java Development Kit [JDE] 1.8.0 5

Sun‘s Java Development Kit [JDE] properties:

"erzsion: 1.8.0 -
Patch Mumber: 5 J
Locaton: C:5Program Fileshava'ydk1.8.0_05

4 o

< Back Next > Cancel |

Selecting the Knowledge Center Server Java Version

12. Click Next. The Ready to Install screen appears.

Genesys Installation Wizard E
Ready to Install

Genezys Installation Wizard has collected all required mformation and iz ready to install Knowledos
Center Server on your compuber.

To install Knowledge Center Server, chick Install,
Toreview settings, chek Back. To exit the 'wizard, chck Cancel

< Back I Install I Cancel I
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Knowledge Center Server is Ready to Install

13. Click Install. The Genesys Installation Wizard indicates it is performing the requested operation.
When through, the Installation Complete screen appears.

14. Click Finish to complete your installation.

15. Inspect the directory tree of your system to make sure that the files have been installed in the
location that you intended.

End

Linux Installation Procedure
Start

1. Open a terminal in the Genesys Knowledge Center Server CD/DVD or the Genesys Knowledge
Center Server installation package and run the install.sh file. The Genesys installation starts.

2. Enter the hostname of the host on which you are going to install.
3. Enter the connection information required to log in to the Configuration Server:
a. Hostname—For instance, demosrv.genesyslab.com
b. Listening port—For instance, 2020
c. User name—For instance, demo
d. Password
4. If you have a backup Configuration Server, enter the Host name and Port.

5. If the connection settings are successful, a list of keys and Genesys Knowledge Center Server
applications is displayed.

6. Enter the key for the Genesys Knowledge Center Server application that you created previously on
Configuration Server.

7. Enter the full path to your installation directory and confirm that it is correct.

If the installation is successful, the console displays the following message: Installation of
Genesys Knowledge Center Server, version 8.5.x has completed successfully.

End

Installing multiple Server instances

To install multiple server instances you need to repeat following steps for every instance:

1. Create Server applications
2. Configuring the Knowledge Center Server Application

3. Installing Knowledge Center Server

Note: Knowledge Center Cluster Application is created just ones for all server instances working
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in the same cluster.

It is advices to do not co-locate several Knowledge Center Server instances on the
same host.

Geo-location database

¢ Database for Geo-IP Location (the way to translate client IP to its geographical location)

* On Windows, the path to /linguatools/geoip/GeoLite2-City.mmdb can be changed in the launcher.ini' file:
-DGEODB.

¢ On Linux, the path to /linguatools/geoip/GeoLite2-City.mmdb can be changed in the 'setenv.sh file under
CUSTOM_JAVA_OPTS: -DGEODSB.

Language Resources Configuration

* On Windows:
* The path to /linguatools/freeling/data/ can be changed in the launcher.ini file: -DFREELINGSHARE.
* The path to /linguatools/freeling/bin/ can be changed in the launcher.ini file: -DFREELINGBIN.

e On Linux:

* The path to /linguatools/freeling/data/ can be changed in the setenv.sh file under
CUSTOM_JAVA_OPTS:

e -DFREELINGSHARE - Path to Path to installation directory/linguatools/freeling/data
e -DFREELINGBIN - Path to Path to installation directory/linguatools/freeling/bin

Provide Knowledge Center Access to Agents

Tip

Access to a knowledge base may be limited by an agent's assigned skills (see
Installing and Using the Administrator Plugin). Please add the appropriate skills so
your agent may see the required knowledge bases (see Bulk Assignment of Skills to
Agents for more information).
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Genesys Knowledge Center supports the following privileges to restrict agent access:

¢ Allows agent to change data in a knowledge base (suggested for authors)

* Allows to bypass tenants restrictions (suggested for user configured in CMS for "Log On Account" in case
of multi-tenant configuration)

To configure the appropriate privileges for an Agent:

Start

1. Go to Provisioning > Accounts > Roles.
2. In the taskbar, click New to create a new object.

3. Set the name of the role in the General section.
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Knowledge Center Server Access Roles

4. Go to the Role Privileges tab and select the set of roles for Genesys Knowledge Center.
5. Open the list of privileges for Knowledge Center Server.

6. Set the appropriate privileges to Allowed.
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Setting Knowledge Center Server Access Privileges
7. Go back to the Configuration tab.
8. In the Members section, add the appropriate Agent by clicking the Add button.
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Knowledge Center Server Members Section
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9. Save and Close.

End

Start and Stop Genesys Knowledge Center Server

Start the Server

Windows:

You can start the Genesys Knowledge Center Server on Windows from:

e Windows Services
e The server.bat script

e Genesys Administrator

Start

* You can start the server from Windows Services:
1. Open Windows Services

2. Select and start the Genesys Knowledge Center Server [Knowledge Center Server] service.

¢ You can use the provided server.bat script:

1. Navigate to the Knowledge Center Server installation server directory and launch the Windows
command console (cmd.exe).

2. Open server directory

3. Type and execute server.bat, without any parameters.

You can use entry in the Start > All Programs > Genesys Solutions > Knowledge Center Server
[Knowledge Center Server] menu to start the Server using server.bat

* You can start the server from Genesys Administrator:
1. Navigate to PROVISIONING > Environment > Applications.

2. Select the Knowledge Center Server.
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3. Click Start applications in the Runtime panel.

End

The Genesys Knowledge Center Server is shown in Started status in Genesys Administrator.

Linux:

You can start the Genesys Knowledge Center Server on Windows from:

e The server.sh script

¢ Genesys Administrator

Start

* You can use the provided server.sh script:

1. Navigate to the Genesys Knowledge Center Server installation directory in the Unix command
console.

2. Go to server directory

3. Type and execute server.sh, without any parameters.
* You can start the server from Genesys Administrator:
1. Navigate to PROVISIONING > Environment > Applications.
2. Select the Knowledge Center Server.
3. Click Start applications in the Runtime panel.
End

The Genesys Knowledge Center Server is shown in Started status in Genesys Administrator.
After the Server start
After successful Server start you can use following URLs in your browser:

e http://<host>:<default_port>/gks-server - to access the Server REST API

e http://<host>:<default_port>/gks-sample-ui - to access Sample Ul application shipped with product
(Note: you need to load some data to be able to play with this application - reference on Quick Guide.)
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Stop the Server

Windows:

You can stop the Genesys Knowledge Center Server on Windows from:

e Windows Services
¢ Genesys Administrator

e A console window

Start

¢ You can stop the server from Windows Services:
1. Open Windows Services

2. Select and stop the Knowledge Center Server service.

* You can stop the server from Genesys Administrator:
1. Navigate to PROVISIONING > Environment > Applications.
2. Select the Knowledge Center Server.

3. Click Stop applications in the Runtime panel.

 If you previously started Genesys Knowledge Center Server in a console window, you can stop the
server by closing the window or navigate to Genesys Knowledge Center Server installation directory in
Windows console (cmd.exe), open server directory and execute comand: server.bat stop

End

The Genesys Knowledge Center Server is shown in Stopped status in Genesys Administrator.

Linux:

You can stop the Genesys Knowledge Center Server on Linux from:

¢ Genesys Administrator

e A console window

Start
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e can stop the server from Genesys Administrator:
1. Navigate to PROVISIONING > Environment > Applications.
2. Select the Knowledge Center Server.
3. Click Stop applications in the Runtime panel.
e Or you can stop the server from the console window where it was started:
1. Press Ctrl+C while the window is active.
2. Type Y and press Enter.

e Or you could use provided script server.sh:
1. Navigate to the Genesys Knowledge Center Server installation directory in the Unix command
console.

2. Go to server directory
3. Type and execute server.sh with parameter "stop" (for example: server.sh stop)

End

The Genesys Knowledge Center Server is shown in Stopped status in Genesys Administrator.
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Installing the Knowledge Center CMS

This chapter describes the process of installing and configuring Knowledge Center CMS that includes
following steps:

e Importing the CMS Application Template

e Creating and configuring CMS Application in Genesys Administrator

e Configuring the Data Source

¢ Installing the CMS

¢ Granting your agents authoring privileges

e Starting/Stopping the installed CMS application
Before you proceed with these steps you need:

* Configure Knowledge Center Cluster application

e Select and install one of the Relational Database Management Systems (RDBMS) from the supported
link

e Configure the load-balancer for access to CMS

Knowledge Center CMS support one of the following RDBMS as persistent storage:

e Microsoft SQL Server 2012
e Oracle 119
* PostgreSQL

Install the CMS

Import the CMS Application Template

Start
1. Open Genesys Administrator and navigate to Provisioning > Environment > Application
Templates.
2. In the Tasks panel, click Upload Template.
3. In the Click 'Add' and choose application template (APD) file to import window, click Add.

4. Browse to the Knowledge Center CMS.apd file available in the templates directory of your installation
CD. The New Application Template panel opens.
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The Knowledge Center CMS Application Template

5. Click Save and Close.

End

Create CMS Applications

Start

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.
2. In the Tasks panel, click Create New Application.

3. In the Select Application Template panel, click Browse for Template and select the Genesys
Knowledge Center CMS application template that you imported earlier. Click OK.
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Selecting the Knowledge Center CMS Template
4. The template is added to the Select Application Template panel. Click Next.

5. In the Select Metadata file panel, click Browse and select the Knowledge_Center_ CMS.xml file. Click
Open.

6. The metadata file is added to the Select Metadata file panel. Click Next.
7. In Specify the appropriate application parameters:
a. Enter a name for your application. For instance, Knowledge Center CMS.
b. Enable the State.
c. Select the Host on which the CMS will reside.
d. Click Create.
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Creating the Knowledge Center CMS Application

5. The Results panel opens.

Enable Opens the Application details form after clicking 'Finish' and click Finish. The Knowledge
Center CMS application form opens and you can start configuring the CMS application.
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Configuring the Knowledge Center CMS

End

Configure the CMS Application
Start

1. If your Knowledge Center CMS application form is not open in Genesys Administrator, navigate to

Provisioning > Environment > Applications. Select the application defined for the Knowledge
Center CMS and click Edit....

2. In the Connections section of the Configuration tab, click Add. The Browse for applications panel
opens.

3. Select the Knowledge Center Cluster application, then click OK.
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4. Expand the Server Info pane.
5. If your Host is not defined, click the lookup icon to browse to the hostname of your application.

6. In the Listening Ports section, create the default port by clicking Add. The Port Info dialog opens.
a. Enter the Port. For instance, 9000.

b. Choose http or "https" for the Connection Protocol.

c. If you will be using a secure connection to the cluster, choose Secured for the Select Listening
Mode.

d. Click OK. The port with the default identifier appears in the list of Listening ports.
| Port Info f

General Advanced Mebwork Security

| - |
A

* Port: (9000 |
Connection Protocol: e
HA sync: O True
Il Select Listening Mode: Unsacured e |
! Description:

Knowledge Center CMS Port Information

7. Add a port that will be used by Knowledge Center CMS nodes to communicate to each other by clicking
on Add and:

a. entering clustering in the ID field
b. entering the Port. For instance, 9150.

c. Clicking OK

8. In the Tenants section, add a working tenant by clicking Add. Browse and choose the appropriate
tenant in the pop-up dialog. Click OK.

9. Uncheck Log On As SYSTEM.

10. In Log On Account specify the user account that:

* has the ability to view access groups (this is required if you use access groups to set privileges for
your agents)

* has Knowledge.AUTHOR (Allows agent to change data in a knowledge base) privilege and
Knowledge.MULTITENANT (Allows to bypass tenants restrictions) in case multi-tenant
configuration (required for scheduled synchronization)

* User should have access to the same tenant/tenants in which that CMS is configured

* User should be granted "Read and Execute (RX)" and "Read Permissions (E)" permissions for
Environment tenant, if the application configured not in the Environment tenant; user should belong
to Administrators Access Group in CMS tenants (required for scheduled synchronization)
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14. Click Save.

15. The Confirmation dialog for changing the application's port opens. Click Yes.
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Knowledge Center CMS Information

16. Go to Application Cluster application, open Options tab. In section cms.general set valid URL to CMS
or CMS cluster load balancer in externalURL option (for example, http://<cms host>:<CMS default
port>/gks-cms).

End

Configure Data Source

Knowledge Center CMS requires persistent storage to be configured to store all the authored content.
Please follow one of the instructions to set up storage of your choice:

* Microsoft SQL Server - Using CMS with Microsoft SQL Server
¢ Oracle - Using CMS with Oracle
e PostgreSQL - Using CMS with PostgreSQL

Installing the CMS
Windows Installation Procedure
Start

1. In your installation package, locate and double-click the setup.exe file. The Install Shield opens the
welcome screen.
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Installing the Knowledge Center CMS

Genesys Installation Wizard

wherever it iz needed,

syztermn status.

Welcome to the Installation of Knowledge CMS, version

Genesys Knowledge Center alloves pou to make the best use of your
enterprize knovdedge by capturing. stomng, and distribubing i

The Genezys Installation Wizard will gusde vou through the
F.rnowledge CMS matallation or maintenance, depending on vour

E:"J Genesys‘ To continue, chck Mest. To exit the Wizard, click Cancel

Mext >

Cancel |

Knowledge Center CMS installation Window

2. Click Next. The Connection Parameters to the Configuration Server screen appears.

Genesys Installation Wizard

Connection Parameters to the Configuration Server

Server.

The parameters in the Host and Uzer helds are required to establizh a connection to Configuration

the machine on which Canfiguration Server

Specify the host name and port numbet for - Host name: Jhcalhnst

i% unning.
Port: [2020
~ User
Specify your Configuration Server user User name: Jdgfau“:

name and password,

Pazsword: [....M|

< Back

Mext =

Knowledge Center CMS Connection Parameters
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3. Under Host, specify the host name and port number where Configuration Server is running. (This is the

main listening port entered in the Server Info tab for Configuration Server.)
4. Under User, enter the user name and password for logging in to Configuration Server.

5. Click Next. The Select Application screen appears.

6. Select the Knowledge Center CMS that you are installing. The Application Properties area shows the

Type, Host, Working Directory, Command Line executable, and Command Line Arguments
information previously entered in the Server Info and Start Info tabs of the selected application

object.
Genesys Installation Wizard E3
Select Application

Select Application from the list of configured applcations for target computer. IF application that vou
ate fving to install iz nat in the list below contact your system administrator,

Application Properties:

Type: Genesys Knowledge Center CMS [191] ;I
Host: gk z-dep-nghtly
orking Direchony: .
Cormmand Line:
Command Line Args: | _,I
4 F
< Back Mewt » Cancel |

Selecting the Knowledge Center CMS Application
7. Click Next. The Choose Destination Location screen appears.

8. Under Destination Folder, keep the default value or browse for the desired installation location.
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Genesys Installation Wizard Ed I
Choosze Destination Location

Geresys Installation Wizard will install Enowledge CMS in the fallowing Destination Folder,

Toinstall to this folder, chck Mest.
Toinztall to a different folder, click Browse and select another folder.
Torestore a path to default Destination Folder, chck Default

Destination Folder

|C:\Program Files\GCTI\Knowledge CMSA\GKC_CMS_IP

Drefault Browsze. . |

¢ Back Next > Cancel |

Choosing the Knowledge Center CMS Installation Destination

9. Click Next. Choose the appropriate version of the Java JDK.
Note: Knowledge Center Server requires Java 1.8 or higher.

Genesys InstallotionWizord K|
Select Installed Sun's Java Development Kit [JDK]

Select Sun's Java Development Kit DK fram the list of Sun's Java Development Kit [JDE)
installed on tamet computern, Product propertis: will be updated based on your selechion

Sun's Java Development Eit [JD

Sun's Java Development Kit [JDK) properties:

"erzsion: 1.8.0 -
Patch Mumber: 5 J
Locaton: C:5Program Fileshava'ydk1.8.0_05

4 o

< Back I Mest > I Cancel |
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Selecting the Knowledge Center CMS Java Version

10. Click Next. The Ready to Install screen appears.

Ready to Install

Genezws Installation Wizard has collected all required mformation and iz ready to install Enowledos
CRS on wour computer.

To install Knowledoe CHMS | click Install.
Toreview settings, chek Back. To exit the Wizard, chek Cancel

< Back I Install I Cancel I

Knowledge Center Knowledge Center is Ready to Install

11. Click Install. The Genesys Installation Wizard indicates it is performing the requested operation for the
Genesys Knowledge Center CMS. When through, the Installation Complete screen appears.

12. Click Finish to complete your installation.

13. Inspect the directory tree of your system to make sure that the files have been installed in the location
that you intended.

End

Linux Installation Procedure

Start

1. Open a terminal in the CMS installation package, and run the install.sh file. The Genesys installation
starts.

2. Enter the hostname of the host on which you are going to install.

3. Enter the connection information required to log in to the Configuration Server:
a. Hostname—For instance, demosrv.genesyslab.com
b. Listening port—For instance, 2020
c. User name—For instance, demo

d. Password
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4. If you have a backup Configuration Server, enter the Host name and Port.

5. If the connection settings are successful, a list of keys and Knowledge Center CMS applications is
displayed.

6. Enter the key for the Knowledge Center CMS application that you created previously in Configuration
Server.

7. Enter the full path to your installation directory and confirm that it is correct.

8. If the installation is successful, the console displays the following message:
Installation of Genesys Knowledge CMS has completed successfully.

End

Installing multiple CMS instances

To install multiple CMS instances you need to repeat following steps for every instance:

1. Create CMS applications
2. Configuring the Knowledge Center CMS Application
3. Installing Knowledge Center CMS

Note: Knowledge Center Cluster Application is created just ones for all CMS instances working in the
same cluster.

Granting Agents Authoring Privileges

Genesys Knowledge Center supports the following privileges to restrict agent access:
¢ Administrator (allows a user to carry out Administrator tasks such as creating and editing Knowledge
bases)
e Approver (allows a user to Approve and Publish documents)
e Category Author (allows a user to create and update categories)
¢ Document Author (allows a user to create and update documents)

¢ Multitenant user (allows a user to work with data in all tenants in the CMS)

Only agents who have both Document Author and Category Author privileges can
successfully import data from XML files into CMS.
To publish document from CMS to Knowledge Server agent also should have "Allows

Genesys Knowledge Center Deployment Guide 79



Installation and Deployment Installing the Knowledge Center CMS

agent to change data in a knowledge base" privilege on Knowledge Server (link to
Provide Knowledge Center Access to Agents in Server installation page)

To configure the appropriate privileges for an agent:

Start

1. Go to Provisioning > Accounts > Roles.
2. In the taskbar, click New to create a new object.

3. Set the name of the role in the General section.
ol Ganatys Adminisinalor S — B e e e -
i T ] SSSssssTTTTTTT———————SRS——S——————
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Knowledge Center CMS Access Roles
4. Go to the Role Privileges tab and select the set of roles for Genesys Knowledge Center.
5. Open the Genesys Knowledge Center CMS privileges list.

6. Set the appropriate privileges to Allowed.

s g = ==

Setting Knowledge Center CMS Access Privileges

7. Go back to the Configuration tab.

8. In the Members Section, add the appropriate Agent by clicking the Add button.

5 P
ihet ] =1
U Py - gt e b P b Rrpiy ey 10 Dawm
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Knowledge Center CMS Members Section

9. Save and Close.

End
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Start and Stop Genesys Knowledge Center CMS

Start the CMS

Windows:

You can start the Genesys Knowledge Center CMS on Windows from:

¢ Windows Services
e the server.bat script

e Genesys Administrator

Start

¢ You can start the server from Windows Services.

1. Open Windows Services
2. Select and start the Genesys Knowledge Center CMS [Knowledge Center CMS] service.

* You can use the provided server.bat script.
Navigate to the Knowledge Center CMS installation server directory and launch the Windows
command console (cmd.exe).

1.

2. Open server directory
3. Type and execute server.bat, without any parameters.

You can use entry in the Start > All Programs > Genesys Solutions > Knowledge Center CMS [Knowledge
Center CMS] menu to start the Server using server.bat

e You can start the server from Genesys Administrator.
1. Navigate to PROVISIONING > Environment > Applications.
2. Select the Knowledge Center CMS

3. Click Start applications in the Runtime panel.

End

The Genesys Knowledge Center CMS is shown in Started status in Genesys Administrator.
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Linux:

You can start the Genesys Knowledge Center CMS on Windows from:

e the server.sh script

* Genesys Administrator

Start

* You can use the provided server.sh script.
1. Navigate to the Genesys Knowledge Center CMS installation directory in the Unix command console.

2. Go to server directory

3. Type and execute server.sh, without any parameters.

* You can start the server from Genesys Administrator
1. Navigate to PROVISIONING > Environment > Applications.
2. Select the Knowledge Center CMS.

3. Click Start applications in the Runtime panel.

End
The Genesys Knowledge Center CMS is shown in Started status in Genesys Administrator.

After the CMS start
After successful CMS start you can use following URLs in your browser:

e http://<cms host>:<CMS default port>/gks-cms - to access the CMS user interface

Stop the CMS

Windows:

You can stop the Genesys Knowledge Center CMS on Windows from:

¢ Windows Services

e Genesys Administrator
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e A console window

Start

¢ You can stop the server from Windows Services.
1. Open Windows Services
2. Select and stop the Knowledge Center CMS service.
* You can stop the server from Genesys Administrator.
1. Navigate to PROVISIONING > Environment > Applications.
2. Select the Knowledge Center CMS.
3. Click Stop applications in the Runtime panel.

e |If you previously started Genesys Knowledge Center CMS in a console window, you can stop the server
by closing the window or navigate to Genesys Knowledge Center CMS installation directory in Windows
console (cmd.exe), open server directory and execute command: server.bat stop

End
The Genesys Knowledge Center CMS is shown in Stopped status in Genesys Administrator.

Linux:

You can stop the Genesys Knowledge Center CMS on Linux from:

¢ Genesys Administrator

¢ A console window

Start

* You can stop the server from Genesys Administrator.
1. Navigate to PROVISIONING > Environment > Applications.
2. Select the Knowledge Center CMS.
3. Click Stop applications in the Runtime panel.
e Or you can stop the server from the console window where it was started.
1. Press Ctrl+C while the window is active.

2. Type Y and press Enter.
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e Or you could use provided script server.sh:
1. Navigate to the Genesys Knowledge Center CMS installation directory in the Unix command console.
2. Go to server directory

3. Type and execute server.sh with parameter "stop" (for example: server.sh stop)

End
The Genesys Knowledge Center CMS is shown in Stopped status in Genesys Administrator.
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Using CMS with Microsoft SQL Server

Prerequisites

¢ Create new database in Microsoft SQL Server

¢ Create user account to access the database

Configuring CMS

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications
2. Select the application defined for the Knowledge Center Cluster and click Edit
3. From the Options tab in the cms.cluster section, set the following options:

a. set option type to value mssql

if you are using version 8.5.300.xx, please type jdbc instead of mssql

b. set dbConnectionUrl to JDBC connection string for connection to MS SQL Server following the
format:
jdbc:sqlserver://<host of MSSQL Server>:<port of MSSQL Server, 1433 by
default>;databaseName=<CMS DB name>

c. dbUsername - set to the username that needs to be used to login to MS SQL Server
d. dbPassword - set to the password for db account

e. dbDriverClass - set to net.sourceforge.jtds.jdbc.Driver

Description of options in cms.cluster section can be found in Configuration Options.

If you are installing Knowledge Center CMS 8.5.302.xx or earlier, you need to download and place
Microsoft SQL Server JDBC driver on every CMS host:

1. Open in your browser https://sourceforge.net/projects/jtds/files/jtds/1.2.7/
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2. Download jtds-1.2.7-dist.zip (Oracle account is needed)

3. Unpack downloaded archive

4. Place jtds-1.2.7.jar into <CMS _installation_folder>/lib/ext

The driver must be added to the installation folder of every CMS node in your
deployment.

Starting from the 8.5.303.xx release of the product, drivers are embedded into the
CMS's IP.
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Using CMS with Oracle

Oracle 11g supported from version 8.5.302.xx of the product.

Prerequisites

¢ Create new database in Oracle 11g

e Create user account to access the database

Configuring CMS

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications
2. Select the application defined for the Knowledge Center Cluster and click Edit
3. From the Options tab in the cms.cluster section, set the following options:

a. set option type to value oracle

b. set dbConnectionUrl to JDBC connection string for connection to Oracle following the format:
jdbc:oracle:thin:@<host with Oracle>:<port of Oracle, 1521 by default>:<CMS DB SID>
or

jdbc:oracle:thin:@//<host with Oracle>:<port of Oracle, 1521 by default>/<Service
Name>

c. dbUsername - set to the username that needs to be used to login to Oracle
d. dbPassword - set to the password for db account

e. dbDriverClass - set to oracle.jdbc.driver.OracleDriver

Description of options in cms.cluster section can be found in Configuration Options.

If you are installing Knowledge Center CMS 8.5.302.xx, you need to download and place Oracle JDBC
driver on every CMS host:
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Open in your browser http://www.oracle.com/technetwork/apps-tech/jdbc-112010-090769.html
Accept the license

Download ojdbc6.jar (Oracle account is needed)

A W N -

Place ojdbcé6.jar into <CMS_installation_folder>/lib/ext

The driver must be added to the installation folder of every CMS node in your
deployment.

Starting from the 8.5.303.xx release of the product, drivers are embedded into the
CMS's IP.
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Configuring CMS to Work with PostgreSQL

PostgreSQL is supported starting from 8.5.304.xx release of the Genesys Knowledge
CMS Please use the latest stable version of PostgreSQL.

Prerequisites

e Create new database in PostgreSQL

e Create user account to access the database

Configuring CMS

1. Configure database properties in the Genesys Knowledge Center Cluster application.
2. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.
3. Select the application defined for the Knowledge Center Cluster and click Edit.
4. From the Options tab in the cms.cluster section, set the following options:
» for option type set postgre value.

e dbConnectionUrl - to JDBC connection string for connection to PostreSQL Server following the
format:

jdbc:postgresql://<host of PostgreSQL>:<port of PostgreSQL>/<CMS DB name>

* dbUsername - set to the username that needs to be used to login to PostgreSQL.

* dbPassword - set to the password for db account.

Note: Description of options in cms.cluster section can be found in Configuration Options.

Genesys Knowledge Center Deployment Guide 89



Installation and Deployment Installing the Knowledge Center CMS

Configure Resource Access Point for
Knowledge Center CMS Load-Balancer

If you plan to use several instances of Knowledge Center CMS or use it with Universal Constance
Server for Standard Responses you'll need to set up an external Load-Balancer and/or configure a
Resource Access Point (RAP).

Importing the Load-Balancer Resource Access Point Template

Start

1. Open Genesys Administrator and navigate to Provisioning > Environment > Application
Templates.

2. In the Tasks panel, click Upload Template.

Tasks ¥

Create S
@ Upload Termplate

Multi Update -

ar] Matniage Annes

A Manage Permissions

Copy Object -

R Copy Chject From
Cither Location

3. Click Add and choose application template (APD) file to import window, click Add.

4. Browse to the CMS_LB_Resource Access_Point.apd file. Click Open.
The New Application Template panel opens:
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SGenesys Genesys Administrator

Tenant: | Environment R New Window | Log out | & v | @ v

e e ——

PROVISIONING > Envionment > Appication Tempiates > New Application Template

Navigation [« ‘ /i) CMS_LB_Resource_Access_Point - \Application Templates\
. Search [+ | % Cancel | Save & Close |l Save [l Save & New | | Reload | T Import Metadata
L Environment E| e i || optons || permssions || pependences
[ Alarm Conditions
[ Scripts * Name: [CMS_LB. Resource_Access_Poinf
[ Application Templates * Type: Resource Access Point v
[ Applications # Version: 9.0.0
[ Hosts Metadata:
[ Solutions Metadata Description:
[ Time Zones Metadata Version
[ Business Units/Sites State: Enabled
[ Tenants
[ Table Access Points
[ Formats
[ Fields
g Switching [+
|y Routing/eServices I+
| Desktop [+
| Accounts =
L Voice Piatform *
ey Outbound Contact [+)
ety 5/25/201¢

5. Click Save & Close.

End

Creating the Load-Balancer Resource Access Point Application

Prerequisites

* You completed Importing the Load-Balancer Resource Access Point Template.

Start

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.

2. In the Tasks panel, click Create New Application.

Genesys Knowledge Center Deployment Guide

91



Installation and Deployment

Installing the Knowledge Center CMS

Tasks e

Multi Update -

Create -~

@ Create Mew
&pplication

3. In the Select Application Template panel, click Browse for Template and select the

CMS_LB_Resource_Access_Point template that you imported in Importing the Load-Balancer Resource

Access Point Template. Click OK.

Browse

) Instructions: Choose objects from the list below.

Application Templates
v [ New ... [+ New Folder
MName - Type
T | Fitter Filter
View: "] Roof > (] Application Templates
4 CMS_LB_Resource_Access_Point éResource Access Point
b . Configuration_Manager_8& Configuration Manager
¥ Configuration_Server_8 Configuration Server
P Elasticsearch_Resource_Access... Resource Access Point
¥ ES_RAP Resource Access Point
P Genesys_Administrator_8 Genesys Administrator
P Genesys_Administrator_Server_8  Genesys Administrator Server
F  Knowledge_Center_Cluster Application Cluster
F Knowledge Center_Cluster 900 Application Cluster
¥ Knowledge_Center_CMS Genesys Knowledge Center CMS
¥ Knowledge_Center_CMS 900 Genesys Knowledge Center CMS
¥ Knowledge_Center_Server Genesys Knowledge Center Server
b

Knowledge_Center_WDE_Plugin Interaction Workspace

4 4 Pageofl y bl

Version

Filter

9.0.0
85
8.5
9.0.0
9.0.0
8.5
8.5
9.0.0
9.0.0
9.0.0
9.0.0
9.0.0
9.0.0

State

Filter

Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled

Displaying objects 1 - 13 of 13

OK

] [ Cancel

4. The template is added to the Select Application Template panel. Click Next.
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5. In the Select Metadata file panel,
a. click Browse
b. click Add

c. select the CMS_LB_Resource_Access_Point.xml file
d. Click Open

6. The metadata file is added to the Select Metadata file panel. Click Next.

7. In Specify Application parameters:

a. Enter a name for your application. For instance, "Genesys Knowledge CMS Load-Balancer RAP"
b. Make sure that State is enabled

c. Select the Host on which the Access Point will reside
d. Click Create

Create New Application

x
Steps IE @) Instructions: Please enter the Application parameters. Mandatory parameters are denoted with an asterisk.
st eowe L L |
+/ Select Metadata file
» Specify Application parameters * Name: ‘ Genesys Knowledge CMS Load-Balancer RAP ‘
Resuits * Application Prototype: CMS_LB_Resource_Access_Point

State: Enabled

* Host: ‘gkc—cmsZ ‘x Ip‘

* Startup Timeout: ‘90 ‘

* Shutdown Timeout: ‘90 ‘

* Redundancy Type: ‘ Not Specified

[ Cancel ] [ 4 Previous “ Create » ][ Finish I

8. The Results panel opens.

9. Enable Opens the Application details form after clicking 'Finish' and click Finish. The Load-Balancer
Resource Access Point application form opens and you can start configuring its properties.
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e = [ ——

PROVISIONING > Envionment > Appications > Genesys Knowledge CMS Load-Balancer RAP

Navigation <« "] Genesys Knowledge CMS Load-Bal... - \Appiications\

L Search + | % cancel |l save & Close [l save [l Save & New | [F3Reload | ) Start [ Stop [ Graceful Stop

' Environment - Ji(‘,onﬁgumlkm 7” Options || Permissons || Dependences || Warms || rogs
[ Alarm Conditions

General Server Info Network Security

3 scripts ~ * General
[ Application Templates * Name: [Genesys Knowledge CMS Load-Balancer RAP
[ Applications * Applcation Template: | CMS LB Resource Access Point t3%]
[ Hosts * Type; v
[ Solutions Version:
[ Time Zones Server: v
[ Business Units/Sites State: Enabled
[ Tenants Connections: [Cladd 3Edit [FgRemove
[ Table Access Points Server «. Connection Protocol Local Timeout Remote Timeout Trace Mode
[3 Formats No objects to dispay
[ Fields
~ * Server Info
. swiching + | —|= * Network Security

) Routing/eServices +

End

Configuring the Load-Balancer Resource Access Point Application

Prerequisites

* You completed Creating the Load-Balancer Resource Access Point Application.

Start

1. If your Load-Balancer Resource Access Point application form is not open in Genesys Administrator,
navigate to Provisioning > Environment > Applications. Select the application defined for the
Load-Balancer Resource Access Point and click Edit.

2. Expand the Server Info pane.

3. In the Tenant section, click Add and select your tenant. For instance, Environment. Click OK. (Tenant
should be same as for previously created Genesys Application cluster <link to chapter about installing
Cluster>)

4. If your Host is not defined, click the lookup icon to browse to the hostname of your application, which
should point to the host where you plan to locate your external Load-Balancer or CMS server.

5. In the Listening Ports section, create the default port by clicking Add. The Port Info dialog opens.

a. Enter the Port. For instance, 9090 (use value of http port of your external Load-Balancer or CMS
server).

b. Click OK. The default port appears in the list of Listening ports.

Genesys Knowledge Center Deployment Guide 94



Installation and Deployment Installing the Knowledge Center CMS

4 * server Info

Tenants: ladd | E 3% Remove

Name « State

Environment Enabled

Tenant1 Enabled

Tenant2 Enabled
* Host: gke-cms? x P
* Listening Ports: iC|add [JE % Remove

IDa Port

default 9090

6. Ensure the Working Directory and Command Line fields contain "." (period).
Configuration Ciptions Permissions Dependencies Alarms Logs

General  Server Info
*working Directary:

* Cornrmand Line:

Comrmand Line
Arguments:

* Startup Timeout: og
* Shutdown Tirmeout: =Ty}

Backup Server: [Unkniown Backup Server]
* Redundancy Type: Mot Specified

* Timeout: 10

* Attermnpts: 1

Auto Restart: [ True

Log On &s SYSTEM True

* | oo R Account:

7. Click Save.
8. The Confirmation dialog for changing the application's port opens. Click Yes.
9. Select the Options tab.
* Make sure the following options are set in the [resource] section:
* [resourcel/type=1loadbalancer
¢ [resource]/solution=cms

i~ Genesys Knowledge CMS Load-Bal... - \Applications\

¢ Cancel [ Save & Close ] Save |l Save & New | | Reioad start [@stop [BGrac
Configuration Options Permissions Dependences Aarms Logs
i“INew iig¢Dekte > Export T Import View: Advanced View (Options) v
Name « Section Option Value
T | Fiter Filter Filter Filter

& resource (2 Items)

resource/solution resource solution cms

b type resource type loadbalancer

10. Click Save & Close. If the Confirmation dialog opens, click Yes.

End
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Configuring the Knowledge Center Cluster for Use with Load-
Balancer

Prerequisites
* You completed Configuring the Load-Balancer Resource Access Point Application.
Start

1. Navigate to Provisioning > Environment > Applications. Select the application defined for the
Knowledge Center Cluster and click Edit.

2. In the Connections section of the Configuration tab, click Add. The Browse for applications panel
opens. Select a Genesys application defined as a Load-Balancer Resource Access Point, then click OK.

3. Select added connection to application, click Edit and ensure that the default connection port selected
as ID

4. Click Save & Close. If the Confirmation dialog opens, click Yes
i gke-cluster - \Applications\
% cancel g Save & Close gl save [l Save &New | EReload | ) start [ stop [ Gracerul stop

fConﬁgmarmn H Options H Permissions H Dependendies H Aarms H Logs

General ServerInfo Network Security

~ * General

* Name: gke-cluster

* Application Template: Knovdedge Center Cluster L
* Type: "
Version:
Server: v
State: Enabled
Connections: ) Add (g3Edit [fjRemove

Server « Connection Protocol Local Timeout Remote Timeout Trace Mode

Genesys Knowledge CMS Load-Balancer RAP 0 0 [Unknown Trace Mode]

es_rap 0 0 [Unknown Trace Mode]

End
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Installing the Workspace Desktop Edition
Plugin

Installing the Plugin for Workspace Desktop Edition

Agents can use the Knowledge Center Plugin for Workspace Desktop Edition (WDE) to access
knowledge-related information right from their desktop. For example, if a customer asks a question
using a chat widget and the corresponding interaction is routed to an agent, Knowledge Center can
execute a pre-populated search based on data attached to the new interaction, as well as displaying
the customer's search history and providing the agent with full access to the knowledge base access.
And if the customer has not authorized during their search, the agent can link their session history to
that customer's ID to access their full history while working with the interaction. To use this plugin

complete the procedures below, in order.

Installing the Plugin for Workspace Desktop Edition

Prerequisites

Workspace Desktop Edition must be installed and configured to work with voice or media
interactions.

Start

1. In your installation package, locate and double-click the setup.exe file. The Install Shield opens the
welcome screen.
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Genesys Installation Wizard

= Genesys

Welcome to the Installation of Genesys Knowledge

Center Plugin for Workspace Desktop Edition, verzion
(AN I

enesys Knowledoe Center Plugin for wWarkspace Deskiop Edition

provides agents with access to knowledge events [searches, article
wigws and feedback) related o the current customer and also

allows them to zearch the knowledos baze nght from their deskhop.
The Geneszys Inztallation \Wizard will guide wou through the Genesps

K.novdedoe Center Plugin for Workspace Deskiop Edition
installation of maintenance, depending on your system statis,

To continue, click Mest. To ext the Wizard, click Cancal,

[ New> | Cancel |

Knowledge Center WDE Plugin—Install Shield Screen

2. Click Next. The Select Installed Application screen appears.

3. Select the installed Workspace Desktop Edition Application for which you want to install the plugin. The

Application Properties area shows the Type, Host, Working Directory, Command Line

executable, and Command Line Arguments information previously entered in the Server Info and
Start Info tabs of the selected Application object.
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Genesys Installation Wizard Ei

Select Installed Application

Select Workspace Desktop Edition IP from the izt of application installed on target computer.
Genesyz Instalation wWizard will instal Genesyz Knowledoe Center Plugin for'Workspace Deskiop
E dition components n the selected 'Workspace Deskiop Edition's location

I |, o e e -_|r_'_| {n ] LIJIIII.'

Apphcation Properties:

|rstallation Packaoge Mame Workspace Desktop Edition
"erzion: 8.5.103.07, Build 1
Install Locaton: C:\Program Files\GCTINwWork space Desktop Edition

<

Select Installed Workspace Desktop Edition Application

4. Click Next. The Ready to Install screen appears.

Genesys Installation Wizard

Ready to Install

Fenesys Installation Wizard has collected all required infiormation and iz ready o install Genesys
¥.nowledge Center Plugin for “Workzpace Deskbop Edibon on pour computer.

To nstall Genesy: Knowledge Center Plugin for Workspace Desktop Edition. click Install
To review sethings, chick Back, To exit the Wizard, click Cancel

< Back I Install I Cancel
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Knowledge Center WDE Plugin—Ready to Install

5. Click Install. The Genesys Installation Wizard indicates it is performing the requested operation for
Backend Server. When through, the Installation Complete screen appears.

Genesys Installation Wizard

Installation Complete

The Genesys Installation Wizard has successfully installed Genesys
Krowledge Certer Plugin for Work space Desklop Edition, version
8530017, an vour conmpuber.

Qg‘ GEI’\ESYS' To esit the Wizard, click Finish

Finish

Knowledge Center WDE Plugin—Installation Complete
6. Click Finish to complete your installation.

7. Inspect the directory tree of your system to make sure that the following files have been installed in the
location that you intended:

GWElInstallationFolder\Genesyslab.Desktop.Modules.Knowledge.dll

GWEInstallationFolder\Genesyslab.Desktop.Modules.Knowledge.module-config

GWEInstallationFolder\Genesyslab.Desktop.Modules.Knowledge.pdb
GWEInstallationFolder\Newtonsoft./Json.dll
GWEInstallationFolder\RestSharp.dll

GWElInstallationFolder\System.Net.Http.Formatting.dll

GWEInstallationFolder\Language\Genesyslab.Desktop.Modules.Knowledge.en-US.xml

End
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Configuring the WDE Application to work with the WDE Plugin

To run the WDE plugin correctly, the local storage must be enabled in Internet
Explorer on the host with the WDE client application. To verify this, open Settings >
Internet Options then click the Advanced tab > Security. Confirm that “Enable

DOM-Storage” is checked. If it is not, click the check box and then save your updated
settings.

Add the Knowledge Center Cluster to Your WDE Connections

1. If your Workspace Desktop Edition application form is not open in Genesys Administrator, navigate to
Provisioning > Environment > Applications. Select the application defined for the Workspace
Desktop Edition and click Edit....

2.

In the Connections section of the Configuration tab, click Add. The Browse for applications panel
opens. Select the Knowledge Center Cluster application, then click OK.

- —

Knowledge Center WDE Plugin—Browse for applications 1

]

Knowledge Center WDE Plugin—Browse for applications 2

Add Knowledge Center Options to Your WDE Application

To use the Knowledge Center Plugin for WDE, you need to add some options to your WDE application
so that it can gather knowledge-related information from incoming interactions. You can add these
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options to the the interaction-workspace section of the WDE application.

Start

1. Import the template with the additional options:

1. Open Genesys Administrator and navigate to Provisioning > Environment > Application

Templates.
2. In the Tasks panel, click Upload Template.
3. In the Click 'Add' and choose application template (APD) file to import window, click Add.
4. Choose the application template (APD) file from the import window and click Add.
5. Browse to the Knowledge_Center WDE _Plugin.apd file available in the templates directory of your
installation CD. The New Application Template panel opens.
o Gy Iteririnioats —_—— = F

Knowledge Center WDE Plugin—New Application Template panel
6. Click Save and Close

2. Open the Options tab of the uploaded application and review the new options.

Knowledge Center WDE Plugin—Options tab of uploaded application

3. Navigate to Provisioning > Environment > Applications. Select the application defined for
Workspace Desktop Edition and click Edit....
4. Open the Options tab.

5. Add the plugin options to the interaction-workspace section using the New button.
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New Option *
Location: |QOptions w
Section: | interaction-workspace

MName: ghc.customer

EmailAddrass |

Walue:

| ok || cancel |

Knowledge Center WDE Plugin—Add plugin options

End

The Knowledge Center Plugin for WDE uses the following additional options:

Section

interaction-
workspace

interaction-
workspace

interaction-
workspace

interaction-

workspace

interaction-
workspace

Option

gkc.question

gkc.kbid

gkc.customer

gkc.session

gkc.language

Default value

gks_question

gks_kbid

EmailAddress

gks_session

gks_lang,
Language

Allowed
values

any valid user
data key

any valid user
data key

any valid user
data key

any valid user
data key

comma-
separated list
of valid user

Description

Interaction
user data key
that contains
search query
that will be
pre-populated
in Desktop

Interaction
user data key
containing the
knowledge
base Id to
search
knowledge in

Interaction
user data key
that contains
customer
identification
(for example
email address
of the
customer)

User data key
that contains
knowledge
session Id
associated with
the interaction

Interaction
user data key
that contains

Takes effect

Next agent
session

Next agent
session

Next agent
session

Next agent

session

Next agent
session
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Section

interaction-
workspace

interaction-
workspace

interaction-
workspace

interaction-
workspace

Option

gkc.country

gkc.spellcheck

gkc.send-
document

gkc.extended-
filters-view

Default value

Country

false

false

false

Allowed
values

data keys

any valid user
data key

true

false

true

false

true

false

Description

language of
interaction

This option can
contain a comma-
separated ordered
list of keys. for
example "gks_lang,
Language"; in the
case of several
keys in the
attached data, the
first key in the list
is used

Interaction
user data key
that contains a
region of
interaction
(used for multi-
regional
languages, for
example
en_US, en_UK)

Enables or
disables spell
check
correction of
the searched

query

Allows agents
to push a link
to the
document into
the chat
session
transcript by
clicking the
Send
Document
button

Allows you to
display type
labels for
custom
attributes in an
applied filter

Introduced in:
9.0.001.04

Takes effect

Next agent
session

Next agent
session

Next agent
session

Next agent
session
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Providing Knowledge Center Access to Agents

Genesys Knowledge Center supports the following privilege in order to restrict Agent access:

* Knowledge.WORKER — Enables access to the Genesys Knowledge Center tab in WDE
* Knowledge.AUTHOR — Enables ability to suggest new knowledge to knowledge bases.

To configure the appropriate role for an agent:

Start
1. Go to Provisioning > Environment > Application Templates.
2. Select the application template defined for Workspace Desktop Edition and click Edit....
3. Click Import Metadata.
4. Click Add and select the Knowledge_Center_WDE_Plugin.xml file.
5. Click Open.
6. Information from the metadata file will be added to the template and the appropriate privilege will be

added into the framework.

N

Save and Close.
8. Go to Provisioning > Accounts > Roles.
9. In the taskbar click New to create a new object.

10. Set the name of the role in the General section.

Knowledge Center WDE Plugin—Set Role Names

11. Go to the Role Privileges tab, and select the set of roles for Genesys Knowledge Center.

12. Open the WDE Knowledge Center Plugin privileges list and select the Genesys Knowledge Center
Privileges section.

13. Create the appropriate privileges as allowed.

Knowledge Center WDE Plugin—Create Privileges

14. Go back to the Configuration tab.
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15. Add the appropriate Agent to the Members section by clicking the Add button.

& P
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Knowledge Center WDE Plugin—Members Section
16. Save and Close.

End
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Post Installation and Deployment

This chapter provides you with information on what to do after you've deployed the Knowledge
Center within your environment. It covers following topics:

* Access Permissions

¢ Configuration Options

* Load-Balancing Configuration

¢ Security

¢ Geo Location

 UTF8

» Supported Languages

e Translation Service
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Access Permissions

Overview

Before starting up with Knowledge Center you need to:

* Define access rules for every knowledge base you have created
e Set up permissions for your knowledge team

e Set up access to knowledge for your agents
Knowledge Center leverages privileges and skills to define desired access level:

e Privileges used to grant access to functional capabilities such as authoring ability, approval rights,
ability to work with knowledge in Workspace or ability to suggest content. Privileges assigned to roles
that you can assign to your personnel.

e Skills allow you define knowledge areas that an agent or author can access. Skills are highly dynamic
and allow you to provide additional knowledge while you assign areas of responsibilities to your agents.

Let's review these tasks a bit closer in the following sections.

Access permissions

Restricting access to Knowledge

To restrict access to the knowledge you need to define these restrictions for a knowledge base. All
documents within knowledge base will follow the defined restrictions.

A knowledge base can be restricted-
for viewing:
e Public (Anyone) - its content is accessible to all agents and customers

¢ Private (Agent Only) - its content is accessible to agents only

e Private with skill restriction (Skilled agent) - content of the knowledge base is accessible to an agent
with specific skills

for authoring:

e Any Author - any agent that is granted author privilege can create/update knowledge documents

¢ Authors with skill restriction - only agents that are granted author privilege and have one of the
selected skills can create/update knowledge documents
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Skill-based access allows you dynamically manage access to the knowledge along with managing the
distribution of the customer's interactions. That ensures that there are no additional actions required
when you assign an agent to a new area.

For example, say you have a knowledge base with restricted access for agents who have the skill
"technical support”, and the same skill is used for routing interactions to your group of agents.
Adding the agent to the group by assigning him the "technical support" skill will automatically give
him access to the proper knowledge bases.

Setting up Knowledge Team

The next task is to grant access to the CMS and knowledge bases to the members of your authoring
team. CMS allows the following privileges to be granted:

e Administrator - allowed to manage knowledge bases (create new, modify and delete)

e Author: Categories - gives content author ability to create new categories, and modify and delete
existing ones

e Author: Documents - gives content author ability to create new documents, and modify and delete
existing ones

* Approver - designated for content managers who validate and approve created documents and
categories

At least one of the above privileges are required to be able to work with CMS.
Also, content authors and managers need to be assigned proper skills to get access to the private

knowledge bases with skill restrictions. Note: Administrators have access to any knowledge base, no
matter the skill restrictions applied.

Granting access to agents

Agents follow the same concept. They require privileges to get access to functionality and skills for
getting access to private knowledge bases with skill restrictions.

An agent can be assigned following privileges:

¢ Knowledge Worker - allows access to Knowledge Center functionality in the Workspace

e Knowledge Author - allows agent to suggest knowledge content from the Workspace

Also, agents need to be assigned proper skills to get access to the private knowledge bases with skill
restrictions.

Configuration Procedures

Knowledge Center Privileges

Knowledge Center supports following privileges
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Privilege Product

Knowledge Center

Knowledge.AUTHOR T

Knowledge Center

Knowledge.MULTITENANT Server

Knowledge Center

KnowIedge.CanAccessPubIigerver

Knowledge.CMS.Document idudivdedge Center CMS

Knowledge.CMS.Category.Akibloarledge Center CMS

Knowledge.CMS.Approver Knowledge Center CMS

Knowledge.CMS.Administraksowledge Center CMS

Knowledge.CMS.MultitenanKnowledge Center CMS

Workspace Desktop

Knowledge.Worker Edition

Workspace Desktop

Knowledge.Author Edition

Description

Allows changing data in
a knowledge base. This
privilege is required for
agents that are running
data synchronization
from Genesys
Knowledge Center CMS
or third-party sources.

Allows to bypass
tenants restrictions
while importing data
into knowledge bases.

Required only for the
multi-tenant
deployments. Will not
affect other privileges or
access rights except
authoring.

Allows agents to access
public knowledge bases.
Used if the Cluster
option privilege.can-
access-public in section
search is set to false

Gives content author
ability to create new
documents, and modify
and delete existing ones

Gives content author
ability to create new
categories, and modify
and delete existing ones

Designated for content
managers who validate
and approve created
documents and
categories

Allowed to manage
knowledge bases
(create new, modify and
delete)

Allows bypassing tenant
restrictions while
working through API

Enable the Knowledge
Center Plugin for the
agent

Allows agent to propose
new knowledge
documents from

Since

9.0.0

9.0.0

9.0.0

9.0.0

9.0.0

9.0.0

9.0.0

9.0.0

9.0.0

9.0.0
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Privilege

Privileges for typical Roles

Product

Workspace

Description

Since

The table below shows examples of typical roles and privileges required for them:

Role

CMS Administrator

Knowledge Manager

Knowledge Author

Agent

Assigning a Privilege

Description

Manages Knowledge Bases
Sets up publishing schedules

Doing maintenance
procedures with knowledge

Approves content produced
by authors

Publish knowledge documents
to be used by agents and
customer

Creates knowledge
documents

Creates knowledge categories

Reviews usage feedback and
update knowledge content

Handles customers'
interactions

Access to public Knowledge
bases for this agent is
allowed (while disabled in
general)

To configure the appropriate privileges for an Agent:

Start

1. Go to Provisioning > Accounts > Roles.

2. In the taskbar, click New to create a new object.

3. Set the name of the role in the General section.

Privileges

Knowledge.CMS.Administrator
(CMS)

Knowledge.AUTHOR (Server)

Knowledge.CMS.Approver
(CMS)

Knowledge.AUTHOR (Server)

Knowledge.CMS.Document.Author
(CMS)

Knowledge.CMS.Category.Author
(CMS)

Knowledge.Worker (WDE)
Knowledge.Author (WDE)

Knowledge.CanAccessPublic
(Server)
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9.

. Open the list of privileges for Knowledge Center Server.

. Set the appropriate privileges to Allowed.

T —— m—

. Go back to the Configuration tab.
. In the Members section, add the appropriate agent by clicking the Add button.

]
i

= e —

Save and Close.

End

Assignining Skills

To configure the appropriate skills for an Agent:

Start

v ok N

Go to Provisioning > Accounts > Users.
Select Agent from the table

Click Edit... button

Expand Agent Info panel

CI_tiqk Add... in the Skills Level section

it -
—— —
- —

- -

- -

-—— — —_

. In the Skills Level dialog:

. Go to the Role Privileges tab and select the set of roles for Genesys Knowledge Center.
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(o= [ ome ]

e select the skill
e enter the skill level

* click OK

7. Save and Close.

End
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Configure Reporting

Reporting functionality is available starting from version 9.0.001.xx

Knowledge Center Server packages contain the following reporting modules:
¢ Kibana-based discovery dashboards: allows you to discover different insights of your knowledge data
usage
* Predefined Templates and Datasource for native Pulse widgets

This chapter describes how to enable and configure this functionality within your Knowledge Center
deployment.

Prerequisites

For Pulse widgets, it is required you use Pulse 8.5.108.02 or higher.

For Kibana dashboards, it is required to use ElasticSearch 6.2.3 version, 6.2.x is supported but not
recommended.

Restrictions

Note the following restrictions related to the reporting functionality:
¢ The basic authentication feature of the Knowledge Center Server must be disabled to allow Pulse to use
Knowledge Center data source for widgets (only for versions of 9.0.001.xx family).

e You cannot run two or more nodes of Knowledge Center Server on the same host with reporting
functionality enabled (only for versions of 9.0.001.xx family).

e HTTPs for Kibana supported if security proxy enabled (from version 9.0.003.06), or via secured Load-
Balancer on top of Genesys Knowledge Cluster (from version 9.0.004.x).

¢ Taking into account that Pulse is single tenant and does not support Cloud configuration, in multi-tenant
environments, each tenant must have its own dedicated Pulse for reporting.

e |If you are deploying several Knowledge Center Clusters within one environment, each independent
Knowledge Center cluster must have its own dedicated Pulse for reporting.

* In case of standalone Pulse, the base URL should be set as "/gax". For example, set "root_url=/gax" in
.Jconf/pulse.properties for Pulse installation (only for versions of 9.0.001.xx and 9.0.002.xx family).
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Configuration

By enabling the reporting functionality you have to enable the Kibana process that is started and
controlled by the Knowledge Center Server on each server Knowledge Center Server runs (Kibana
exposes discovery dashboards for Knowledge Center).

To enable reporting functionality in Genesys Knowledge Center you must follow the steps described
below:

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications

2. Select the application defined for the Knowledge Center Cluster and click Edit

3.

4.

From the Options tab in the kibana section, set the following option:

* option enabled to value true

Mew Option x
Location:  Options -
Section:  kibana
Name:  enabled >
Value:  true J

Click Save

By default, Kibana is enabled and Knowledge Center Server uses port 5601 to expose the Kibana
application. As of version 9.0.002.09 you can configure a custom port for Kibana on the Knowledge
Server node:

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.

2. Select the application defined for the Knowledge Center Server node application and click Edit.
3.
4

. In the Listening Ports section, select the port with the name "kibana" and click Edit. The Port Info

Expand the Server Info pane.

dialog opens.

Change the Port value and click OK.

| Pawt Tnls
§ Genersl  ddesnced Rarbeenrt Sacunty

| “PFou O
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|| SeertLstenrg Mofe:  Ursscesd w
§ | Dewrpton;

. Save your changes.
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As of version 9.0.004.x, to correctly import Kibana URLs into Pulse during Tenant Provisioning, you
should create a port with the name "kibana" in the Genesys Knowledge Center Cluster application:

5.

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.
2. Select the application defined for the Knowledge Center Cluster application and click Edit.

3.
4

Expand the Server Info pane.

. In the Listening Ports section, create a port with name "Kibana" by clicking Add. The Port Info dialog

opens.
a. Enter the port number for the load-balancer configured for Kibana; for instance, 6051.

b. If you are using a secure connection to Kibana Load-balancer, choose Secured under Select
Listening Mode.

c. Click OK. The HTTP or HTTPS port with the "Kibana" identifier appears in the list of Listening ports.

Fort Inbe:
||| comemal | Ademced | tetmork Secrty
|
| " o S5
| Coneecton Pratocnt L
HA sy Trat

Salact Ltesing Mada: Lavused b
Daicripton:

Lo [ emn ]

Save your changes.

e The new configuration is applied to newly started nodes or restarted nodes.

e To ensure proper load balancing of requests between Kibana nodes embedded into
Knowledge Center Servers you must configure the load balancer to distribute new
sessions evenly between started nodes.

¢ Kibana load balancer must run on the same host as Knowledge Center Server load
balancer.

e If Kibana Security proxy is configured, you cannot configure the "Kibana" port in the
Knowledge Cluster Application. In this case, the "default" port will be used to access
Kibana.
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Kibana security

Available as of version 9.0.003.06.

By default you can access the Reporting Dashboard in Kibana using the "kibana" port and host
configured in the Knowledge Server Application. This behavior does expose the ability to modify and
delete data via the DevTools console or Kibana API. To restrict the processing of any data modification
requests, you need to enable the Kibana security proxy.

To enable restricted access to Kibana with proxy to protect the data from modification, follow these
steps:

1. Open Genesys Administrator and navigate to Provisioning > Environment > Applications.

2. Select the application defined for the Knowledge Center Cluster and click Edit.

3. From the Options tab in the kibana section, set the following options:

Edit Option >
“ Option Mame:
abC  [zwem ]
Option Value:
Jgks-server/kibana |
Cancel

4. Click Save.

After configuring the proxy you must restart all instances of Knowledge Center Server before doing any
further activities against reporting.

If you want to close the access with proxy to Kibana which was already configured and provisioned,
you must:
1. Call tenant provisioning API.

2. Remove all GK* widgets from Pulse (If they were already previously created) and create them again
using updated GK* templates.
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If the Kibana security proxy is configured and a connection to the node configured as
"'secured" then access to Kibana will also be via secured connection via the "default"
Server port.

Configuring external Kibana

Configuring Kibana has been possible as of version 9.0.006.08.

By default reporting is provided using the embedded Kibana version 6.2.3. You can install an external
Kibana instance (https://www.elastic.co/kibana) and configure the Knowledge Server to show which
dashboard is not embedded.

To enable reporting in external Kibana, follow these steps:

1. Install and configure external Kibana (https://www.elastic.co/start).

2. Open the Kibana configuration file (that is, kibana.yml), and add or change the following option:
server.basePath: "/gks-server/kibana"

3. Configure Kibana to use the same Elasticsearch used by the Genesys Knowledge Center.

You should use the same Kibana version that is used for your Elasticsearch instances.

Access the Option of Knowledge Center Cluster application and set the following options in the
Kibana section:
* base_path = /gks-server/kibana.

¢ host = set the external Kibana's hostname or IP address (for example - kibana.demo.com or
192.168.10.10).

¢ port = set the external Kibana's port (for example - 5601).
After you apply this configuration, run the Knowledge Server Cluster and the external Kibana.

Click the following link to access the Kibana: <GKC Server host or access>:<GKC server port>/gks-
server/kibana/app/kibana.

Genesys Knowledge Center Deployment Guide 118



Post Installation and Deployment Configure Reporting

* Access to the external Kibana will only be available via a secured proxy within the GKC
Server. The secured proxy will redirect Kibana calls to a real external Kibana instance.

e If you use external Kibana - no need to configure Kibana port in GKC Server nodes
applications or in GKC Cluster application. For external Kibana this port could be
removed from configuration.

Pulse templates auto-provisioning

Pulse templates auto-provisioning available only for versions of 9.0.001.xx family.

To configure Pulse templates auto-provisioning you must specify the pulse URL and credentials used
during provisioning. From the host Knowledge Center Server installed:

1. Locate the <installation_folder>/server folder:
Windows:

* Open the launcher.ini configuration file
e Locate the following lines:

-Dreporting.pulse.url=http://host:port
-Dreporting.pulse.user=default
-Dreporting.pulse.password=password
Linux:
* Open setenv.sh file
* Locate line starting from CUSTOM_JAVA_OPTS and containing:

-Dreporting.pulse.url=http://host:port -Dreporting.pulse.user=default
-Dreporting.pulse.password=password

Change host:port to the actual host port of Pulse or its load balancer
Change default to the user name you wish to use during provisioning
Change the password to the password for this user account

Save changes

o U s~ W N

Restart Knowledge Center Node (Pulse should be running)
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Troubleshooting
"No default index pattern" message
If you see "No default index pattern" message in Kibana you need to execute following steps:

1. Stop Knowledge Center Server
2. Delete the .kibana index in Elasticsearch by executing following command:
curl --request DELETE --url http://<ES Host>:<ES Port>/.kibana

3. Start Knowledge Center Server

When the Knowledge Center Server re-initializes after start, the Kibana definitions help to resolve the
problem.

"Error: EPERM: operation not permitted, open '.babelcache.json'"" message

If you see message "Error: EPERM: operation not permitted, open '.babelcache.json' in logs of the
Knowledge Center Server you must execute following steps:

1. Navigate to the <installation_folder>/server/kibana/optimize folder (the one the error message
refers to)

2. Using administrative permissions, delete file .babelcache.json

3. Start Knowledge Center Server

Tenant Provisioning

To make reporting more controllable and stable, auto-provisioning was removed in
version 9.0.002.09. Now, if you need the reporting feature, you can enable and
configure it using API.

Tenant Provisioning includes generation and importing visualization metadata into Pulse and Kibana.
You can skip them with next application option under reporting section.

Section Option Value Description

Enable or disable Kibana
reporting kibana.provision true or false metadata provision. By
default, is is set to true.

Enable or disable widget
reporting pulse.provision true or false templates import into
Pulse. By default it is set
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Section Option Value Description
to true.

To perform a tenant provision, you need to execute a Reporting Provision API request:

For v.9.0.002.09

request POST

--url http://<Knowledge Cluster Host>:<Knowledge Cluster Port>/gks-server/reporting/vl/

provision

--header 'content-type: application/json'

--header 'ContactCenterID: <Id of working Tenant>'

--data

{
"pulseUrl" : "http://<Pulse Host>:<Pulse Port>",
"pulseUser": "<Pulse User>",
"pulsePassword": "<Pulse User Password>",
"kibanaTenantName": "<Custom name for working tenant>"

} 1

For versions v.9.0.003 and higher

PulseUrl should be used in the format http://<Pulse Host>:<Pulse Port>/<Pulse base URL> this
is because when using Pulse in GAX you use the URL format http://<Pulse Host>:<Pulse
Port>/gax. Standalone Pulse however, by default, is configured in the URL as http://<Pulse
Host>:<Pulse Port>/pulse.

Provisioning request for v.9.0.003 and higher should look like:

request POST
--url http://<Knowledge Cluster Host>:<Knowledge Cluster Port>/gks-server/reporting/vl/
provision
--header 'content-type: application/json'
--header 'ContactCenterID: <Id of working Tenant>'
--data
{
"pulseUrl" : "http://<Pulse Host>:<Pulse Port>/<Pulse base URL>",
"pulseUser": "<Pulse User>",
"pulsePassword": "<Pulse User Password>",
"kibanaTenantName": "<Custom name for working tenant>"

}I
When the provision is done correctly, you can expect the following response:

{ "status": {

"code": 200,
"message": "Ok" },
"data": {
"provisionLog": {
"log": [

"Kibana Provision - DONE",
"Pulse Provision - DONE"]

PR}
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Example (v9.0.002.09)

curl --request POST \
--url http://localhost:9010/gks-server/reporting/vl/provision \
--header 'content-type: application/json' \
--header 'ContactCenterID: a906b47e-e641-4216-96e5-05c827725ecd" \
--data '{

"pulseUrl" : "http://demosrv:8081",

"pulseUser": "default",

"pulsePassword": "password",

"kibanaTenantName": "Genesys Tenant"

} 1

Example (v9.0.003 and higher)

curl --request POST
--url http://localhost:9010/gks-server/reporting/vl/provision
--header 'content-type: application/json'
--header 'ContactCenterID: a906b47e-e641-4216-96e5-05c827725ecd"’
--data '{

"pulseUrl" : "http://demosrv:8081/pulse",

"pulseUser": "default",

"pulsePassword": "password",

"kibanaTenantName": "Genesys Tenant"

Adding Knowledge Widgets in Pulse

To see data on minimized widgets, Pull Collector must be configured and running for
Pulse.

1. There are two ways you can add a report to your dashboard or wallboard:
 Click the more icon (}) in the right corner and click Add a Widget.
* On empty dashboards and wallboards, click the Add a Widget icon.

Genesys Pulse opens a report builder to guide you.
add a widget
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To quickly locate Knowledge Center widgets in the search bar of the "Add a Widget" window, type "GK" and it will filter Knowledge
Center widgets:

e |f widgets are not shown, it means that they have not yet been provisioned

¢ In versions of 9.0.001.xx family Knowledge Center provisions widget templates
automatically as soon as:

» kibana/enabled options are set to true
* reporting.pulse.* variables are properly set

* Knowledge Center Server node with proper settings is re-started

* Please investigate log files for errors if you do not see provisioned Pulse templates
after these steps are completed

2. Select one of the widgets:

* GK - Analytics: Overview (Last 24h) - provides summary statistics on knowledge usage events
(such as search requests, feedback, 5-star rating, comments, and other) over last 24 hours.

Expanded view for this widget displays the Kibana dashboard allowing you to discover details of
knowledge events.

* GK - Knowledge Objects Summary - provides you a summary of indexed knowledge (number of
knowledge bases, documents, categories, and others), Expanded view for this widget displays the
Kibana dashboard allowing you to explore indexed knowledge documents.

* GK - Performance: Processing Time (Last 24h) - provides you request processing performance
metrics allowing you to monitor solution performance. Expanded view for this widget displays the
Kibana dashboard with detailed performance information.

3. Click the Create Widget button
4. Select the Objects and Statistics that you want to use in your report
5. Click the Display Options tab to define how you want to display your report, such as:
* Widget Title
* Widget Type
* Size
* Headline Type & Object
6. Click Create Widget and the newly added widget will appear on the dashboard:
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Reporting REST AP

Available since v9.0.002.09

Overview

This page describes Genesys Knowledge Reporting REST API.

Reporting Provisioning
Provides provision functionality for Pulse and Kibana metadata.

1. Check Kibana index. Create and configure it with appropriate mapping if it does not exist.
2. Kibana provisioning:

1. Generates dashboards and visualisations metadata files

2. Patch metadata with requested Tenantld/ContactCenterlID

3. Import metadata into ElasticSearch Kibana index
3. Pulse provisioning:

1. Generates Pulse templates

2. Import Pulse generated templates into Pulse

You can skip Kibana and Pulse provisioning with following application options under the reporting
section:

Section Option Value Description

Enable or disable Kibana
reporting kibana.provision true or false metadata provision. By
default, is is set to true.

Enable or disable widget
templates import into
Pulse. By default it is set
to true.

reporting pulse.provision true or false
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HTTP Description
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Request
Method

URI
Content-type

POST

/reporting/v1/provision

application/json

JSON Object with next fields

Field Value Mandatory Description Example
URL
yes n n
http://<pulse URL to Pulse  "http://demosrv:8040
host="">:<pulse in the case of server, for
p%f‘ﬁ;&; BOgr EU|S€- o where v.9.0.002.09
n n VAT EUS a rovisioning
pulseUrl http://<pulse being enabled, generated 9[‘
host="">:<pulse see Reporting dashboards http://demosrv:8040/
port="">/<Pulse Provisioning will be pulse" for
base URL>for  section. imported. v.9.0.003.xx
v.9.0.003.xx
es
y Pulse user
in the case of username.
Body Pulse Required to
"pulseUser"  String AR have "default"
being enabled, .
see Reporting ~ Permissions
Provisioning to write data
section. to Pulse.
yes
in the case of
Pulse pul
" ; Provisioning ulse user " "
pulsePasswordString being enabled, password password
see Reporting
Provisioning
section.
"kibanaTenantNatriay no Custom "Example
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Headers

Response
Content-type

HTTP codes

Field Value

Name

ContactCenterID UUID

application/json

200 - OK

Provision was success.
Response Body Example
{

"status": {
"code": 200,

Value

Mandatory Description Example
name for
Description
section of
Dashboards
and
Visualizations. -II\—IeanragE
If not
specified,
ContactCenterID
value is
taken.
Mandatory Description
If specified,
contains
Contact Center
ID.
no

If not specified,
works like "on-
prem"
installation.
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"message": "Ok"
}I
"data": {
"provisionLog": {
"log": [
"Kibana Provision - DONE",
"Pulse Provision - DONE"
1
}
}

}

400 - Required request body field is missing
In the case if required parameter is missed
Response Body Example
"status": {
"code": 651,
"message": "Field [pulseUser] is required. String type. For
example [default]"
}
b
500 - General server error

Provision was failed on any step described steps aboe. Response
body includes related error message.

Response Body Example

"status": {
"code": 500,
"message": "Unable to import Pulse templates on the

initialization phase :Failed to connect http://demosrv:8081"

}
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Configuration Options

For information on 9.0+ Knowledge Center Configuration Options, please see the links below.

Knowledge Center Server and Knowledge Center CMS have the same options as
Knowledge Center Cluster.

* Knowledge Center Cluster Configuration Options

¢ Logging Configuration Options
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Knowledge Center Cluster Configuration
Options

Section:

cross-origin
cms.cluster
cms.general
translation
general
index
reporting
search
configuration
security
kibana

agent-can-see
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Option Name
Section: cross-origin

CORS Filter Configuration allowedOrigins

Section: cms.cluster

Configuration of the Knowledge Center CMS Cluster.

Database connection URL dbConnectionUrl

Description Value

A comma separated list of origins
(for example, instrumented web
sites) allowed to access the
Knowledge Center. If an allowed
origin contains one or more "*" Value Type:string
characters (for example
http://*.domain.com) then "*"
characters are converted to ".*".
Characters "." are converted to "\.".
Thus obtained allowed origin can be
interpreted as a regular expression.

Default value: "*"

Changes Take Effect: At start/
restart

Database connection string for the
selected persistent storage.
Examples:

for Microsoft SQL:
jdbc:sqlserver://[host of MS
SQL server]:[port of MS SQL
server; 1433 by

default];databaseName=[CMS DB Default value: <empty>

name]

for Oracle: Value Type:string
jdbc:oracle:thin: [userName]/[password]@[host

of Oracle DB]:[port of Oracle Changes Take Effect: At start/restart

DB; 1521 by default]:[SID. for
example ORCL] or
jdbc:oracle:thin:@//[host of
Oracle DB]:[port of Oracle DB;
1521 by default]/[Service Name]
for PostgreSQL:
jdbc:postgresql://[host of
PostreSQL server]:[port of
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Option

Database user password

Database user name

Storage type

Section: cms.general

Name

dbPassword

dbUsername

type

Description

PostreSQL server; 5432 by
default]/[CMS DB name]

Password for user for access JDBC
database.

Name of user for access JDBC
database.

Type of persistent storage provider
used for Knowledge Center CMS
repository.

Value

Default value: <empty>
Value Type:string

Changes Take Effect: At start/restart

Default value: <empty>
Value Type:string

Changes Take Effect: At start/restart

Default value: mssql
Value Type:enumerated type

Valid values:
[+] mssql

Microsoft SQL Server

[+] oracle

Oracle

[+] postgre

PostgreSQL

Changes Take Effect: At start/
restart

Genesys Knowledge Center Deployment Guide

134



Post Installation and Deployment

Configuration Options

Option

Connection to CMS load balancer

Approval flow default value

Named entities synchronization
delay

Section: translation

APl key

Translation service

Name

externalURL

approvalFlow.default

ne.synchro.delay

key

type

Description

Public URL that is used to access the
CMS directly or via load balancer
(like http://<cms host>:<CMS
default port>/gks-cms). This URL will
be used to build the link on the
attachments in knowledge
documents.

(Introduced in 9.0.003)

Default value for approval flow in knowledge
bases.

(Introduced in 9.0.004.xx)

Delay for named entities synchronization from
CMS to GKS in minutes.

Translation service API key. Key is
provided by translation provider and
required as part of request
authentication to API.

Defines translation service provider
used by Knowledge Center CMS.

Value

Default value: <empty>
Value Type:string

Changes Take Effect: Immediately

Default value: standard

Value Type: enumerated type
Valid Values: standard, simple

Changes Take Effect: at start/
restart

Default value: 30
Value Type: integer

Valid values: any positive integer
Changes Take Effect: At start/restart

Default value: <empty>
Value Type:string

Changes Take Effect: Immediately

Default value: none
Value Type:enumerated type

Valid values:
[+] none

None

[+] google
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Option Name

Section: general

Time to live for session sessionTtl

Folder name for knowledge bases knowledgebaseFolder

Section: index

Number of replicas in historical index historyNumberOfReplicas

Description

Specifies the length of time that the
server will store session information
while no activities are carried out.

Name for folder in \"Script\" in Tenant
in Configuration for storing
Knowledge Base definitions for
particular Knowledge Center Cluster.

Number of copies of historical index.
Copies of index help to improve read

Value

Google Could Translation API

[+] microsoft

Microsoft Translator Text API

[+] yandex

Yandex.Translate

Changes Take Effect: At start/
restart

Default value: 8h

Value Type:regular expression
[~[0-9]*(ms|m|h|d|w)]

Valid values: number + unit, for example, 1d
or 3m. Supported units: d (days), m (minutes),
h (hours), or w(weeks)

Changes Take Effect: Immediately

Default value: knowledge

Value Type:regular expression [~ [a-zA-
Z0-9_1*$]

Valid values: Any non-empty alpha-numeric
string

Changes Take Effect: After restart

Default value: 1
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Option

Number of shards in historical index

Index namespace

History segment format

Section: reporting

IP geo location mode

Name

historyNumberOfShards

namespace

historySegmentFormat

geo

Description

performance and tolerate lost data
nodes. On the other hand they
consume your disc space.

Number of shard (parts) that each
historical index is divided into.
Please follow Elasticsearch
recommendations and projected load
to estimate number of shards
required.

Namespace constant used as the
prefix in the name of Elasticsearch
indexes to ensure no naming conflict
will arise while using the same
Elasticsearch cluster for other tasks
(including 2 independent Knowledge
Center clusters)",

History segment format as Java date

Determine the precision of IP geo
location algorithm.

Value

Value Type:integer

Changes Take Effect: Immediately

Default value: 1

Value Type:integer

Valid values: Any integer greater than 1 and
less than 10 inclusively. Takes effect for new
indexes only, settings of existing historical

indexes will not be changed.
Changes Take Effect: Immediately

Default value: default
Value Type:regular expression [~ [a-zA-
Z0-9_I*$]

Valid values: Any alpha-numeric string
Changes Take Effect: After restart

Default value: yyyy-MM
Value Type: string

Changes Take Effect: Immediately

Default value: CITY
Value Type:enumerated type

Valid values:
[+] OFF

Disabled

[+]1 CITY
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Option Name

Time to live ttl

Kibana provisioning kibana.provision

Overwrite Pulse Templates pulse.provision

Section: search

Description

Specifies the length of time that
records will be stored in the history.

Enable Kibana provisioning with
dashboards and visualization.

Enable Pulse provisioning with
predefined templates.

Value

Customer's city

[+]11IP

Customer's IP Address

[+]1 COUNTRY

Customer's country

Changes Take Effect: Immediately

Default value: 365d

Value Type:regular expression
[~[0-91*(ms|m|h|d|w)]

Valid values: number + unit, for example, 1d
or 3m. Supported units: d (days), m (minutes),
h (hours), or w(weeks)

Changes Take Effect: Immediately

Default value: true

Value Type: Boolean
Changes Take Effect: At start/restart

Default value: true
Value Type: Boolean

Changes Take Effect: At start/
restart
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Option Name

Using NLP at analysis useNIp

Number of documents in result numberOfAnswers

Trending period trendingPeriod

Access to public knowledge privilege.can-access-public

wordsPerMin

Words per minute rate

Section: configuration

Applying NED modifications interval reindexNedInterval

Description

Enables/disables NLP processing
against indexing data and search
queries

Number of documents returned as
the result of search operation (if
other not specified directly in
request)

Number of the days from now that is
document usage is analyzed for to
show trending knowledge documents
(the documents having most
attention during the recent period).

Enables/disables access to public
knowledge for agents (authorized
user). If set to true, agents able to
access both public and private
knowledge bases. If set to false, all
agents have access to private
knowledge bases only unless agent
is granted special privilege"

Default words per minute rate that is
used as basis in reading time
calculation.

(Introduced in 9.0.004.xx)

Defines time between operations of applying
modifications of NED for improving search.

Value
Default value: true

Value Type: Boolean
Changes Take Effect: At start/restart

Default value: 6
Value Type:integer

Valid values: Any integer greater than 0
Changes Take Effect: Immediately

Default value: 10
Value Type:integer

Changes Take Effect: Immediately

Default value: true
Value Type:Boolean

Changes Take Effect: Immediately

Default value: 160

Value Type:integer
Valid values: Any integer greater than 0

Changes Take Effect: Immediately

Default Value: 120s

Value Type: regular expression
[~[0-9T*%(s|m[h|d)]
Changes Take Effect: Immediately
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Option

Feedback classification interval

Update document rating interval

Agent refresh interval

Business attributes refresh interval

Skills refresh interval

Name

feedbackClassificationInterval

updateRatinginterval

usersRefreshinterval

attributesRefreshinterval

skillsRefreshinterval

Description

(Introduced in 9.0.004.xx)

Defines time interval between operations of
classifying feedback information.

(Introduced in 9.0.004.xx)

Defines time interval for performing document
rating update.

Defines the time interval in which
information about agents is cached
in memory. The larger the interval,
the fewer the requests sent to
configuration server, but it will take
more time (up to specified interval)
to get recently updated information
from Configuration Server.

Defines time interval that
information about business
attributes (languages, media type) is
cached in memory. The larger the
interval, the fewer the requests sent
to configuration server, but it will
take more time (up to specified
interval) to get recently updated
information from Configuration
Server.

Defines time interval that
information about skills is cached in

Value
Default Value: 1d

Value Type: regular expression
[~[0-91%(s|m]h]d)]

Valid Values: any positive integer plus h, m,
s or d to indicate hours, minutes, second or
days

Changes Take Effect: Immediately

Default Value: 1h

Value Type: regular expression
[~[0-91%(s|m[h|d)]

Valid Values: any positive integer plus h, m,
s or d to indicate hours, minutes, second or
days

Changes Take Effect: Immediately

Default value: 120s

Value Type: regular expression
[~[0-91%(s|m]h]d)]

Valid values: any positive integer plus h, m,
s or d to indicate hours, minutes, second or
days

Changes Take Effect: Immediately

Default value: 120s

Value Type: regular expression
[~[0-91%(s|m]h|d)]

Valid values: any positive integer plus h, m,
s or d to indicate hours, minutes, second or
days

Changes Take Effect: Immediately

Default value: 120s
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Option

Section: security

Authorization scheme

Password

User ID

Name

auth-scheme

password

user-id

Description

memory. The larger the interval, the
fewer the requests sent to
configuration server, but it will take
more time (up to specified interval)
to get recently updated information
from Configuration Server.

Specifies the HTTP authentication
scheme used to secure REST API
requests to the Knowledge Server.
With the Basic scheme, clients must
be authenticated with a user ID and
password.

Applies to: Genesys Knowledge
Center Server

The user password used in
authentication for the REST API.
Applies to: Genesys Knowledge
Center Server.

The user identifier (login) used in
authentication for the REST API.
Applies to: Genesys Knowledge
Center Server.

Value

Value Type: regular expression
[~[0-91%(s|m[h|d)]

Valid values: any positive integer plus h, m,
s or d to indicate hours, minutes, second or
days

Changes Take Effect: Immediately

Default value: none

Value Type:enumerated type

Valid values:
[+] basic

Basic Authorization

[+] none

Disabled

Changes Take Effect: Immediately

Default value: <empty>
Value Type:string

Changes Take Effect: Immediately

Default value: <empty>

Value Type:string

Changes Take Effect: Immediately
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Option
Section: kibana

Enable/disable Kibana

Path to kibana proxy

Kibana protected (internal) host

Enable/disable connection to
external Kibana

Port of external Kibana instance.

Section: agent-can-see

Access to the query history from the
Knowledge Center WDE Plug-in.

Name

enabled

base path

host

external

port

history

Description

Configuration of Kibana component

Path to mount Kibana for running it
behind a proxy. It is important to
enter exactly the value of "/gks-
server/kibana" with no tailing slash.
Exactly at this point knowledge
server exposes its entry point for
proxying kibana.

Specifies the host to which GKS will
redirect Kibana proxy calls. IP
addresses and host names are both
valid values.

Enabling or disabling use of external
Kibana for reporting.

Specifies the port to which GKS will
redirect Kibana proxy calls.

Enables/disables access to
conversation history. If set to true,
agents are able to access the history
from the Agent Ul.

Value

Default value: false

Value Type: Boolean
Changes Take Effect: Immediately

Default value: ""

Value to enable proxy "/gks-server/kibana"
Changes Take Effect: Immediately

Default value: 0.0.0.0
Recommended value: Hostname or IP

address of Kibana instanse
Changes Take Effect: At start/restart

Default value: false

Value Type: Boolean
Changes Take Effect: At start/restart

Default value: 5601

Recommended value: valid port of external
Kibana instanse

Changes Take Effect: At start/
restart

Default value: true

Value Type: Boolean
Changes Take Effect: At start/restart

Genesys Knowledge Center Deployment Guide

142



Post Installation and Deployment Configuration Options

Logging Configuration Options

Overview

This page explains the options that are used to configure application logging.

It is recommended you define log configuration in the Knowledge Center Cluster Application so it can
be used by all Knowledge Center Server and Knowledge Center CMS nodes connected to the cluster.

The file path defined in the log section of the Knowledge Center Cluster Application
must be valid for every node within this cluster. It is recommended to use a relative

path.

There are two sections in the configuration that allow you to configure log system behavior:

e log - defined logging system common options

¢ log-extended - enables extended logging for certain sub-systems of the application

¢ We do not recommend you change the settings in the log-extended section unless you
are advised to do so by Genesys Technical Support.

* The log-extended section might be used when collecting information for an incident
investigation.

e Please ensure that values in this section are reverted to original values during
production use of the product.

Genesys Knowledge Center allows you to change log options for a particular node of the Knowledge
Center Server or Knowledge Center CMS by defining log configuration options in the Application
object of this particular node.

We do not recommend you define a separate configuration for individual nodes unless
you have a specific reason to do so (for example, you were advised by a Genesys
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Technical Support representative).

Log section
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Option
Section: log
Logging options.
All events all
Standard standard
Trace trace
Debug debug

Name

Description

Specifies the outputs to which an
application sends all log events. The
log output types must be separated
by a comma when more than one
output is configured. For example:
all = stdout, logfile

Specifies the outputs to which an
application sends the log events of
the Standard level. The log output
types must be separated by a
comma when more than one output
is configured. For example: standard
= stderr, network

Specifies the outputs to which an
application sends the log events of
the Trace level and higher (that is,
log events of the Standard,
Interaction, and Trace levels). The
log outputs must be separated by a
comma when more than one output
is configured. For example:trace =
stderr, network

Specifies the outputs to which an
application sends the log events of

Value

Default value: stdout

Value Type:string

Valid values: stdout, stderr, network,
[filename]

Changes Take Effect: Immediately
Default value: stdout

Value Type:string

Valid values: stdout, stderr, network,
[filename]

Changes Take Effect: Immediately
Default value: stdout

Value Type:string

Valid values: stdout, stderr, network,

[filename]

Changes Take Effect: Immediately

Default value: stdout
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Option

Verbose

Logging pattern

Log compression

Name

verbose

outputPattern

compressMethod

Description

the Debug level and higher (that is,
log events of the Standard,
Interaction, Trace and Debug levels).
The log outputs must be separated
by a comma when more than one
output is configured. For example:
debug = stderr, network

Determines whether a log output is
created. If it is, specifies the
minimum level of log events
generated. The log events levels,
starting with the highest priority
level, are Standard, Interaction,
Trace, and Debug.

Specifies the output pattern that logs
is formated to. Log4j/Log4j2 pattern
format must be used.

Specified method that will be used
for archiving log files.

Value

Value Type:string
Valid values: stdout, stderr, network,
[filename]

Changes Take Effect: Immediately

Default value: standard

Value Type:chooseMultiple
Valid values: all > debug | trace | interaction
| standard | none

Changes Take Effect: Immediately

Default value: %d{dd.MM.yyyy
HH:mm:ss}> %-5.5p | %-45.80t
| %-30.1000c{1} %m %ex%n

Value Type:string

Changes Take Effect: Immediately

Default value: <empty>

Value Type:enumerated type

Valid values:
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Option

Segment segment

Expire expire

Description

Specifies whether there is a
segmentation limit for a log file. If
there is, sets the mode of
measurement, along with the
maximum size. If the current log
segment exceeds the size set by this
option, the file is closed and a new
one is created. This option is ignored
if log output is not configured to be
sent to a log file.

Determines whether log files expire.
If they do, sets the measurement for
determining when they expire, along
with the maximum number of files
(segments) or days before the files
are removed. This option is ignored if
log output is not configured to be
sent to a log file.

Value

[+] None

None

[+] gzip

GZIP

[+] zip

ZIP

Changes Take Effect: Immediately
Default value: 100 MB

Value Type:regular expression
[~(?i)(false>(\d+) (kb|mb]hr))$]

Valid values: false | <number>[ KB] |

<number> MB | <number> hr
Changes Take Effect: Immediately
Default value: 10

Value Type:regular expression

[~(?i)(false>(\d+) day|(\d+))$]

Valid values: false | <number>][ file]
(1-1000) | <number> day (1-100)
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Option Name

Time zone timeConvert

Time format timeFormat

Description

Specifies the system in which an
application calculates the log record
time when generating a log file. The
time is converted from the time in
seconds since "00:00:00 UTC,
January 1, 1970".

Specifies how to represent, in a log
file, the time when an application
generates log records. A log record's
time field in the ISO 8601 format
looks like this:
"2001-07-24T04:58:10.123".

Value

Changes Take Effect: Immediately

Default value: local

Value Type:enumerated type

Valid values:

[+] local

The time of log record generation is expressed
as a local time, based on the time zone and
any seasonal adjustments. Time zone
information of the application's host computer
is used.

[+] utc

The time of log record generation is expressed
as Coordinated Universal Time (UTC).

Changes Take Effect: Immediately
Default value: time
Value Type:enumerated type

Valid values:

[+] time

The time string is formatted according to
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Option Name

Message format message-format

Description

Specifies the format of log record
headers that an application uses
when writing logs in the log file.
Using compressed log record
headers improves application
performance and reduces the log
file's size.

Value

"HH:MM:SS.sss" (hours, minutes, seconds, and
milliseconds) format.

[+] locale

The time string is formatted according to the
system's locale.

[+] iso8601

The date in the time string is formatted
according to the ISO 8601 format. Fractional
seconds are given in milliseconds.

Changes Take Effect: Immediately
Default value: custom
Value Type:enumerated type

Valid values:

[+] short

An application uses compressed headers
when writing log records in its log file.

[+] medium

An application uses medium size headers
when writing log records in its log file.

[+] full
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Value
Option Name Description

An application uses complete headers when
writing log records in its log file.

[+] shortcsv

An application uses compressed headers with
comma delimiter when writing log records in
its log file.

[+] shorttsv

An application uses compressed headers with
tab char delimiter when writing log records in
its log file.

[+] shortdsv

An application uses compressed headers with
'messageHeaderDelimiter' delimiter when
writing log records in its log file.

[+] custom

Custom message format, specified in
'customMessageFormat' option.

Changes Take Effect: Immediately
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Configuring Resource Access Points

Genesys Knowledge Center requires two types of Resource Access Points to be configured:

e Elasticsearch Resource Access Point - used by the Knowledge Center Server to access the Elasticsearch
cluster

e CMS Resource Access Point - used by Genesys components (for example, Universal Contact Server 9.1)
to access the Knowledge Center CMS nodes within a cluster

Elasticsearch Resource Access Point Configuration Options

In section resource:
e option type must be set to value "elasticsearch".

For more information see Configure access to Elasticsearch.

CMS Resource Access Point Configuration Options
CMS Resource Access Point must have following options configured:
In section resource

e option type must be set to value "loadbalancer".

e option solution must be set to value "cms".
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Load-Balancing Configuration

Deploying a Cluster

Whenever you deploy a Knowledge Center Server instance, you must configure a
Knowledge Center Cluster, even if you only plan on having one server.

Knowledge Center Cluster stores all of the settings and data that are shared by each of the
Knowledge Center Server instances that reside within it. This makes it pretty easy to add additional
servers as your knowledge needs grow.

Knowledge Center Cluster also serves as the entry point to all client requests sent to Knowledge
Center Servers. The cluster application in Genesys Administrator needs to be configured to point to
the host and port of the load balancer that will distribute these requests among your Knowledge
Center Servers.

If you only have one server deployed in your cluster, you can configure the cluster
application to point directly to the host and port of that server.

Configuring Your Load-Balancer Solution

Let's take a look at how you might configure your load balancer to distribute requests between
servers. This sample uses an Apache load balancer.

Genesys recommends that you use a round-robin approach to balancing for
Knowledge Center Server. If want to use a cluster of Knowledge Center CMS instances
you'll need to use a sticky session strategy for load-balancing in order to keep
authorized user on the same node.
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If you need more information about load balancing in a Genesys environment, the
Genesys Web Engagement Load Balancing page provides some useful background
information.

Prerequisites

Several Knowledge Center Servers/Knowledge Center CMS should be installed. These servers will be
used as cluster nodes (nodel, node2, node3, and so on)

¢ You must have a Genesys Administrator application type Application Cluster

e An application created for each Knowledge Center Servers/Knowledge Center CMS in cluster

All Knowledge Center Server/Knowledge Center CMS applications should be connected to the
application cluster

Start

1. Install Nginx HTTP and reverse proxy server (https://nginx.org/en/). The port and host of the installed
load balancer should be used in the Application Cluster application in Genesys Administrator.

2. Configure nginx as the load-balancer for your cluster. See below for an example of configuring from a
nginx.conf file.

* Pay close attention to the upstream cluster _nodes section; here you can add a list of nodes and
then select the balancing method.

* For Knowledge Center Servers, we recommend using least conn balancing method
(http://nginx.org/en/docs/http/ngx_http_upstream_module.html#least_conn)

» For Knowledge Center CMS, we recommend using ip hash (http://nginx.org/en/docs/http/
ngx_http_upstream_module.html#ip_hash)

3. Restart nginx, then restart all of your nodes.

4. All requests that are sent to nginx will be distributed to your cluster nodes.

user nginx;
worker processes 1;

error_log /var/log/nginx/error.log warn;
pid /var/run/nginx.pid;

events {
worker connections 1024;
)

http {

include /etc/nginx/mime.types;

default type application/octet-stream;

log format main '$remote addr - $remote user [$time locall "$request" '
'$status $body bytes sent "$http referer" '

$http user agent" "$http x forwarded for"';

access log /var/log/nginx/access.log main;
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sendfile on;
#tcp _nopush on;

keepalive timeout 65;
#gzip on;
include /etc/nginx/conf.d/*.conf;
server {
listen 9999;
underscores _in headers on;

location / {
proxy pass http://cluster nodes;

}
}
upstream cluster nodes {
ip_hash;
server gkc-node-1:9010;
server gkc-node-1:9010;
}
}
End

Here are couple of sample requests:

* Request to a specific node: http://host_node_1:port_node_1/gks-sample-ui

¢ Request to the cluster, which will be distributed to any appropriate node:
http://host_load_balacer:port_load_balancer/gks-sample-ui
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Security

Genesys is committed to offering products and solutions with a high level of security. Opening
Application Programming Interface (API) access on the web requires a secure transmission. Genesys
Knowledge Center does not compromise the security level of the enterprise network.

Genesys Knowledge Center adheres to the standards described in the Open Web Application Security
Project (OWASP) Top 10 — see the OWASP website for details about the Top 10 — and has adopted
several methods of ensuring security, for example:

e Errors are logged locally to prevent information leakage through API requests.

¢ User sessions have a timeout option.

¢ Cross Site Request Forgery Protection

The following topics discuss issues that you may wish to consider when deploying the Genesys
Knowledge Center, depending on your enterprise network architecture.

Genesys performs security testing with OWASP Zed Attack Proxy (ZAProxy) to make
sure the Genesys Knowledge Center solution is invincible to known attacks.

Genesys Knowledge Center includes additional security configurations that can be used with your
Knowledge Center installation:

e Transport Layer Security (TLS) with Genesys Server — Configure TLS for connection between Knowledge
Center servers and other Genesys server.
e Authentication — Enable authentication for the Knowledge Center Server and the CMS.

e Cross Origin Resource Sharing (CORS) filter — Configure web resources that are allowed to access
Knowledge Center APIs
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Transport Layer Security (TLS) with
Genesys Servers

Genesys Knowledge Center Server and Genesys Knowledge Center CMS supports the Transport Layer
Security (TLS) protocol to secure data exchanged with other Genesys components. For details about
TLS, see the Genesys Security Deployment Guide.

Configure TLS between Genesys Knowledge Center Server and
Genesys Knowledge Center CMS

If Genesys Knowledge Center Server or Load-Balancer have been used for Servers Cluster configured
to run in TLS mode, you'll need to ensure that its root certificate has been added to the trusted store
of JDK/JRE used by Genesys Knowledge Center CMS. Without this CMS it will not possible to establish
a connection with Knowledge Center Server for background operations.

Configuring TLS for Genesys Servers

To configure the TLS parameters for Genesys servers, see Introduction to Genesys Transport Layer
Security.

Configuring TLS Options

For connections with other Genesys servers, configure Connections of the Knowledge Center Cluster
(8.5.1+) application through secure ports. The Genesys Knowledge Center Server or CMS nodes
includes the following TLS-related configuration options in its security section.

Parameter Name Acceptable Values Purpose
Boolean value.
. Client:
Possible values are "1"/"0", "yes"/"no",
“on"/"off", "true"/"false". 1 - perform TLS handshake immediately
tls after connecting to server. 0 - do not turn
Example: on TLS immediately but autodetect can
still work.
° Ilt|S=1II
"PEM", "MSCAPI", "PKCS11" Explicit selection of security
. provider to be used. For example,
Not case-sensitive. MSCAPI and PKCS11 providers
provider Example: can contain all other parameters
in their internal database. This
+ "provider=MSCAPI" parameter allow configuration of

TLS through security provider
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Parameter Name

certificate

certificate-key

trusted-ca

Acceptable Values

PEM provider: path to a X.509
certificate file in PEM format.
Path can use both forward and
backward slash characters.

MSCAPI provider: thumbprint of a
certificate - string with hexadecimal
SHA-1 hash code of the certificate.
Whitespace characters are allowed
anywhere within the string. PKCS11
provider: this parameter is ignored.

Examples:

e '"certificate= C:\certs\client-
cert-3-cert.pem"

» ‘"certificate=A4 7E A6 E4 7D
45 6A A6 2F 15 BE 89 FD 46
FO EE 82 1A 58 B9"

PEM provider: path to a PKCS#8
private key file without password
protection in PEM format. Path
can use both forward and
backward slash characters.

e MSCAPI provider: this
parameter is ignored; key is
taken from the entry
identified by "certificate"
field.

e PKCS11 provider: this
parameter is ignored.

Examples:

e '"certificate-key= C:\certs\
client-cert-3-key.pem"

PEM provider: path to a X.509
certificate file in PEM format.
Path can use both forward and
backward slash characters.

MSCAPI provider: thumbprint of a
certificate - string with hexadecimal
SHA-1 hash code of the certificate.
Whitespace characters are allowed
anywhere within the string. PKCS11
provider: this parameter is ignored.

Examples:

e "trusted-ca= C:\certs\
ca.pem"

Purpose
tools.

Specifies location of X.509
certificate to be used by
application.

MSCAPI provider keeps certificates in
internal database and can identify them
by hash code; so called thumbprint.

In Java, PKCS#11 provider does not allow
selection of the certificate; it must be
configured using provider tools.

Note: When using autodetect (upgrade)
TLS connection, this option MUST be
specified in application configuration,
otherwise Configuration Server would
return empty TLS parameters even if
other options are set.

Specifies location of PKCS#8
private key to be used in pair
with the certificate by
application.

MSCAPI provider keeps private keys
paired with certificates in internal
database. In Java, PKCS#11 provider does
not allow selection of the private key; it
must be configured using provider tools.

Specifies location of a X.509
certificate to be used by
application to validate remote
party certificates. The certificate
is designated as Trusted
Certification Authority certificate
and application will only trust
remote party certificates signed
with the CA certificate.

MSCAPI provider keeps CA certificates in
internal database and can identify them
by hash code; so called thumbprint. In
Java, PKCS#11 provider does not allow
selection of the CA certificate; it must be
configured using provider tools.
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Parameter Name

tls-mutual

tls-crl

tls-target-name-check

cipher-list

fips140-enabled

sec-protocol

Acceptable Values

e "trusted-ca=A4 7E A6 E4 7D
45 6A A6 2F 15 BE 89 FD 46
FO EE 82 1A 58 B9"

Boolean value.

Possible values are "1"/"0", "yes"/"no",
"on"/"off", "true"/"false".

Example:

e "tls-mutual=1"

All providers: path to a Certificate
Revocation List file in PEM
format. Path can use both
forward and backward slash
characters.

Example:

e "tls-crl= C:\certs\crl.pem"

"host" or none. Not case-
sensitive.

Example:

e "tls-target-name-check=host"

String consisting of space-
separated cipher suit names.
Information on cipher names can
be found online.

Example:

e '"cipher-list=

Purpose

Has meaning only for server
application. Client applications
ignore this value. When turned
on, server will require connecting
clients to present their
certificates and validate the
certificates the same way as
client applications do.

Applications will use CRL during
certificate validation process to
check if the (seemingly valid)
certificate was revoked by CA.
This option is useful to stop
usage of leaked certificates by
unauthorized parties.

When set to "host", enables
matching of certificate’s
Alternative Subject Name or
Subject fields against expected
host name. PSDK supports DNS
names and IP addresses as
expected host names.

Used to calculate enabled cipher
suites. Only ciphers present in
both the cipher suites supported
by security provider and the
cipher-list parameter will be

TLS_ECDHE_RSA_WITH_AES 2563@[&}@ SHA
TLS ECDHE RSA WITH AES 128 CBC_SHA
TLS ECDH RSA WITH 3DES EDE CBC SHA"

Boolean value.

Possible values are "1"/"0", "yes"/"no",
"on"/"off", "true”/"false".

Example:

e "fipsl40-enabled=1"

String value.

Possible values are "SSLv23", "SSLv3",
"TLSv1", "TLSv11", "TLSv12".

PSDK Java: when set to true,
effectively is the same as setting
"provider=PKCS11" since only
PKCS11 provider can support
FIPS-140. If set to true while
using other provider type, PSDK
will throw exception.

Starting with PSDK release 8.5.1,
an application can specify the
exact protocol to send and
accept secure connection
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Parameter Name Acceptable Values Purpose

Example: .
requests on one or more of its

« "sec-protocol=TLSv1" connections.

See Configuring Trusted Stores below for details about configuration for a specific type of store (PEM,
JKS, MSCAPI).

Configuring Trusted Stores
PEM Trusted Store

PEM stands for "Privacy Enhanced Mail", a 1993 IETF proposal for securing email using public-key
cryptography. That proposal defined the PEM file format for certificates as one containing a
Base64-encoded X.509 certificate in specific binary representation with additional metadata headers.

PEM certificate trusted store works with CA certificate from an X.509 PEM file. It is a recommended
trusted store to work on Linux systems.

Complete the steps below to work with the PEM certificate trusted store:
Start

1. Configure TLS for Genesys servers to use certificates signed by CA certificate certificateCA.crt.

2. Place the trusted CA certificate in PEM format on the Genesys Knowledge Center Server application
host. To convert a certificate of another format to .pem format you can use the OpenSSL tool. For
example:

* Convert a DER file (.crt .cer .der) to PEM:
openssl x509 -inform der -in certificateCA.crt -out certificateCA.pem

» Convert a PKCS#12 file (.pfx .p12) containing a private key and certificates to PEM:
openssl pkcsl2 -in certificateCA.pfx -out certificateCA.pem -nodes

You can add -nocerts to only output the private key or add -nokeys to only output the
certificates.

3. In Genesys Administrator, navigate to Provisioning > Environment > Applications and open your
Knowledge Center Server application.

4. Click the Options tab and navigate to the security section.
5. Set the trusted-ca-type option to PEM.

6. Set the trusted-ca option to the path and file name for your trusted CA in PEM format on the Genesys
Knowledge Center Server application host.

7. Click Save & Close.

End
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JKS Trusted Store

A Java KeyStore (JKS) is a repository of security certificates used, for instance, in SSL/TLS encryption.
The Java Development Kit provides a tool named keytool to manipulate the keystore.

Complete the steps below to work with the JKS certificate trusted store:

Start

N =

8.

. Configure TLS for Genesys servers to use certificates signed by CA certificate certificateCA.crt.
Import the CA certificate to an existing Java keystore using keytool:

* Run the keytool command with option -alias set to root:
keytool -import -trustcacerts -alias root -file certificateCa.crt -keystore
/path/to/keysore/keystore. jks

* Enter the keystore password in command line prompt - for example:
Enter keystore password: somepassword

. In Genesys Administrator, navigate to Provisioning > Environment > Applications and open your
Knowledge Center Server application.

. Click the Options tab and navigate to the security section.
Set the trusted-ca-type option to JKS.

. Set the trusted-ca option to the path and file name for your JKS trusted storage type on the Genesys
Knowledge Center Server application host.

Set the trusted-pwd option to the password defined for your keystore in Step 2.
Click Save & Close.

End

MSCAPI Trusted Store

Complete the steps below to work with the MSCAPI certificate trusted store:

Start

1

2.

3.

. Configure and tune TLS for Genesys servers to use certificates signed by the same CA.

If the Knowledge Center Server is running on a different host, copy the trusted CA certificate to this
host.

Import the CA certificate to WCS via Certificates Snap-in on the Knowledge Center Server host by
launching the MMC console. Enter mmc at the command line.

4. Select File > Add/Remove Snap-in... from the main menu.
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= Consolel - [Console Root] [_ O] I
w Action  View  Favorites  Window  Help | = |5' |§|
@:g Pew CErl+HM
—  Open.. Chrl+C I
— Save Chrl+5
Save Az, There are no iterns ko show in this view,
add/Rel Chrl+m
Options, .
1 Chwindowsh, , \services, msc
2 ServerManager.msc
3 S indowst. .\ compmgmk. msc
4 C1indowstsywstem32) secpol.msc
Exit
|Enables wou to add snap-ins to or remowve them From the snap-in console,
5. Select Certificates from the list of available snap-ins and click Add.
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7= rConsolel - [Console Root] _ (Ol x]

@ File  Action View Favorites Window  Help 12| x|
sl Add or Remove Snap-ins [ x|

&= =]

=] Console Rao You can select snap-ins for this console From those available on your computer and configure the selected set of snap-ins, For
5 extensible snap-ins, wou can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-in | Wendor | - ] Console Raat Edit Extensions. .. |
= Activel Contral Microsaft Car...
.ﬁ.uthorization Manager Microsoft Cor... REmave |
es Micrasaft Car...
_:EE." Camponent Services Microsoft Car. .. Move Up |
;g!(:ornputer Managem.., Micrasoft Cor,,, —
sk Device Manager Microsaft Cot.., [Maye Down |
= Disk Management Microsoft and. .. Add = |
@ Event Viewer Microsaft Cot..,
| Folder Microsaft Cor,..
_i‘f Group Policy Object ... Microsoft Cor,,,
-;g"'lnternet Information... Microsoft Cor..,
@ IF Securiby Monikor Microsoft Cor, .,
@ 1P Security Policy Ma... Microsoft Cor...
12| Link to web Address Microsoft Car... LI e
Description:
The Certificates snap-in allows you to browse the contents of the certificate stores For yourself, a service, aor a compu ter.

K I Cancel |

6. Select the account to manage certificates for and click Finish. It is important to place certificates under
the correct Windows account. Some applications are run as services under the Local Service or System
account, while others are run under user accounts. The account chosen in MMC must be the same as
the account used by the application which certificates are configured for, otherwise the application will
not be able to access this WCS storage.
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= Consolel - [Console Root] 9 =] '

& Fle  Action  Vie

|| Console Roo of snap-ins, For

This snap-in will always manage certificates for:

% My user account Edit Extensions |

" Service account

" Computer account Bemove |

Mave g |
flae: Lo |

advanced... |
[
< Back I Firizh I Cancel | e
acompu ker,

oK | Cancel |

7. Click OK.

8. Import a certificate. Right-click the "Trusted Root Certification Authorities/Certificates" folder and choose
ALl Tasks > Import... from the context menu. Follow the steps presented by the Certificate Import
Wizard. Oonce finished the imported certificate appears in the certificates list.
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9. In Genesys Administrator, navigate to Provisioning > Environment > Applications and open your

Knowledge Center Server application.

10. Click the Options tab and navigate to the security section.

11. Set the trusted-ca-type option to MSCAP.
12. Click Save & Close.

End
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Authentication

You can enable secure communications with the Management and Reporting REST APIs by completing
the procedures below to implement authentication. If you do enable authentication, then all API
clients must use the authentication scheme and credentials. Three common clients of the API are the
Genesys Knowledge Center Plugin for Administrator, Genesys Knowledge Center Plugin for Workspace
Desktop Edition and Genesys Knowledge Center CMS.

Configuring Authentication in Genesys Knowledge Center

Complete the steps below to enable authentication for the Management and Reporting REST APIs.

Start

1. In Genesys Administrator, navigate to Provisioning > Environment > Applications, select the
Knowledge Center Cluster application, and click Edit....

2. Click the Options tab and scroll down to the [security] section.

3. Set the following options:
» auth-scheme
* user-id
* password

4. Click Save & Close.

End
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Cross Origin Resource Sharing (CORS) Filter

What i1s CORS?

Since the browser Same Origin Policy prevents a web page from making an XMLHttpRequest to
another domain, the Genesys Knowledge Center supports Cross Origin Resource Sharing (CORS) to
allow the web application to interact with the Knowledge Center APIs across domains.

For a simple request — one that uses either GET or POST and whose body is text/plain — the request
is sent with an extra header called Origin. The Origin header contains the origin URI (scheme, domain
name or address, and port, as per RFC 6454) of the requesting page so that the server can easily
determine whether or not it should serve a response. An example Origin header might look like this:
Origin: http://www.genesys.com:8080

If the server decides that the request should be allowed, it either sends an Access-Control-Allow-
Origin header echoing back the same origin that was sent or '*' if it is a public resource.

For example:
Access-Control-Allow-0rigin: http://www.genesys.com:8080

If this header is missing, or the value of this header does not match the value of Origin header, then
the browser disallows the request. If all is well, then the browser processes the response.

For general information and background on CORS, see Cross-Origin Resource Sharing.

Configuring CORS Filter

Knowledge Center supports the CORS pre-flight OPTIONS requests.

Types of requests:

e A CORS request is an HTTP request that includes an “Origin™ header.

¢ A CORS-preflight request is a CORS request that checks to see if the CORS protocol is understood. It
uses “OPTIONS" as method.

Allowed-Origins

To set up Cross-Origin Resource Sharing, make sure you set the allowedOrigins option in the cross-
origin section of Knowledge Center Cluster application. Knowledge Center will use the provided list
of domains to validate the Origin header of the request and respond with Access-Control-Allow-
Origin in response.
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By default cross-origin/allowedOrigins is set to * which makes it possible to use
Knowledge Center APIs from any web resource. Before going into production mode,
the default value of this option MUST be updated with the most precise list of origins

in which APl access is allowed.

allowedOrigins option must be set as a comma-separated list of allowed domains. For example:

allowedOrigins=http://*.genesys.com,http://*.genesyslab.com

Other CORS options

All options are collected in section cross-origin (default), however the name of this section can be
changed. Note: Genesys Knowledge Center has two application servers, while CMS and every other
application have their own section: gks.cross-origin and cms.cross-origin.

Option

skipCheckControlRequestHeaders

preflightMaxAge

passBlockedRequestToChain

exposedHeaders

enable

emptyAllowedFor

Description

Allow pass CROSS preflight
request with out check Access-
Control-Request-Headers.

The number of seconds that
preflight requests can be cached
by the client.

Allow pass next chain if this
request is CROSS request but
not allowed by origin, method, or
header.

A whitelist of additional response
headers to be exposed to the
browser tab beyond the default
headers.

Boolean value that allows cross-
origin filter.

A comma-separated list of
requested URLs that are allowed
to access this server application
in the case when there is no

Default value
false

for Genesys Knowledge Center:
true

1800 seconds, or 30 minutes

for Genesys Knowledge Center:
3600 seconds, or 60 minutes

true

Cache-Control,Content-
Language,Content-
Type,Expires,Last-
Modified,Pragma

for Genesys Knowledge Center:

gkc_agentld,gkc_apiClientld,gkc_apiClientMediaType,
gkc_customerld,gkc_interactionld,gkc_sessionld,
ContactCenterlD,Authorization,contentType

true

¥ (any request)
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Option Description

Origin and Referer.

This option is affected if allowOrigin
does not contain "*" (any origin).

Boolean value that disables the
OPTIONS http request if it is
true. If it is false we cannot use
preflight requests.

disableHttpOptionsRequest

Boolean value; will answer
Referrer canonized to Origin
instead of Origin for use with
native CrossOrigin check.

If this option is enabled:

* Origin present and Referrer
present and both are valid
(filter recognizes them as
allowed for CrossOrigin), so
CrossOrigin headers are

checkReferer added to response.

e Origin absent and Referrer
present and valid, so
CrossOrigin headers are
added to response.

e Origin present and Referrer
present and one of them is
invalid, so CrossOrigin
headers are not added to
response.

If true, preflight requests are
chained to their target resource
for normal handling (as an
OPTION request). Otherwise the
filter responds to the preflight.

chainPreflight

A comma-separated list of origins
(for example, instrumented web
sites) allowed to access this

server application.
allowedOrigins

If an allowed origin contains one or more

"*" characters (for example

http://*.domain.com) this can be

interpreted as a regular expression.

a comma-separated list of HTTP
methods that are allowed to be
used when accessing the
resources (for preflight requests).

allowedMethods

a comma separated list of HTTP

allowedHeaders headers that are allowed to be

Default value

false

true

true

¥ (any origin)

GET,POST,HEAD

for Genesys Knowledge Center:
GET,POST,HEAD,PUT,DELETE, ATCH

X-Requested-With,Content-
Type,Accept,Origin
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Option Description Default value

for Genesys Knowledge Center:
specified when accessing the gkc_agentld,gkc_apiClientld,gkc_apiClientMediaType,

resources (for preflight requests). gkc_customerld,gkc_interactionld,gkc_sessionld,

ContactCenterlD,Authorization,contentType,Content-

Type
false
A boolean indicating if the
allowCredentials resource allows requests with for Gen Krowledae Contor:
credentials. or Genesys Knowledge Center:

true

For morel information and background on CORS and response headers, see Cross Origin Resource
Sharing Standard.
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Translation service

Usage of translation service will result in the document content being transferred to
the 3rd-party translation provider. By enabling this feature you authorize your authors
to perform such operations with the pre-configured translation service. Usage of
translation service will result in the service fee according to the pricing policy of the
translation provided and configured.

What is translation service?

Knowledge Center can use 3rd-party translation APIs to enable authors with a capability to
automatically translate the content of knowledge documents from one language to another.

Authors can translate the whole document or just particular fields of the document. Automated
translation allows using state-of-the-art Neural Machine Translation (NMT) to simplify an authors work
by avoiding routine translation done by computer. The Author is able to review and edit pre-
translated content before saving.

Supported Translation APIs

Knowledge Center supports following Translation APIs:

¢ Cloud Translation API
¢ Microsoft Translator Text API

¢ Yandex.Translate API

Configuring Translation Service

The Administrator is able to configure the translation service for the Knowledge Center cluster by
setting following option:
1. In the section translation set option Translation Service (type) to one of the following values:
* none - translation service is disabled (default value)
e google - Cloud Translation API

¢ microsoft - Microsoft Translator Text API
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* yandex - Yandex.Translate API

2. In the section translation, set option APl Key (key) to the value of APl key provided by the selected
translation provider.

Getting API key

This chapter provides sample steps to get APl Key from one of the supported
translation providers. Please always refer to the documentation of the selected
provider to get up-to-date information on configuration on API keys and pricing.

Warning

Usage of Translation APl will result in changes on your account according to pricing
policy of the selected provider.

Each of the providers of text translation functionality has its own way of obtaining the API key:

Google

1. Sign in at Google cloud

console
1 Set up Google cloud project

2. Create new or open one of
your existing project

1. Open APIs and Services >
Dashboard

2. Click ENABLE APIS AND
SERVICES

Add "Cloud Translator API" to 3

our project . Search for and click Cloud
you )

Translation API
4. Click ENABLE
A console will ask you to enable billing.

After you approve use of billing, Cloud
Translator API is added to your project.

3 Create API key 1. Open APIs and Services >
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Microsoft

Credentials

2. Click Create credentials >
API key

API key is created and ready to use.

e Don't have an account? Sign-
up for a Microsoft Azure

Sign into Azure account

¢ Already have an account?
Sign-in

. After you sign into Azure,
navigate to Cognitive
Services

Under API Type select Text
or Speech API

* You can only add one
Translator API subscription
at a time

In the Pricing Tier section,
select the pricing tier that

Subscribe to Microsoft Translator best fits your needs

e Each subscription has a
free tier. The free tier has
the same features and
functionalities as the paid
plans and does not have
an expiration date

Fill out the rest of the form,
and select Create

* All subscriptions go into
effect immediately

Navigate to All Resources
and click on your subscription
to retrieve your

Retrieve Authentication Key authentication key

e The Key value is used for
authentication so keep
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the Key value confidential.
You will need this when
you develop your app.

Yandex
L Use the Yandex home page to
1 Sign into Yandex sign-in or sign-up.
Navigate to API keys and click
> Create API key Create key. In the popup, enter

the description of your key and
click Create.
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IP Geolocation

Collecting information about a customer's location and the way it is stored may be
subject to regulations or restrictions within your country or countries you operate in.
Please check with your national legislation to ensure you are not in violation. This
feature can be turned off if needed.

What is Geolocation

Geolocation is the identification or estimation of the real-world geographic location of an object. IP
geolocation is the process geolocation that is based on the client's IP address as the into a physical
location.

When geolocation is enabled it allows Genesys Knowledge Center to store client IP address and its
relevant geolocation information in the History index. Stored information is mostly useful in the
reports allowing to understand regional differences in the knowledge usage by the agent and
customer.

IP geolocation is inherently imprecise. Locations are often near the center of the population. Any
location provided should not be used to identify a particular address or household.

The actual location of the IP address is likely within some radius area around the latitude and
longitude coordinates.

Configuring IP Geolocation

The Administrator is able to configure the precision of the geolocation for the Knowledge Center
cluster (cluster/reporting/geo) as:

e off - disable the IP geolocation functionality: both IP and longitude and latitude are empty for historical
records

IP - only IP address is stored, Knowledge Center is not identifying geographic location of the customer
e country - IP and country name longitude and latitude of country are stored

e city (default) - IP, country name and and city longitude and latitude are stored

Described levels are defined in the Knowledge Center Cluster option geo that is located in section
reporting.
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Visualize the Geolocation Information

This stored data is used in the Kibana to visualize:

* a geo-map with requests heat indicators

e the top 10 countries

Im%‘“%% i

.ml..
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Activity Heatmap

How to Update the Geolocation Database

Geolocation functionality requires a special database to translate a client's IP address to the
geographical location of the customer. When Genesys Knowledge Center Server is installed it
provides the MaxMind GeolLite2 City database stored in <installation directory>\linguatools\
geoip folder. The folder storing the database can be changed in the gks.yml file:

path.geoip : <IP folder>/GeoIP/GeolLiteCity.dat

To update the database you need to:
1. Visit MaxMind GeolLite2 database download page. Note: Knowledge Center is not supposed to work with
other MaxMind products (for example, Geolite or GeolP, please use Geolite2).

2. Download the most recent version of the City database.Note: Please download database in MaxMind DB
binary format.

3. Unarchive the database.
4. Store the database in the folder configured in the gks.yml file

5. Restart Genesys Knowledge Center Server.
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e These steps needs to be executed for every Knowledge Center Server node in the
cluster.

* You can store the geolocation database in shared network location to ensure that it is
updated for all Knowledge Center Server nodes.
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UTF8

You can configure your Knowledge Center Servers and Knowledge Center CMS to support UTF-8 in
Configuration Server, which in turn supports multi-language categories.

Configuring a UTF-8 Connection to Configuration Server

Complete the following steps for your Knowledge Center Servers.

Prerequisites

e Your version of Configuration Server supports UTF-8. For details, see the compliant versions for
mandatory components.

Start

1. Navigate to the installation directory for your Knowledge Center Server and open the setenv.bat file
for Windows — or the setenv.sh file for Linux — with a text editor. For example: Path to installation
directory/server/setenv.bat.

2. Find the following string: :: set JAVA_OPTS=%)AVA_OPTS% -Dgenesys.cfgServerUseUtf8=true.

3. Remove the two colons (::) at the start. This converts the string from a comment to a command to use
UTF-8. Your string should now look like this: set JAVA_OPTS=%)AVA_OPTS%
-Dgenesys.cfgServerUseUtf8=true

4. Save your changes.

End

Genesys Knowledge Center Deployment Guide 177



Post Installation and Deployment Supported Languages

Supported Languages

Genesys Knowledge Center supports a search for the right answer in any language. It executes a
knowledge search involving different natural language processing techniques to come up with the
best suggestions for the question asked. The level of the search processing functionality depends on
the language. The table below lists the languages that have advanced search processing, along with
the level of advanced processing support for each language.

Advanced Natural Language

Content Language Product Version Processing Level
English 8.5.000+ all
Danish 8.5.302+ =

8.5.302+ o
Finnish

9.0.003+ ul
French 8.5.100+ =1l

8.5.100+ .
German

8.5.304+ =il
Italian 8.5.100+ o |
Norwegian 8.5.302+ ™ |
Portuguese 8.5.100+ =il

8.5.100+ -
Spanish

8.5.304+ ™ |

8.5.302+ ull
Swedish

8.5.304+ =il
Croatian 9.0.003+ ul
Romanian 9.0.003+ - |

For languages not listed in the table above, Genesys Knowledge Center provides a keyword-based
search of the available knowledge articles.
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Supported syntax for questions

Knowledge Center can handle both natural language queries (when you express your question in
human language) as well as keyword-based queries.

Example queries:

Natural-language query: How to install Knowledge Center CMS?
Keyword query: install CMS

For languages that support natural-language techniques, you can use either query type. For
languages that use a basic keyword search (those not listed in the table above), keyword queries
provide favorable results compared to natural language queries. If necessary, decrease the “out-of-
domain” limit to include results having lower confidence levels in the final result set.

How to configure the out-of-domain limit

The out-of-domain limit defines the minimum confidence level for a document to appear in the result
set. It enables you to hide less relevant documents in search results. To change the out-of-domain
limit, edit the option in the properties of your knowledge base.

e For instructions on how to configure the out-of-domain limit, see the Behavior Options section of the
Managing Knowledge Bases topic, in the Genesys Knowledge Center Help.

The out-of-domain limits range from 0, representing 0% confidence, to 1, 100% confidence. The value
0.75 is considered a magic value. It corresponds to the exact match between the search term and the
document, without proof of learning signals. Every learning signal (for example, positive relevancy
feedback) improves it further.

The following table lists recommended out-of-domain limits:

Advanced Natural Language Processing Level Out-of-domain value
None 0.20
il 0.50
il 0.46
=l 0.38
0.35

For knowledge bases with multiple languages, you must set the out-of-domain limit to the lowest of
the possible values. For example, if your knowledge base includes articles in both English and French,
the recommended values 0.5 for English and 0.46 for French. The recommended value for the entire
knowledge base is 0.46.
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Screening Rules and Standard Responses

Overview

Knowledge Center allows users to:

e Create and edit Standard Responses—an item in the Standard Response Library, which stores pre-
written responses for use as suggestions to agents, acknowledgments, and/or autoresponses.

¢ Create and edit Screening Rules in order to screen interactions for specific words or phrases, which you
can then use to decide how to handle the interaction.

This functionality is aimed to be used in the environment that uses Universal Contact
Server 9.1 and later. Additional information can be found in the UCS 9.1
documentation at the following locations:

* Integration with Genesys Knowledge Center/Content Management System 9.0

¢ Deploying GKC Content Management Server

If you are using Universal Contact Server 8.x it is recommended you disable Screening
Rules and Standard Responses in Knowledge Center CMS.

Universal Contact Sever 8.x uses its own storage for Standard Response and
Screening Rules, and eService Manager must be used to manage them. For more
information, see eServices Manager Plug-in for GAX.

This following describes how to enable and disable Screening Rules and Standard Responses in
Knowledge Center CMS.

Enabling Standard Reponse

By default, the Standard Response functionality is disabled so we must first enable it either through
Genesys Administrator or Genesys Administrator Extension (GAX).

Genesys Knowledge Center Deployment Guide 180


https://docs.genesys.com/Documentation/UCS/latest/Dep/Overview#intgkccms
https://docs.genesys.com/Documentation/UCS/latest/Dep/CMS
https://docs.genesys.com/Documentation/ES/latest/ESMgr/KMwelcome

Post Installation and Deployment Screening Rules and Standard Responses

How to enable Standard Response through Genesys Administrator

Log in to Genesys Administrator through GAX.

Click the Provisioning tab.

From the Environment folder, select Applications.
Double-click gkc-cluster.

Select the Options tab.

Navigate to cms.ucs > cms.ucs\srl-enable.

No v ks~ w N H

Set the Value to true

OPERATIONS

pplications > gke-cluster
] gke-cluster - \ Applications\

% Cancel |l Save & Close |l save |l Save &uNew | [ Reload | = start [ Stop [ Graceful Stop

|  Configuration H_Opliuns _H_Pemusslons H " Dependencies H_A\arms H “Logs

[ New (3¢ Delete % Export T Import View: Advanced View (Options)
Name Section Option Value

T | Filter Filter Filter Filter
cms.index/enable cms.index enable true
cms.index/minNodes cms.index minNodes o

= cms.ucs (10 Ttems)

cms.ucs/asyncsync-delay cms.ucs asynesync-delay 1000
cms.ucs/config-synchro-mode cms.ucs config-synchro-mode bothy
cms.ucsfieldcode-format-locale cms.ucs fieldcode-format-locale
cms.ucs/postpone-synchro-delay cms.ucs postpone-synchro-delay 1000
cms. ucs/replace-blank-fieldc ode cms.ucs replace-blank-fieldcode false
8 Tms. ucs streening-TUETSyme-dela 10000
cms.ucs/sri-enable cms.ucs srl-enable true
a anee < cms.ucs standard-responses-sync-gdelay 10000
Cms.ucs/synchronize-screening-rules cms.ucs synchronize-screening-rules trug
cms._ucs/synchronize-standard-responses cms.ucs synchronize-standard-responses true
= general (3 Items)
generallesReadOnly general esReadOnly true
general’knowledgebaseFolder general knowledgebaseFoider knowiedge
generalisessionTtl general sessionTtl 2n
= index (5 Ttems)
indexfdocstatNumberOfReplicas index docstaiNumberOfReplicas 1
w—— Displaying obj

8. Click Save & Close to apply your changes.

How to enable Standard Response through GAX

Log in to GAX.

Go to Configuration > Environment > Applications.

Navigate to the Knowledge > QA > 853 > Knowldge_Space_Freeling Properties folder.
Click Application Options from the left-hand menu.

Navigate to the ems.ucs section and click cms.ucs\srl-enable.

Set the Value to true.

N o v A w N

Click OK, and Save to apply your changes.
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Home > > > > 0A > 853 > _Space_Freeling Properti Tl Delete Application
Application Options Q Quick Filter

] Name ¢ Section ¥ Key §  Valve

Ports
] v cms.ucs

Tenants
0 cms.ucs \ asyncsync-delay cms.ucs asyncsync-delay 1000

Options
[al ©ms.ucs \ config-synchro-mode cms.ues config-synchro-mode periodically
a cms.ucs \ fieldcode-format-locale cms.ucs fieldcode-format-lecale
] cms.ucs \ replace-blank-fieldcode cms.ucs replace-blank-fieldcode false

ication Options

0 ©ms.ucs \ screening-rules-sync-delay cms ucs screening-fules-sync-delay 10000
& cms.ucs \ sr-enable cms.ucs srlenable @
(] cms.ucs \ standard-responses-sync-delay cms.ucs standard-responses-sync-delay 10000
[l €ms.ucs \ synchronize-screening-rules cms ucs synchronize-screening-rules. false
(& €ms.ucs \ synchronize-standard-responses coms ucs synchronize-standard-fesponses faise
i} ¥ general
0 general \ knowledgebaseFolder general knowledgebaseFolder knowledge_tpl

ana—— /
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Knowledge Center in Production

This chapter provides you with information on the Knowledge Center once in production within your
environment. It covers following topics:

* Monitoring Knowledge Center

¢ Sample Ul
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Monitoring Knowledge Center

Knowledge Center provides access to metrics and other key performance indicators (KPIs).

It also gives you the ability to configure Message Server alarms when a KPI passes its threshold
value.

Monitoring Capability supported by both Knowledge Center Server and Knowledge
Center CMS.

Knowledge Center Metrics

Starting with release 8.5.000.13, Knowledge Center integrates with the third-party Metrics Java
library to keep track of several Knowledge Center metrics. The Metrics toolkit includes counters,
timers, histograms, and gauges.

You will probably want to use Java Management Extensions (JMX) as your main way of reporting on
these metrics. We show how to do that here. Or you may want to check out some of the other tools
that are available.

You can also use REST—which is helpful for performance testing—or write your metrics to a log file or
to the console.

Knowledge Center Alarms

Knowledge Center lets you use tools from the Genesys Management Layer for monitoring and
controlling your applications. These tools can be an important factor in improving
performance—especially alarms, which let you set performance thresholds for these key metrics:

e Garbage collection latency

* Heap memory usage

Alarm Configuration
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Alarm name

Threshold type

Heap Memory
Usage

GC Latency

Alarm
description

Selection mode type
Defines the heap

memory usage

threshold value.

This is the ratio

of used heap

memory to

maximum heap

memory.

Defines the
garbage predefined
collection
latency threshold
value, in
milliseconds, in
relation to the
last time the
garbage was
collected within
the configured
time interval.

Application

Alarm Condition object

Detect Event
ID

Select by
Application Type

Cancel Event
ID

Knowledge
Center Backend
Server

100001

10005

Related
configuration
option
100002 HeapMemoryUsage.threshold
10006 GclLatency.threshold
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Viewing Metrics with JMX

You can use JConsole to view metrics provided by your Knowledge Center Server. To do this, you can
start Knowledge Center Server as a:

* Local java process
e Server on a remote host

* Windows service
Once you have connected, you can view your metrics in a JConsole JMX panel.

You may also want to look into some of the other tools that are available for viewing your Knowledge
Center metrics.
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Connect to Knowledge Center started as a local java process.

gltunsule: Mew Conneckion

New Connection

{+ Local Process:

Mame | P |

zap-2.4.0.jar
carm, ge uncher . boak

onsale, Jansale

Mote: The management agent will be enabled on this process,

{~ Remote Process:

Usage: =hostmame:=: sport= OF service:jmx: =protocol=: =sap=

Username: Password: I

Conneck | Cancel

1. Run jconsole.exe from the jdk/bin directory.
2. Inthe New Connection dialog, specify the Knowledge Center launcher java process.

If the Knowledge Center Server was started via a BAT file in the same host where the JMX console is opened, this launcher process
is the com.genesys.launcher.bootstrap.Bootstrap process from the Local Process list.
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Connect to Knowledge Center Server started on a remote host.

Eltnnsule: Mew Conneckion

New Connection

i~ Local Process:

Mame | P |
zap-2.4.0.jar 4612
sun, kools, joonsole, JConsole 3520
com.genesys,launcher, bookstrap, Bookstrap 2103

{+ Remote Process:

I192. 1658.67,112:7199

Usage: =hostname:=: =port= OR service: jrx: =probocol=: =sap=

Username: Password: I

Conneck | Cancel

If the Knowledge Center Server was started remotely as a server, follow these steps:

1. Run jconsole.exe from the jdk/bin directory.

N

. Open setenv.bat and uncomment all of the lines under the line that begins:
:: Uncomment for enabling JMX

3. Save your changes.
4. Restart the Knowledge Center Server application.

5. Specify host:JMX port in the Remote Process section, as shown in the screenshot on the left.

Connect to Knowledge Center started as a Windows service.

If Knowledge Center Server is started as a Windows service, you should first stop
the service, reinstall it, and restart it, as shown in these steps:

1. Stop the service.

2. Open setenv.bat and find the service name in the line that says SVC NAME=.
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3. Run this command to remove the service:
server.bat -service <service name> remove
4. Open setenv.bat and uncomment all of the lines under this one:
Uncomment for enabling JMX Remote. Memorize JMX port.
5. Save your changes.
6. Run this command to install the service:

server.bat -service <service name> install

7. Start the service.

8. Specify host:JMX port in the Remote Process section, as shown in the above screenshot.

Open the IMX panel to view the metrics.

Connection  Window  Help

id: 7532 com.genesys.launcher.bootstrap.Bootstrap

Overviewl Memoryl Threadsl Classesl YM Summary  MBeans | i
- Attribute walues

- IMImplementation =
: cluster 1-mettics Mame Yalue
com.genesys, cassandra.client.chatInfo alue 2
com.genesys,cassandra. client. driResources
cam.gensasys.cassandra. client.engagementPro
com.genesys.cassandra. client. events
com.genesys,cassandra, client. visitProfile
com.genssys.cassandra,server

com.genesyslab. platform[F7d08893-0618-4624—
com.genesyslab, wme

)| cam.genasyslab, wme, metrics

: (% Bridge_HeapMemorylsage

(% Bridge_MarkSweep_CollectionCount

--@ Bridge_MarkSweep_LasteInfo

[ Bridge_Scavenge_CollectionCount

[+ (@ Bridge_Scavenge_Last&cInfo

--@ Bridge_StartTime

E}@ DroolsSessionCache. Cachesize

--Operations
#- (8 DroolsSessionCache, EnvictionCount
t- (3 DroolsSessionCache. HitCount
- (% DroolsSession”ache.LoadExceptionount
v (8 DroolsSessionCache,LoadSuccessCount
t- (@ DroolsSessionCache.MissCounk -

e O B e B

1. Click Connect in the New Connection dialog. The JMX panel opens.

2. Open the MBeans tab and expand com.genesyslab.wme.metrics. All of the Knowledge Center
metrics are there.

3. To refresh the metrics, click Refresh.
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Other Tools

We have just explained how to use the JConsole tool bundled with Oracle Java (TM) to view your
metrics, but there are several other tools you can use to do this:

e The EJTools JMX Browser

* Panoptes

e jManage

« MC4J

e Zabbix
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Sample Ul

Overview

Knowledge Center comes with a Sample Ul, hosted on a sample website, which provides basic access
to your installation of Knowledge Center and your configured knowledge base content. You can use it
to test and demonstrate what Knowledge Center can do or as an example of how to integrate
Knowledge Center access into your existing website.

The Sample Ul is based on independent and easily configurable components. Its website was created
using Bootstrap and works on all web browsers that support Bootstrap. See the Bootstrap
documentation for details.

After you install your Knowledge Center Servers and configure the Knowledge Center Cluster, you can
access the Sample Ul sandbox via the following URLs:

* If you have configured a load-balancer for your cluster: http://host load balacer:port load balancer/gks-
sample-ui

e If you use a Knowledge Center Cluster with a single node: http://gkc_server_host:gkc_server_port/gks-
sample-ui

The Sample Ul is pre-configured to show all Active and Public knowledge bases configured in
Knowledge Center Server in language en (English).

Authorizing

You can use the Sample Ul to:

¢ Browse the site, either as an anonymous user or by authorizing yourself as a customer.
To authorize, click the Log in link, enter your credentials, and click Confirm

This is not a real site authorization, as Knowledge Center server will only use an email as a customerld to
identify sessions in History records.
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Sample Ul Login

e To log out, click the link with your customer name and select "Logout"

Search

Ling ot

Sample Ul Logout

Searching
Search for any QNA document using the search bar.

Conduct a search

Start

1. Enter a question in the search bar and Search or press Enter.
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Caslomer =

knowledge center W Search

What |5 Hnowledge Center?
How 10 Creale new Rnowiedge base in Knowledge Cenler Server?
‘What components Knowledge Cenler consists of?
What &5 main Aanctionall How iy Peedback helps the Hnowledge Cenler?
What go | need o have Rnowledge Center CMS for?
Dioes Mnowiedge: Center (S and Knowledge Cenler Server uses same data?
What is main funcionallty of the Knowiedge Cenlar?
Hirw knowiedge cenler inds The right Srwers on my gesstions?
Shhat & the diference D
i Can | astign Genesys Knowlsadge Center Plugies o my sgents?

Should | el Hnowlkedge |
! Can | presvent Mnowksoge Cemer nom Saweing Ceran questions?
Hoaw can | set a0Cess oo - —

Top Questions

Can | igse My CMS syshl
o B EMPOIT data imo

Ca | prevent oustomen

How Enowiedge enter inds: e right answers on my qUesIons?

What components Knosiedge Center consists of?
What is abernatie questions?

Categories @

Garetal Languages Feedback

Coertyd Kpowieoge Cener Sened HElony Adminiiralon eXiention fof Geheiv Khiwisdge Cantier
ARG @ XIRAION fof GEnesys Knowkedge Cemed Saang GEnesys Knowieage Center Server

Sample Ul Search

2. Review search results. You can use the No relevant result button to let Knowledge Center know that
your search was unsuccessful. At the bottom of the page, there is a list of categories to which your
search result documents belong.

Lgn

Wil Iy Ganawyy Knoelaigs Cantar™ n

Wt Is Samaan Krrmindgs Conme?

unius. Knsmivigs Comte Shvwn T 1Sy g 0 S-0 VO RS Rumiedgn Iy COphng . B ity a8
s P by ATl T oD SR, R b T (HTE T PO 1 B o o

Hem can | snnign Ganeays Hnowisdge Canter Plogin fo my sgenta?

To PITYEE I AT S Can S ey M iy Y B RTeE Ty e S rowiesge o i
Fiumbili |04 e fama O i o i, |l FaB i T ey WA R B e

WTLT e b i .. ik st

ARl [l A Pude o) O vl reedl B O el oD ST | Of e AOwied0e 0 Siviasi k. lﬁmﬁm
rorponeniy - raekeige Corter Sere - B Paa of Gares Saowedgr Cosier B s e o of pou

Sample Ul Search Results

End
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Open and Review a Document

Important
Documents can be in plain text or rich text

Login

Home  Whal o Knowhdge?

What is Knowledge?
Theones of knowledge

Sow o'my L pesterrodogy

Thesnfusl demsmaion of phlasonty from seenos wis mase possbee Gy the sabanifel pheinapiy s some was Theony of knosdedps.
& Fuory chafonciirom dhe sownces becacas o uag e foundaton | Withoo! thy cea of 8 Yeony of inowisdos “ @ i hard o mages
el ity " couald s Bt it e o micdee Eoence — Richardfordy. Philosophy and the Wror of Nslore

mﬂm#mnjnﬂdmﬂm i in Thalinid of degy. The clakwcal defirtion. described But
el dyendorad by Plaio fhrd Wl & mmmummnnmhmmhw i el B puasified. e
ol Bl 5 Tl s 2ol Aol 4 Gl Sl animphiraaligidl; Semoralrats. Thife & 3 fusts o

ailasratiin propoaed, echading Robet Hosck's o thai b A Tracks fh PrLth e Smoer Blackbue s sdolteonsl

3

qr
PRpUITRT B e 00 NOF W B0 Sy PTTos who Mot @y of M condlions’ Thioegh a defect, flaw, o Laduhave knowiedge. Rchard
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Example of Rich Text

¢ To expand the document, click the more link.

* Send feedback about the relevance of a search, using the Yes/No link to Like or Dislike the quality of
the search. If you like or dislike an answer, you are asked to provide a star-rating and a comment
(optional) to improve the Knowledge article.
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Negative Feedback Comment Field

¢ Click the I need more help button to send a request for proactive help from Genesys Web
Engagement.

Important

This feature has been created only for use in conjunction with Genesys Web Engagement. No real message
will be sent without integrating your Knowledge Center installation with GWE.

¢ Click attachment names to open any attachments in the document. Attachments will open in a new
window.
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Opening Attachments
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Browsing

To browse Categories click the "Categories" link from main page.
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Importing Data into the Knowledge Center
Server

Indexer Tool

If you are not going to use a CMS you can use the indexer to import data for use with Genesys
Knowledge Center. The indexer is installed during the installation of Knowledge Center Server. It is
located inside your Knowledge Center Server installation folder in the \server\tools\indexer
subdirectory.

Command line:

java -jar indexer.jar [parameters]

Parameters:
Qualified s
Short Parameter Parameter Mandatory Example Description
Name of internal
-u --user n/a --user gkc_super :Ei&g:ﬁg
permissions

Username and
-a --authorization n/a -a user:password password for basic
authorization

(introduced in
9.0.002.09)

-author --author n --author gks_super  Common author
- identifier for all

documents that are
being published

(Introduced in

9.0.002.09)
) B --approver Common approver
approver approver n gks_super identifier for all

documents that are
being published

Path to file or
-f --file Y --file c:\xml directory with files
for importing

--host http://gks/ target knowledge

-h --host Y gks-server:8080 server url

For replacing all

-0 --overwrite n/a -0 s
/ existing
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Qualified
Short Parameter Parameter
-tenant --tenantld
-sbt --subTenantld
-sk --sslKeys
-sp --sslPassword
-t --transformer

Knowledge File Structure

field type

knowledge Object

knowledge.categoriesArray

knowledge.categories{ibjaeteégory

knowledge.categoriesfkdategory.id

n/a

n/a

n/a

n/a

n/a

Y

Y

Mandatory

mandatory

knowledge.categoriesfkdategory.categoryPdNentid

Example

--tenantid 1
--subTenantld
default

--sslKeys c:\keys\
sslkey

--ss|Password
topsecret

--transformer
c:\transformers\
transformer.xsl

format

n/a

n/a

n/a

n/a
n/a

Description

documents with
documents from
importing file

Target tenant
identifier

Target subtenant
identifier

Path to trust store

trust store
password

Path to XSL
transformer

description

Container of
documents and
categories for
indexing.

There are two
mandatory
attributes of a node
of "knowledge":

e kbld -
Knowledge
base identifier

¢ lang - language
identifier

e version -
version
identifier
(current:
"8.5.304")

Knowledge base
categories
directory

Knowledge
category

Category identifier
Parent category
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field type mandatory format description

identifier. Omit for
root categories.

knowledge.categoriesfkdategory.name Y n/a Category name

Documents for
indexing. Omitting
of this field means
knowledge.documentérrray N n/a that indexer must
not touch already
indexed
documents at all.

Document
identifier. Server
may generate
identifier
automatically in
case when
documents[l.id is
omitted

knowledge.documentdtridg N n/a

Document

knowledge.documentdtiriegnplateld Y n/a template identifier

(Introduced in

, 9.0.002.09)
knowledge.documentdtiranghor No n/a

Document author

(Introduced in

9.0.002.09
knowledge.documentdtraqgprover No n/a )

Document approver
Document start
date

Document
expiration date

knowledge.documentf)htalidFrom N YYYY-MM-DD

knowledge.documentfhtalidTo N YYYY-MM-DD

List of media
channels that this
document is
related to.

knowledge.document#irenedia N n/a

Document media

knowledge.documentdtrmegdia.media N n/a channel value

List of tags related

knowledge.document#irtags N n/a to this document

Document tag

knowledge.documentdtiriags.tag Y n/a value

Document external

knowledge.document$tring N n/a arl

knowledge.document§trinide Y n/a Document title

Document title

knowledge.documentdtriitde.id Y n/a name
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field type
knowledge.documentdtrhitde.value Y
knowledge.documentg{iragntent Y

knowledge.document€Dbjamttent[].docField Y

knowledge.documentdiriantent[].docField.id

knowledge.documentdtiritantent[].docField.Yalue

knowledge.document#iragiditional N

knowledge.documentdtiramdgitional[].docField

knowledge.documentdtiramdgitional[].docFieM.id

knowledge.documentdtiramdditional[].docFieM.value

knowledge.document#iralternatives N

knowledge.documentdtiredternatives[].alterhative

knowledge.documentg{irattachments N

knowledge.documentdtiratgachments[].attaBhment

knowledge.document#iragtegories N

knowledge.document€)bjediegories[].categdty

mandatory

format
n/a
n/a
n/a
answer,

description, body

n/a

n/a

n/a

n/a

n/a

n/a

n/a

n/a

n/a

n/a

n/a

description

Document title
value

Document content

Document content
field

Document content
field name

Document
additional content
field value

For importing Rich
Text in HTML format
via indexer

use <![CDATA[ and ]]
tags inside <value>
field.

Document
additional content

Document
additional content
field

Document
additional content
field name

Document
additional content
field value

For importing Rich
Text in HTML format
via indexer

use <![CDATA[ and ]]
inside <value>

field.

Alternative names/
questions for the
document

Relevant text item

Document
attachments

Document
attachment URL

Document
category
identifiers

Document
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field type mandatory format description
category object
knowledge.documentdtriredegories[].categofy.id n/a cDaotCeugn(:fynitdentiﬁer
knowledge.document#iraystomFields N n/a aDt(i(r:iLtj)thgt custom
knowledge.documentfbmactomFields[].entdy n/a aDtc’)c(r:i%TtinittgrL:mStom
knowledge.documentdtiringtomFields[].entry.key n/a aDt?c:‘:iLlJ)TteenrtwaCrlﬁgom
knowledge.documenta/ARustomFields[].entiy.value n/a gt(’)cgilérteen\t/aclﬂsetom

Example of content of indexing file (v2)
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<?xml version="1.0" encoding="UTF-8">
<knowledge kbId="knowledgefaq" lang="en" version="8.5.304">

<categories>
<category>
<id>cl</id>
<name>category 1l</name>
</category>

<category>
<id>c2</id>
<name>category 2</name>
<categoryParentId>cl</parentId>
</category>
</categories>

<documents>
<document>
<id>docl</id>
<templateIld>basefaqg</templateId>
<validFrom>2017-02-20</validFrom>
<validTo>2017-02-21</validTo>
<media>
<media>ml</media>
<media>m2</media>
</media>
<tags>
<tag>tl</tag>
<tag>t2</tag>
</tags>
<url>doclurl</url>

<title>
<id>question</id>
<value>document question</value>
</title>
<content>
<docField>
<id>answer</id>
<value>answer body</value>
</docField>
</content>
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<alternatives>
<alternative>document altl</alternative>
<alternative>document alt2</alternative>
</alternatives>

<attachments>
<attachment>al</attachment>
<attachment>a2</attachment>
</attachments>

<categories>
<category><id>cl</id></category>
<category><id>c2</id></category>
</categories>

<customFields>
<entry>
<key>strField</key>
<value>some string</value>
</entry>
<entry>
<key>numField</key>
<value>123</value>
</entry>
</customFields>

</document>

<document>

<id>doc2</id>
<templateIld>basefaq</templateId>
<validTo>2017-02-21</validTo>
<media>
<media>ml</media>
<media>m2</media>
</media>
<tags>
<tag>tl</tag>
<tag>t2</tag>
</tags>
<url>doc2url</url>

<title>
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<id>question</id>
<value>document question</value>
</title>
<content>
<docField>
<id>answer</id>
<value>faq answer</value>
</docField>
</content>
<alternatives>

<alternative>document altl</alternative>
<alternative>document alt2</alternative>

</alternatives>

<attachments>
<attachment>al</attachment>
<attachment>a2</attachment>
</attachments>

<categories>
<category><id>cl</id></category>
<category><id>c2</id></category>
</categories>

<customFields>
<entry>
<key>strField</key>
<value>some string</value>
</entry>
<entry>
<key>numField</key>
<value>123</value>
</entry>
</customFields>
</document>

<document>
<id>doc3</id>
<templateld>basearticle</templateld>
<media>
<media>ml</media>
</media>
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<title>
<id>title</id>
<value>document title</value>
</title>

<content>
<docField>
<id>description</id>
<value></value>
</docField>
</content>

<additional>
<docField>
<id>summary</id>
<value>document summary</value>
</docField>
</additional>

<customFields>

<entry>
<key>cfl</key>

</entry>

</customFields>

</document>
</documents>
</knowledge>
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Importing Sample Data

In the ./server/tools directory in the Knowledge Center installation folder, you can find a sample
knowledge base along with the indexer tool:

¢ knowledgeFAQ.xml — Sample knowledge base describing some of the questions related to Knowledge
Center
e indexer.jar—Java-based indexing tool

e importFAQ.bat—Simple data import script

Users must have Knowledge.AUTHOR privileges in order to use the Administrator
plugin.

To import a sample knowledge base you need to:

1. open import.bat file:

* ensure that --host parameter is pointing on one of your Knowledge Center Servers or the load
balancer in front of the cluster (recommended)

e ensure that --user parameter is set to valid used with Knowledge.AUTHOR privileges (knowledge by
default)

2. save changes if any
3. open knowledgeFAQ.xml:

e ensure that kbld attribute is set to desired knowledge base you would like to import data to
(knowledgeFAQ by default)

* ensure that language is set to properly configured one and added to the knowledge base

4. save changes if any

5. run import.bat
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Upgrade Genesys Knowledge Center
Server

It is recommended that you upgrade your system to Genesys Knowledge Center Server 9.0.006.16. It
is not recommended to select the Fresh or Maintenance options (if available). Also, to be on the safe
side, it is highly recommended that you create and save a copy of your existing launcher.ini file
when working with Windows or your existing setenv. sh file when working with Linux.

Although it is not recommended, if you do choose to select a Fresh (new) installation you must
update the Windows launcher.ini file or the Linux setenv.sh file with the following content so that
it points to the previous configuration server:

The launcher.ini file and the setenv.sh file located in the root directory of the
location in which the Genesys Knowledge Server is installed.

e Dwcc.appName=<previous_app_name>
¢ Dwcc.primaryConfServer=<previous configuration server path>

Upgrade Genesys Knowledge Center Server in a Windows environment
Upgrade Genesys Knowledge Center Server in a Linux environment

Upgrade Genesys Knowledge Center Server in a Windows environment

1. In your upgrade package, locate and double-click the setup.exe file. The Maintenance Setup Type
screen appears.

2. In the Maintenance Setup Type window, select Upgrade the application and from the list provided
select the component you want to upgrade to.
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Genesys Installation Wizard

Maintenance Setup Type

" Install new instance of the application
' Mainlenance of the existing installa & Upgiade the application

The mairdenance setup wpe defines what kind of nctallation bo performe new installation, updates
te the esaiting nstallation, of upgiade 1o & Laler veraon, Select ane option beksw

ledge Center Server 3,0,006,1

Applhcation Properties:

SETRTTRE N

Instalstion Packags Mame: Knowledgs Center S erver
ersicn: 9.0.003 06, Buld 1

1]

ok

Instal Location: C:\Progeam Fles\GCTI\Knowledge Center Server\Knowiedge_Center_5

e
| r|

Cancal |

Hepst >
1]

3. Click Next. The Connection Parameters to the Configuration Server screen appears.

4.

In the Host and User fields enter your host name, port and configuration server credentials.

Genetys Installstian Wizard m

Connection Parameters to the Configuration Server

Serves,

The pasameters i the Host and User felds ace tequined o eslablish a conneclion to Conlfigu sticn

~ Host

the machine on which Configuration Server

Specify the host name and port number for — Host name: 132 168 66.67

B

Port: [2020
r User
Specify your Configueation Senver usar uﬂfﬂmld&fﬂ T
narme and pasmwoid.

Pn:md:m

< Back I Mt » I Cancel

5. Click Next. The Select Application screen appears.

6.
Knowledge Center Server that is currently running.

In the list provided, select the Genesys Knowledge Center Server application. Select the Genesys
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Genesys Installation Wizard

Select Application

Select Applcation fiom the izt of configured applications for target computer. I application that you
ate narg by irvelall i neol i e Bt beslows conbact yous sysberm sdemisirabon.

GKC_SAV_B5304 -]
Erowledge_Center_Server 303 WIN

erderServer_9_006_16
Server S00HIB

Application Properties:

Type: Genezy: Knowledge Center Server [190] =]
Host: ghs-dep-nghily. us.inh. genesyslab.com

whorking Directony .

Comenand Lire: .

Cowrenand Line Angs

4 o

¢Back [ Med> |  Cancel |

7. Click Next. The Choose Destination Location screen appears.

8. In the Destination Folder enter the path to the location of your previous Genesys Knowledge Center

Server.

Genesys Installation Wizard | %]
Chooze Destination Location

Genesps Installation Wizad will nstall Knowledge Cenber Server in the iolovsng Destination Folder

To mastall o this folder, chck Mext
To nstall 1o a different lolder, chck Browse and select another Iolder.
To teslore & path bo default Desination Folder, chck Defsull

r Destination Folder -

IC:\P‘mgam Flas\GCTINEnowdadge Center Server\Enowledge_Center_Serves_S03

Detat | [ Browse. |

X

<Back | Mew> Cancel |

9. Click Next. The Ready to Install screen appears.
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Genesys Installation Wizard

Aeady to Install

Genesys Installston Wizard has collected sl requred infomalion and is ready 1o install Knowledge
Cenler Serves on your compuber

Tavimstal Kriowdedge Center Server, click Irstal
Ta review selings. chck Back. To el the Wizeed, chck Cancel

¢Back [ nctal | Damdl

10. Click Install. The Genesys Installation Wizard indicates it is performing the requested operation. When
through, the Installation Complete screen appears.

11. Click Finish to complete your installation.

12. Start the Genesys Knowledge Center Server.

Upgrade Genesys Knowledge Center Server in a Linux environment

Start

1. Open a terminal in the Genesys Knowledge Center Server CD/DVD or the Genesys Knowledge Center
Server installation package and run the install.sh file. The Genesys installation starts.

2. Enter the hostname of the host on which you are going to install.

3. Enter the connection information required to log in to the Configuration Server:
a. Hostname—For instance, demosrv.genesyslab.com
b. Listening port—For instance, 2020
c. User name—For instance, demo

d. Password

4. If you have a backup Configuration Server, enter the Host name and Port.

5. If the connection settings are successful, a list of keys and Genesys Knowledge Center Server
applications is displayed.

6. Enter the key for the Genesys Knowledge Center Server application that you created previously on
Configuration Server.

7. Enter the full path to your installation directory and confirm that it is correct.

If the installation is successful, the console displays the following message: Installation of Genesys
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Knowledge Center Server, version 8.5.x has completed successfully.

End

Genesys Knowledge Center Deployment Guide 212



	Genesys Knowledge Center Deployment Guide
	Table of Contents
	Genesys Knowledge Center Deployment Guide
	What is Genesys Knowledge Center?
	Knowledge Center Components
	High-Level Architecture
	Terminology

	Planning Your Deployment
	Prerequisites
	Sizing Information
	Hardware Recommendations
	Software Configuration
	Multi-Tenancy

	Installation and Deployment
	Before you Begin
	Automatic Provisioning during installation
	Configuring the Knowledge Center Cluster Application
	Installing the Knowledge Center Server
	Installing the Knowledge Center CMS
	Using CMS with Microsoft SQL Server
	Using CMS with Oracle
	Configuring CMS to Work with PostgreSQL
	Configure Resource Access Point for Knowledge Center CMS Load-Balancer

	Installing the Workspace Desktop Edition Plugin

	Post Installation and Deployment
	Access Permissions
	Configure Reporting
	Reporting REST API

	Configuration Options
	Knowledge Center Cluster Configuration Options
	Logging Configuration Options

	Configuring Resource Access Points
	Load-Balancing Configuration
	Security
	Transport Layer Security (TLS) with Genesys Servers
	Authentication
	Cross Origin Resource Sharing (CORS) Filter

	Translation service
	IP Geolocation
	UTF8
	Supported Languages
	Screening Rules and Standard Responses

	Knowledge Center in Production
	Monitoring Knowledge Center
	Viewing Metrics with JMX

	Sample UI
	Importing Data into the Knowledge Center Server

	Upgrade Genesys Knowledge Center Server

